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Zusammenfassung

Diese Arbeit beschreibt die Sprache ALDiSP. ALDiSP ist eine funktionale
Sprache im Stil von ML oder Scheme. ALDiISP erméglicht es, Algorithmen der
digitalen Signalverarbeitung schnell und direkt zu formulieren. ALDiSP ist kei-
ne Sprache, die nur fiir spezielle Anwendungen geeignet ist, sondern eine sehr
miéchtige, allgemeine Sprache, die iiber Konstrukte zur Beschreibung von Zeit
und Prozessen verfiigt und sich besonders zur Arbeit mit numerischen Arrays
eignet. ALDiISP kennt den Begriff des Nebeneffekts und ist so in der Lage, I/O
sauber zu beschreiben. ALDISP verfiigt iiber

e cine breite Palette numerischer Datentypen, die sich beliebig erweitern

148t

e die Moglichkeit, mathematische Operatoren in natiirlicher Weise zu notie-
ren

e automatisches Mapping aller Funktionen auf Datenstrome und Arrays,
e ecin ausdrucksstarkes Typsystem,

e die Moglichkeit zur Definition abstrakter Datentypen,

e ein occam entlehnter Rendezvous-Mechanismus zur Interprozefkommuni-
kation,

o verschiedene Typen wie ‘Interrupt’, ‘Port’ und 'Register’, die die durch
die Hardware vorgegeben I/O-Strukturen modellieren,

e Modularisierungskonstrukte und Blockstruktur und

e cinen allgemeinen Exception-Mechanismus, der auf dynamisch gebunde-
nen Funktionen beruht.

ALDISP wird call-by-value ausgewertet; es ist zugleich moglich, explizit call-
by-need (lazy evaluation) durchzufiihren und Makro-Funktionen zu definieren.
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Kapitel 1

Einleitung

1.1 Einordnung

Dieser Abschnitt soll ALDiSP in die Sprachlandschaft einordnen und die Posi-
tion im Rahmen des CADiSP-Projekts klarmachen. CADiSP ist ein System zur
interaktiven graphischen Entwicklung von Programmen fiir DSP-Prozessoren.
Das CADiSP-System unterteilt sich in die graphische Umgebung (einen Editor,
der ALDiSP-Programme generiert) und den ALDiSP-Interpreter/Compiler.

1.1.1 Digitale Signalverarbeitung

Digitale Signalverarbeitung ist, vor allem, wenn sie in Echtzeit erfolgen soll, ein
Aufgabengebiet, das die Grenzen des technisch Machbaren ausreizt. Deswegen
werden DSP-Systeme heutzutage auf Basis spezieller Prozessoren konstruiert,
die aus Effizienzgriinden in Assembler (bestenfalls noch in C) programmiert
werden. Mit der wachsenden Komplexitiat von DSP-Algorithmen werden die
Programme grofer und uniibersichtlicher. Da DSP-Algorithmen sich auf Struk-
turebene meist als DatenfluBdiagramme darstellen lassen, scheint es sinnvoll,
von imperativen Sprachen abzugehen und Datenfluf3- oder funktionale Sprachen
als Beschreibungsmittel einzusetzen. Zwei spezielle Probleme tauchen dabei auf:
das der effizienten Compilation und das der Echtzeittauglichkeit der Sprachkon-
strukte, d.h. der Moglichkeit, anzugeben, wie schnell Reaktionen auf asynchrone
Ereignisse zu erfolgen haben bzw. wann synchrone Vorgénge geschehen sollen.

1.1.2 Warum eine funktionale Sprache?

Funktionale Sprachen haben eine lange Tradition. LISP, die erste Sprache, die
funktional genannt werden kann (obwohl die Konzepte, die man heute unter
dem Begriff ‘funktional” sammelt, damals noch nicht explizit ausgearbeitet wa-
ren), entstand kurz nach der Entwicklung des ersten FORTRAN-Compilers.
Funktionale Sprachen setzen direkt auf dem Funktionsmodell des Church’schen
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Lambda-Kalkiils auf, das deutlich michtiger! ist als das Turing-Maschinen-
Modell, das die theoretische Grundlage zum Bau herkémmlicher Maschinen und
zur Entwicklung ‘imperativer’ Sprachen liefert. Wahrend das Lambda-Kalkiil
‘Programme’als méchtige Funktionen begreift (in der Tat sind Funktions- Abstraktion
und -Applikation die einzigen semantischen Elemente des Kalkiils), geht der
Turing-Maschinen-Ansatz davon aus, das ein Programm einen Speicherzustand
in einen anderen Speicherzustand iiberfithrt, ohne in irgendeiner Weise von die-
sem Speicher zu abstrahieren. Imperative (Zustands-orientierte) Sprachen haben
als ‘Codierungshilfe’ (formula translation) fiir von-Neumann-Maschinen ange-
fangen und mit der Zeit immer mehr ‘funktionale’ Elemente iibernommen. Die
Implementierungsprobleme, die man in der Friihzeit mit funktionalen Sprachen
hatte (vor allem der Speichermangel machte fortgeschrittene Techniken z.B. der
Garbage Collection, d.h. der automatischen Speicherreorganisierung, erst spiat
moglich), brachten es mit sich, dafl funktionale Sprachen das Ghetto der theo-
retischen Informatik erst spét verlassen haben.

Inzwischen sind viele Informatiker iiberzeugt, daff den funktionale Sprachen
(und den relationalen wie PROLOG) die Zukunft, gerade im Bereich der grofien
Software-Systeme, gehort. Funktionale Sprachen sind einfacher automatisch ve-
rifizierbar als imperative? und zeigen bessere Méglichkeiten zur Modularisierung
und zur Modul-Wiederverwertung (vor allem auf Grund der Moglichkeit, poly-
morphe Funktionen zu schreiben).

Man kann davon ausgehen, das die Produktivitit eines Programmierers un-
gefahr proportional zum Abstraktionsgrad der benutzten Sprache und zum In-
teraktivititsgrad der Entwicklungsumgebung ist®. Beides ist in modernen funk-
tionalen Sprachumgebungen maximiert.

Elemente Funktionaler Sprachen

Wichtige Eigenschaften moderner funktionaler Sprachen sind:

e Polymorphie: Die Moglichkeit, allgemein definierte Funktionen auf Objek-
te verschiedenster Typen anwenden zu kénnen, die implementierungstech-
nisch verschiedenartig sind.

e Modularisierungskonzepte und abstrakte Datentypen: hierdurch kénnen
grofle Projekte in sauber getrennte Teile separiert werden (ohne Ein-
schriankungen wie z.B. Modula-2 * zu unterliegen).

L «“Michtiger” soll hier nicht im Sinne der Menge der dadurch berechenbaren Funktionen,
sondern eher pragmatisch aufgefait werden. Modula-2 ist méchtiger als Pascal, Common Lisp
ist méchtiger als Scheme.

2Heutzutage sind nur kleine imperative Programme verifizierbar, wiahrend die GroBe bei —
besser abstrahierenden — funktionalen Programmen keine so wichtige Rolle spielt.

3[1], pp. 134ft.

4In Modula-2 kénnen nur solche Typen iiber Modulgrenzen exportiert werden, die sich in
einer Registerbreite unterbringen lassen. Natiirlich kénnen auch Funktionen nur exportiert
werden, wenn die Argumenttypen exportiert sind.
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e Funktionen als First-Class-Objekte: Funktionen kénnen Funktionen als
Parameter und als Ergebnis haben.

e Orthogonalitit: alle Typen haben ‘gleiche Rechte” — jedes Objekt kann als
Parameter iiber— und als Ergebnis zuriickgegeben werden.

o Rekursion als einziges Iterationskonstrukt: Das prog—Konstrukt des frithen
LISP ist {iberkommen; Die End-Rekursion (tail recursion) wird genauso
effizient iibersetzt wie eine imperative Schleife.

e Exceptions: die Moglichkeit, auf Ausnahmefélle gezielt zu reagieren.

e Lazy Evaluation: das Arbeiten mit potentiell unendlich grofien Daten-
strukturen.

Compilation Funktionaler Sprachen

Funktionale Sprachen sind, historisch gesehen, mit den unschmeichelhaften At-
tributen der Langsamkeit und Speicherineffizienz versehen. Zugleich jedoch sind
funktional geschriebene Algorithmen gut zur Parallelisierung geeignet und mit
formalen Methoden leicht analysierbar. Moderne Compiler zeigen, dafl funktio-
nale Sprachen sich durchaus so gut wie z.B. C iibersetzen lassen [8].

1.2 Grundlegende Sprachkonzepte

ALDISP ist eine Sprache, die an wenigen Konzepten orientiert ist. In dieser
Einleitung sollen diese Konzepte kurz vorgestellt werden, damit die Ubersicht
beim Lesen des Reports nicht verlorengeht.

1.2.1 Prozesse und Zeit

Ein Programm lauft ab, indem parallele Prozesse ausgefiihrt werden, die Neben-
effekte erzeugen. Nur Nebeneffekte (= I/O) konnen zeitlich spezifiziert werden.
Die Spezifikation erfolgt iiber ein einfaches Mittel: jeder Prozef existiert in ei-
nem virtuellen Zeitpunkt; jegliche 1/O, die ein Prozef ausfiihrt, vollzieht sich
zu diesem Zeitpunkt. Ein Scheduler sorgt dafiir, dal die virtuellen I/O-Zeiten
mit den ‘realen’ Zeiten iibereinstimmen. Es gibt ein zentrales Konstrukt namens
suspend, das Prozesse erzeugt und mit Zeitvorgaben versieht. Bei der Prozef3-
Erzeugung wird eine Startbedingung angegeben, die dem Scheduler sagt, welcher
globale Zustand (bzw. welche Zustandsianderung) die Ausfiihrung des Prozesses
triggern soll und in welchem Zeitrahmen dies zu geschehen hat.

Ein typisches Beispiel fiir einen asynchronen Prozel (das Dampfkesselbei-
spiel) kénnte so aussehen:

suspend OffneVentil until UberdruckInterrupt within O ms, 10 ms
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Nachdem dieser Ausdruck ausgewertet wurde, wartet ein Prozefl im Hintergrund
darauf, dafl der UberdruckInterrupt kommt.Ist dies der Fall, hat der Scheduler
10 Millisekunden Zeit, den Prozef3 zu starten.

Typische synchrone Prozesse sind in DSP-Applikationen zu finden. Als ein-
fachstes Beispiel soll ein System dienen, das in Echtzeit zwei Audio-Kanile
mischt:

\ Programm zum Mischen zweier Kan\"ale
\ kein Overflow-Test

proc misch() =
writeRegister(readRegister(Kanall)+readRegister(Kanal2))

proc misch44Khz() =
suspend seq misch(); misch44Khz() endseq
until true
within 1/44000 sec, 1/44000 sec

net in
misch44Khz()
endnet

Hier kann man sehen, dafl der ‘asynchrone’ Anteil des Suspend-Konstrukts
wegfillt (die triviale Bedingung true ist immer erfiillt); der ‘synchrone’ An-
teil gibt an, dal genau 1/44000 Sekunde gewartet werden soll, bis es weitergeht.

1.2.2 Die Evaluation von Expressions

Das elementare Ausfilhrungsmodell in ALDiSP ist die Evaluation von Expres-
sions, d.h. die Auswertung von Ausdriicken. Ein Programm wird als Ausdruck
verstanden, der aus Unter-Ausdriicken rekursiv zusammengesetzt ist. Das Pro-
gramm wird ausgefiihrt, indem der dem Ausdruck entsprechende Wert berech-
net wird. Die Semantik der Sprache wird angegeben, indem beschrieben wird,
in welcher Weise der Wert von Ausdriicken bestimmt wird.

1.2.3 Objekte und Primitive

Die Werte in ALDiSP heiflen Objekte. So ziemlich alles ist ein Objekt. Funkti-
onen (selbst Objekte) bilden Objekte auf Objekte ab. Man muf$ zwischen Da-
tenobjekten und Maschinenobjekten unterscheiden. Ein Datenobjekt ist ein be-
rechenbares Ding; ein Maschinenobjekt ist die Reprasentation einer Hardware-
Gegebenheit, z.B. eines D/A-Wandlers.

Die Funktionen, Typen und konstanten Objekte, die von der Sprache (in
den Standard-Libraries) vorgegeben werden, heiflen Primitive. ALDiSP wird
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definiert, indem neben den Sprachkonstrukten, also den Regeln zur Bildung von
Ausdriicken, die Primitiven beschrieben werden.

1.2.4 Funktionale

Funktionale (higher-order functions) sind Funktionen, die Funktionen als Ar-
gumente und/oder als Resultate haben. (Ein typisches Funktional ist Map, das
eine Funktion auf alle Argumente einer Datenstruktur anwendet.) Funktiona-
le werden oft als der implementierungstechnische Schwachpunkt funktionaler
Sprachen angesehen, da sie eine Compilation stark erschweren.

ALDISP arbeitet in starken Mafle mit Funktionalen. Man kann ein Funk-
tional als eine ‘abstrakte Konstrollstruktur’ verstehen — im gleichen Mafle; in
dem ein abstrakter Datentyp von einer aktuellen Datenreprisentation abstra-
hiert, abstrahiert ein Funktional von einem aktuellen Rekursionsschema. Fine
Sprache, die hinreichend viele Funktionale zur Verfiigung stellt, kann auf Rekur-
sion vollig verzichten! Gerade die Analyse der Rekursion aber (im allgemeinen,
die Kontrollflufanalyse) stellt DSP-Compiler vor ein echtes Problem: wenn es
zu beweisen gilt, dal ein gegebenes Stiick Code in einer gegebenen Zeit fer-
tig wird, darf es keine echte Rekursion geben® (oder die Sprungbedingungen
miissen trivial analysierbar sein). Hat man nun vorgegebene Rekursionsstruk-
turen in Form von Funktionalen, so kann die Analyse vom Konstrukteur des
Compilers ibernommen werden. (Gibt es keine Funktionale, versucht der Com-
piler faktisch, herauszubekommen, welche Funktionale benutzt worden wéren,
wenn es sie denn gébe.)

1.2.5 Nebeneflfekte

Rein funktionale Sprachen haben es nicht nétig, sich mit I/O und anderen un-
liebsamen nicht leicht mathematisch beschreibbaren® Aspekten von Program-
men zu beschiftigen. ALDiSP mufl diese Aspekte sogar zeitlich spezifizieren;
es tut dies, indem das Konzept der Nebeneffekte (worunter dasselbe wie “I/0”
verstanden werden soll) in die Sprache integriert wird. ALDiSP kennt keine ech-
ten (“Von-Neumann”-) Variablen, auch gibt es ein echt funktionales Subset der
Sprache; nur im semantischen Umfeld der ProzeBgestaltung und der 1/O kom-
men diese ‘unsauberen’ Konstrukte ins Spiel. In einem ‘normalen’ Programm
gibt es vielleicht 1% Nebeneffektbeschreibung; in den Libraries und Modulen
gibt es so etwas iiberhaupt nicht”. Diese Isolierung der Problemstellen soll eine

5Das Halteproblem ist unlésbar, und die unkontrollierte Rekursion ist die Wurzel allen
Ubels.

8Man schaue sich die I/O in PROLOG an! Zugegeben, mit Streams und Continuations
kann man einiges machen; aber eigentlich wird immer nur versucht, eine schéne Verkleidung
zu konstruieren, hinter der sich die ‘echte’ I/O abspielt. Wen dies interessiert: in 4.3 wird
beschrieben, wie dies in ALDISP aussihe.

"D.h., es kénnen zwar Prozeduren definiert werden, die, wenn sie spiter aufgerufen werden,
Nebeneffekte erzeugen; es kénnen jedoch keine Nebeneffekte wdhrend der Definition eines
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iibersichtliche und einfach zu programmierende Beschreibung von Prozessen in
Echtzeit ermoglichen.

1.2.6 Modularisierungstechniken

Die zentralen Modularisierungstechniken, die in ALDiSP eingesetzt werden, sind
die Unterteilung des Programms in voneinander unabhéngige Module und die
Benutzung abstrakter Datentypen. Module vereinfachen das Lesen des Pro-
grammtextes; Datentypen vereinfachen das Verstdndnis des Datenflusses. Die
zentralen zum Einsatz kommenden Datentypen sind Streams und Pipes. Streams
kann man als call-by-need-Listen auffassen, die potentiell unendlich sind (output-
driven evaluation). Pipes sind das “call-by-availability”-Gegenstiick zu Streams
(input-driven computation). Beide reprasentieren Datenstrome; sie unterschei-
den sich nur im Kontrollfluf3.

Aufbau eines Programms

Ein typisches DSP-Programm besteht aus Modulen und einer Netzbeschrei-
bung. Die Netzbeschreibung definiert eine Datenflu3-Struktur, bei der die ‘Ver-
bindungslinien’ durch Streams und Pipes; die ‘black boxes’ durch Funktionen
reprasentiert werden. Die Funktionen werden, zusammen mit den Datentypen,
iiber denen die Streams und Pipes deklariert sind, in den Modulen definiert.
Die Module sind normalerweise in einzelnen Files abgelagert und voriibersetzt,
so daBl die Erstellung eines Programms im Normalfall (wenn keine neuen Funk-
tionen zu schreiben sind) in der Netzdefinition besteht. Sind neue Funktionen
notwendig, so konnen alte Module erweitert oder neue geschrieben werden, je
nach Bedarf.

Streams und Pipes

Ein Stream stellt eine (potentiell nicht terminierende) Berechnung dar, die bei
Bedarf beliebig ‘weit’ ausgefiihrt werden kann. Ein Stream ist fiir alle prakti-
schen Belange eine Liste, deren erste n Elemente berechnet sind; der Rest der
Liste existiert nur ‘virtuell’ und wird bei Bedarf erstellt. Ein typischer Stream
ist die Liste aller natiirlichen Zahlen:

let func count(i) = i :: DELAY count(i+1) IN count(0) endlet

evaluiert sich zum Stream (0 1 2 3...)3. Typische Klassen von Funktionen iiber
Streams sind

Generatoren: Funktionen, die Streams erzeugen. count ist ein Generator.

Moduls auftreten.
8.7 ist der Infix-Listenkonstruktor, der oft auch durch den Punkt (“.”) notiert wird.
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Konsumptoren: Funktionen, die Streams konsumiern. Ein Beispiel ist die
Funktion, die die ersten n Elemente eines Streams addiert:

func addElements(n)(s) =
if n=0 then O
else head(s)+addElements(n-1)(tail(s))
endif

Mappings: Die typischste ‘synchrone’ Stream-Operation iiberhaupt ist die Funk-
tion f’, die eine Funktion f elementweise auf Streams anwendet. Mappings
kénnen ein- oder mehrstellig sein; es wird ein Stream generiert, der genau-
so lang ist wie der kiirzeste’ Eingabestream. Ein typisches Beispiel fiir ein
zweistelliges Mapping, das iiber nichtterminierenden Number-Streams de-
finiert ist, ist die Funktion, die zwei Streams elementweise addiert:

func addStreams(sl,s2) =
head(s1)+head(s2) :: DELAY addStreams(tail(s1),tail(s2))

Weil Mappings so hdufig auftreten, erfolgen sie in ALDiSP automatisch,
d.h. die obige Definition kénnte einfacher als

func addStreams(sl,s2) = sl+s2

beschrieben werden.

Das Problem mit Streams ist, daf} sie zu jeder Zeit beliebig weit berechenbar
sein miissen. Bei asynchronen Applikationen ist dies nicht der Fall: Dort mufl
man auf Ereignisse reagieren, d.h. warten, bis etwas (eine I/O) passiert. Diese
Wartezeit ist nicht beeinfluSbar. Das zu den Streams analoge Konstrukt fiir die-
sen Fall heifit Pipe und unterscheidet sich syntaktisch kaum von den Streams,
die Semantik jedoch ist eine andere. Wenn im Rahmen der Auswertung eines
Ausdrucks auf eine ‘leere’ Pipe zugegriffen wird, so wird der auswertende Pro-
zel schlafengelegt, bis der Input, der die Pipe mit Daten versorgt, ein neues
Item erzeugt hat; dann wird der ProzeB aufgeweckt; die Daten werden verar-
beitet, und der Prozef} legt sich wieder schlafen. Dies entspricht dem Standard-
DatenfluBmodell, in dem das Vorhandensein von Tokens einen Knoten aktiviert.

Es gibt zwei Arten, Funktionen iiber Pipes zu formulieren: die explizite und
die implizite. Explizite Pipe-Funktionen benutzen das Suspension-Konstrukt,
um die Aktivierungsbedinungen zu formulieren; implizite Pipe-Funktionen se-
hen aus wie Stream-Funktionen ohne DELAY; sie funktionieren, indem sie die
Eigenschaft ausnutzen, dafi der Zugriff auf ein nicht verfiighares Datenobjekt
den zugreifenden Prozefl blockiert.

9Manchmal orientieren sich Mappings auch am lingsten Eingabestream; die anderen, d.h.
vorher endenden, Streams werden entsprechend sinnvoll verldngert.
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Eine typische mit Streams schwer formulierbare Funktion ist der Merge-
Knoten. Will man ihn mit Streams programmieren, mufl man beide Eingénge
aufrufen, nur um an einem Eingang ein ‘not-available’-Token zu erhalten. (Dies
lauft auf ‘busy waiting’ hinaus.) Arbeitet man mit Pipes, so formuliert man die
Bedingung der Suspension, die das Schlafenlegen und Aufwecken des Funktions-
knotens erledigt, derart, dafl das Eintreffen eines Tokens auf einer der beiden
Pipes den Knoten weckt!?:

func merge(pl,p2) =

suspend

if isAvailable(pl) then head(pl)::merge(p2,pl)
else head(p2)::merge(pl,p2)

endif

until
isAvailable(pl) or isAvailable(p2)

within 0,0

1.2.7 Typen, Polymorphie und Overloading

ALDISP verfiigt tiber ein ausdrucksstarkes Typisierungssystem, das zwei Anfor-
derungen geniigt: Einerseits ist es machtiger als die Typisierungskalkiile herkémm-
licher statisch typisierter polymorpher Sprachen (wie z.B. ML): derartige Spra-
chen haben Probleme mit “Polymorphie zweiter Ordnung”,cLh.der‘Uberga—
be von polymorphen Funktionen, die noch nicht mit Typen instanziiert sind,
als Funktionsargumenten; andererseits ist es expressiver als schwach oder nicht
getypte Sprachen wie z.B. LISP, in denen der Begriff des Typfehlers stark
verwissert ist'!.

Das Typsystem von ALDiSP 148t sich sowohl operational als auch men-
gentheoretisch verstehen. Der mengentheoretische Ansatz wird in der Sprachbe-
schreibung und bei der Spezifikation komplexer Typen benutzt, der operationale
Ansatz in der “Alltags-Typisierung”. Der mengentheoretische Ansatz geht da-
von aus, dafl es ein Universum (das durch den Typen 0bj modelliert wird) von
konstruierbaren Objekten gibt, deren Struktur uns momentan egal sein kann.
Wichtig ist, dafl es ein ausgezeichnetes (Daten-) Element L (Bottom)und pri-
mitive Funktionen gibt. Jede primitive Funktion ist iiber einer Teilmenge (des
n-stelligen kartesischen Produkts) von 0bj definiert und hat eine Teilmenge
(des n-stelligen kartesischen Produkts) von 0bj als Wertebereich. Jede primiti-
ve Funktion bildet alle Tupel aus dem Nicht-Definitionsbereich nach L ab.

10Natiirlich muB es in dieser Implementierung einen Scheduler-Prozef geben, der das Warten
erledigt, aber der kann z.B. Interrupts dafiir einsetzen; es wire ungleich schwerer, die hierfiir
notwendigen Informationen aus einem Aquivalenten, durch Streams implementierten, Modell
zur extrahieren.

lGerade in Common LISP [13] ist es méglich, dafl die automatische Typumwandlung
zur Laufzeit viele echte Programmierfehler schluckt, d.h. teilweise verniinftige Ergebnisse
produziert.
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Typen sind jetzt nichts weiter als Teilmengen von 0bj. Sinnvollerweise gibt
es einige wichtige disjunkte Teilmengen (genannt Int, Real, Bool, Char, String,
usw.), die als “atomar” angesehen werden und im Typsystem vordefiniert sind.
Alle anderen Typen (z.B. List, Vector, Map) sind komplexer und bediirfen der
Parametrisierung '2.

Die Teilmengen von Obj lassen sich am einfachsten durch Pradikate cha-
rakterisieren - denn was ist eine Teilmenge anderes als ein einstelliges Pradikat
iiber einer Menge von Objekten? Nimmt man diesen Ansatz ernst, so gibt es
keinen Grund, nicht auch ‘bizarre” Typen zuzulassen, die sich durch ‘konstrukti-
ve’ Typdeklarationsmethoden (Deklaration von Konstruktoren, Selektoren und
Aquivalenzgleichungen) nicht oder nur sehr umstéandlich aufbauen lassen.

Eine Typdeklaration fiir ein Objekt, einen Ausdruck oder einen formalen
Parameter ist nicht, wie in maschinenorientierteren Sprachen (z.B. PASCAL
und C), primér eine Speicherverwaltungsdirektive, sondern eine Zusicherung
(Assertion), daf ein Ausdruck ein bestimmtes Pridikat erfiillt. Bsp!? :

func fak(n:nat):nat =
if n=0 then 1 else n*fak(n-1) endif

ist Aquivalent zu

func fak(n) =
if isNat(n)

then
let
tmp = if n=0 then 1 else n*fak(n-1) endif
in
if isNat (tmp)
then tmp
else bottom
endif
endlet

else bottom
endif

Dies erméglicht die direkte Einbindung von Assertions, wie sie in der Pro-
grammverifikation benutzt werden, denn Assertions sind nichts weiteres als
Pradikate (bzw. Ausdriicke, von denen der Programmierer zusichert, daff sie
sich in jedem Laufzeitkontext zu ‘true’ evaluieren).

Das im letzten Abschnitt vorgestellte fortgeschrittene Typkonzept bedeutet
in der Praxis (also dort, wo 24-Bit-Integers und 512 Elemente grofie Vektoren

12Typen lassen sich sowohl mit anderen Typen als auch mit Konstanten, also Werten,
parametrisieren. Beispiele: List (Integer) oder SizedVector (16 ,Byte).

1¥Das Programm benutzt die ALDiSP-Konvention, daf} es zu jedem Typen XY ein Priadikat
is XY gibt.
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gezdhmt werden miissen) keine Abkehr von gewohnten Notationen, die genauso-
gut in ML oder Pascal vorkommen koénnten. Diese Notationen entsprechen dem
Teil der Typen, der sich ‘statisch’ beschreiben und ohne grofien Aufwand im-
plementieren 14Bt. Insbesondere 148t sich bei diesen einfachen Typen zur Uber-
setzungszeit die Typkorrektheit grofler Programmteile nachweisen.

Polymorphie ergibt sich, wenn einem Ausdruck keine expliziten Typinforma-
tionen beigegeben werden. In diesem Fall gibt es keine Typchecks; die einzige
Typinformation ist die, die durch bereits getypte Teile des Ausdrucks gewonnen
werden kann (d.h. durch die Typen von Konstanten, Primitiven und bereits defi-
nierten Funktionen.). In ALDiSP ist Polymorphie der Normalfall: jede Funktion
ist polymorph, es sei denn, sie wird getypt.

Querloading, d.h. das Unterbringen mehrerer Funktionen unter einem Funk-
tionsnamen, ist eine einfache Konsequenz der Bottom-Semantik von Primitiven.
Wenn es zwei Funktionen gibt, deren Definitionsbereiche disjunkt sind, kann
man die beiden Funktionen problemlos kombinieren (Wenn man sich eine Funk-
tion als Tupelmenge vorstellt, ist die Kombination zweier Funktionen durch die
Mengenvereinigung definiert. Solange das Ergebnis keine echte Relation ist, ist
die Semantik eindeutig definiert.). Bei der Anwendung der tiberladenen Funkti-
on wird, je nach Argumenttyp, eine der Ausgangsfunktionen angewandt.

In ALDiSP bedeutet dies, dafl zwei oder mehr Funktionen unter dem glei-
chen Namen definiert werden kénnen, solange sich keine Uberschneidungen in
den Definitionsbereichen ergeben. Dies wird durch ein einfaches Schliisselword
‘overloaded’ bei der Funktionsdefinition bewerkstelligt.

1.2.8 Verzogerte Auswertung

Das delay—Konstrukt ermoglicht es, die Auswertung eines Ausdrucks bis zu dem
Zeitpunkt herauszuzdgern, an dem der Wert des Ausdrucks wirklich benétigt
wird. Dies macht es dem Programmierer moglich, Funktionen iiber unendlich
grofilen Objekten (insbesondere Streams) zu spezifizieren (die dann in der An-
wendung nur endliche Teil der Objekte verarbeiten).

1.2.9 Exceptions

ALDiSP stellt einen allgemeinen Exception-Mechanismus zur Verfiigung, der
durch dynamisch gebundene Funktionen, wie sie aus dem klassischen LISP (1.5)
bekannt sind, implementiert wird. Diese Exceptions dienen nicht nur dem Ab-
fangen von Fehlersituationen, sondern werden auch als Hintergrund fiir den
parametrisierbaren Rundungsmechanismus eingesetzt.

1.2.10 Syntaktische Elemente

ALDiSP verfiigt iiber die Moglichkeiten, Operatoren zu definieren. Dies erm&g-
licht klammerfreie Funktionsaufrufe. Im weiteren gibt es Makro—Funktionen,
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die zur Ubersetzunszeit expandiert werden und es ermoglichen, auch von sol-
chen Ausdriicken zu abstrahieren, die verzégerte auszuwertende Sub-Ausdriicke
enthalten.

1.3 Awufbau der Sprachbeschreibung

Die ALDiSP-Sprachbeschreibung ist in einen Report und einen Satz von Syn-
taxtabellen aufgeteilt. Zur weiteren Erlduterung gibt es eine Kurzbeschreibung
der Entwicklungsumgebung und einen ‘Rationals’-Teil, der alles enthilt, was
anderswo nicht untergebracht werden konnte.

1.3.1 Der Report

Der Report ist eine Sprachbeschreibung, die eine nicht-formale'* Einfithrung in
ALDiSP gibt, ohne dabei Anspruch auf die Vollstdndigkeit oder Prazision einer
formalen Spezifikation zu erheben (obwohl er sich darum bemiiht). Der Report
erklart alle syntaktischen Konstrukte, die elementaren Typen und die darauf
definierten Funktionen. Das Wissen aus dem Report (und den Syntaxdiagram-
men) muf} ausreichen, um ALDiSP-Programme schreiben zu kénnen. Report
und Syntaxdiagramme sind die Teile des Reports, die fiir “den Anwender” ge-
dacht sind. Alles; was im Report nicht oder nur unklar erklirt ist, sollte vom
Benutzer als das genommen werden, was es ist — eine Spezifikationsliicke, in der
sich verschiedene Implementierungen der Sprache unterscheiden kénnen. Einige
dieser Liicken sind beabsichtigt, um den Implementoren Freirdume zu geben.

1.3.2 Die Entwicklungsumgebung

Dieser Abschnitt der Sprachbeschreibung erklart die minimale Umgebung, die
ein ALDiSP-System braucht. Er geht kurz auf CADiSP ein, um schliefflich sinn-
volle Compiler-Optionen aufzuzidhlen und die Unterschiede in der Semantik zwi-
schen interpretiertem und compiliertem ALDiSP noch einmal aufzuarbeiten.

1.3.3 Die Rationals

Dieser Abschnitt geht ndher auf umstrittene Entwurfsentscheidungen, kontra-
intuitive Aspekte und Implementierungsprobleme von ALDiSP ein. Alles, was
in den anderen Abschnitten nur verwirren wiirde, ist hier untergebracht, zudem
werden viele Einzelaspekte erldutert.

14Tch weigere mich, den Report ‘umgangssprachlich’ oder auch nur ‘natiirlichsprachlich’ zu
nennen - das Deutsch des Reports ist nicht ‘natiirlich’!
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1.3.4 Die Anhiénge

Es gibt zwei Syntax-Beschreibungen von ALDiSP. Die erste benutzt eine EBNF-
Notation und ist nicht ganz vollstandig (d.h., sie beschreibt ein Superset von
ALDISP); sie ist relativ gut lesbar und “fiir den Hausgebrauch” ausreichend. Die
zweite ist eine yacc-Syntax, die alle Fragen von Operatorproritdt und Assoziati-
vitit in ausreichender Weise regelt. Es folgen zwei Anhénge zum leidigen Thema
‘primitive Funktionen und Typen’. Leidig ist das Thema deshalb, weil vollkom-
men unklar ist, wie gro8 der “funktionale Kern” einer Sprache zu sein hat.
Manche Sprachen sehen keinen solchen Kern vor (was zu total inkompatiblen
Programmen fiihrt), andere haben einen aufgebladhten Satz von vordefinierten
Funktionen, den vollstdndig zu implementieren eine grofere Leistung ist (z.B.
Common LISP). ALDiSP versucht, sich aus der Verantwortung zu driicken, in-
dem es zwei “Kerne” vorgibt: einen minimalen, der in allen Implementierungen
realisiert sein muf}; und einen Satz vorgeschlagener Erweiterungen, die nicht
Pflicht sind (wenn sie jedoch implementiert werden, dann mit den hier angege-
benen Namen und Funktionalititen).



Kapitel 2

ALDIiSP Report

2.1 Syntaktische Form von Programmen

Ein ALDiSP-Programm ist ein (moglicherweise auf mehrere Files aufgeteilter)
Text. Der zugrundeliegende Zeichensatz mufl mindestens die sichtbaren ASCII-
Zeichen umfassen; es ist von Vorteil, einige mathematische Sonderzeichen zur
Verfiigung zu haben. Jede Implementierung kann eine maximale Zeilenldnge
vorgeben, die jedoch nicht kleiner als 80 sein darf. Ein Programm besteht aus
einer Sequenz von Namen und Literalen, die durch Zwischenraumzeichen, In-
terpunktionszeichen und ‘spezielle Namen’ getrennt sind.

Kommentare

ALDISP kennt nur zeilenorientierte Kommentare. Alles, was zwischen einem
“\”-Zeichen (Backslash) und einem Zeilenende kommt (exklusive), wird igno-
riert. Die Programme

net
foo=19
endnet

und

net\ein kommentar kann beliebig nahe an ein token
foo\ herangehen.

\

=19 endnet \

sind, wenn auch von stark unterschiedlicher Lesbarkeit, gleichwertig. Da das
Zeilenende nicht ignoriert wird, hat ein Kommentar die syntaktische Funktion
eines Leerzeichens.

16
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Reservierte Worter

Es gibt eine Reihe reservierter Worte. Es sind dies die in syntaktischen Kon-
strukten eingesetzten Worte {as func if delay else endguard endif endlet
endmodule endnet endseq exception exports guard import in postfix
let macro module net on overloaded then prefix proc seq suspend
type until where within }.

Prinzipiell gilt, dafl reservierte Namen nicht fiir vom Benutzer definierte
Objekte benutzt werden kénnen. Die reservierten Wérter haben die Eigenschaft,
daB bei ihnen nicht zwischen Grofi- und Kleinschrift unterschieden wird (‘if’ =
‘IF’ = ‘If’ = ‘iF’), wihrnend bei ‘normalen’ Symbolen auf die Unterscheidung
geachtet wird!, d.h. ‘bottom’ # ‘Bottom’.

Spezielle Namen

‘Spezielle Namen’ sind aus nicht-alphanumerischen Zeichen zusammengesetzte
Zeichensequenzen (Typische Exemplare sind +, =%, => und ::). Eine Sequenz
der Form ‘Name, spezieller Name, Name’ mufl nicht durch Leerzeichen getrennt
werden! Dies erméglicht es, ‘a+b’ statt ‘a + b’ zu schreiben.

Zwischenraume

Als Zwischenraum (auch ‘whitespace’ oder ‘atmosphere’ genannt) dienen das
Leerzeichen (BL), der Tabulator (TAB), das Zeilenende-Zeichen (CR), das Zeilenvorschub-
Zeichen (LF) und das Seitenvorschub-Zeichen (FF).

Interpunktion

Als Interpunktionszeichen dienen die runden Klammern, die eckigen Klammern,
die geschweiften Klammern, das Komma, der Punkt (in Dezimalzahl-Literalen),
das Semikolon, der Doppelpunkt und das Gleichheitszeichen.

Alle anderen Symbole kénnen in ‘Special Identifier’n frei verwendet werden.

Grobaufbau eines Programms

Ein Programm ist eine Reihe von Deklarationen, denen eine in die Schliisselwor-
te net und endnet geschlossene Netzbeschreibung folgt. Diese Netzbeschreibung
nimmt normalerweise die syntaktische Form einer Menge lokaler Variablendefi-
nitionen an, kann aber auch aus einer einzigen Expression bestehen.

1 Siehe hierzu auch 4.3.
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2.2 Sprachkonstrukte

2.2.1 Literale
ALDISP kennt Literale der Typen Zahl, String und Character.

Numerische Literale

Es gibt zwei Formen numerischer Literale: ganze Zahlen (Integers) und Dezi-
malzahlen (Reals). Per Default werden alle Zahlen als im Dezimalsystem notiert
interpretiert; ganze Zahlen sind zu anderen Basen (zwischen 2 und 16) notierbar.
Dies hat dann die Form Basis#tzahl.

\ Beispiele f\"ur korrekte ganze Zahlen
0 1 00001 42 -42
8989824783748755835350908935

16#ffe01 8#12763 2#00101101

Dezimalzahlen sind Zahlen mit Dezimalpunkt und optionalem Exponenten.
Exponenten sind ganze Zahlen. Jeder Teil einer Dezimalzahl ist im Dezimalsy-
stem notiert.

\ Beispiele f\"ur korrekte Dezimalzahlen
13.5

13.0 e -13

13.0 E9284235

-124141.141412e9

\ Beispiele f\"ur fehlerhafte Dezimalzahlen
13. el9

13 el9

16#1ef .2c3 16#1ef.16#2c3

.4

12.3 e 3.4

12,23

Literale sind vom Typ Integer bzw. Real. Will man Literale eines anderen
Typs notieren, ist eine explizite Typumwandlung vorzunehmen.

String-Literale

Ein Literal vom Typ String hat die Form "string". Der String darf sichtbare
Zeichen und Blanks enthalten, auch das Kommentarzeichen.

\ Beispiele f\"ur korrekte String-Literale.

llahall
"jhgjsghsdhgDH\JFg\jksdhk\"O\"A\"U$%//$34562356/$%&! ! '# =7¢""
" \ der leere String
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2.2.2 Variablen

Jeder Name?, der kein reserviertes Wort ist, denotiert eine Variable. Es gibt
keine Unterscheidung zwischen Variablen, die Typen, Funktionen und ‘normale’
Werte denotieren. Syntaktisch gibt es zwei Arten von Namen: normale und
spezielle.

identifier ——  normalld
| specialld
normalld ——  Alpha AlphaNum*
specialld ——  Special Special*
Alpha —  “A-Z a-z _” und lokale Umlaute
AlphaNum +——  Alpha
| “0123456789”
Special —  “!1$%&*0/7"+_-"" und verfiighare mathematische
Symbole

\ einige syntaktisch korrekte Namen

a _b char2int

djhHKGh jdtfhJKHIfddf2635JSHF jdf __dsfjhdf_234
+ ok T H+#T 7 kbkb+ 717

\ einige syntaktisch falsche Namen
number? set! C++ Modula-2 23skidoo

Will man, z.B. bei der Ubertragung von Sprachen aus anderen Sprachen,
Namen benutzen, die diesen Konventionen nicht geniigen, kann man diese in
Hochkommata setzen.

\ gueltige Namen sind
’atb’ ’set!’ ’name mit leerzeichen’ ’punk.tiert’ ’>7’

Das ’>7-Beispiel ist interresant, da es sich hierbei eigentlich um einen legitimen
speziellen Namen handelt. Da aber >’ und ’?’ vordefinierte Infix- bzw. Prafix-
Operatoren sind, wiirde der Parser *>7° in zwel Token aufzutrennen versuchen!
Es gilt: der Parser versucht, von links nach rechts den grofiten Subnamen zu
finden. Beispiel:

\ seien als operatoren definiert: + ++ * ** +%%
+++ \ > + ++

++3k ok \ => ++ *% %

+H+kokk \ => + ++ ** %, nicht ++ +** * |

2“Name” = “Symbol” = “Identifier”
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Natiirlich ist es stilistisch sehr schlecht, derartig obskure Operatoren iiberhaupt
erst einzufiihren! Sind derartige Operator-Ansammlungen unvermeidlich (z.B.
bei Kombinationen von Funktionalen), sollten sie auf jeden Fall durch Leer-
zeichen getrennt werden, wenn die einzelnen Operatoren nicht “herausragend”
genug sind.

Parser-Anweisungen

Parser-Deklarationen verdndern den Status von Symbolen, die vom Parser, d.h.
von der Syntaxphase des ALDiSP-Compilers, gelesen werden. In dieser Phase
haben Symbole (Namen) noch keine Bedeutung; der Parser kann nur zwischen
normalen und speziellen Symbolen und reservierten Worten (wie z.B. if) unter-
scheiden. Durch Parseranweisungen kénnen Namen als Infix, Préafix oder Postfix
deklariert werden. Dies erméglicht gewohnte Notationen wie

atb \ ’+’ infix

n! \ 1’ postfix

sin 3 \ ’sin’ pr\"afix

x element0f set \ ’elementOf’ infix

Die ensprechenden Deklarationen miissen vor der erstmaligen Benutzung
erfolgen. Wenn ein Name einmal als In/Pra/Postfix deklariert worden ist, kann
er nicht mehr anders benutzt werden!

func elementOf(x,set) = ...definition...
. foo elementOf bar .... \ falsch
. elementOf(foo,bar) ... \ korrekt
INFIX "elementOf"
. foo elementOf bar .... \ korrekt
. elementOf(foo,bar) ... \ falsch

Jeder Name kann in Hochkommata gestellt werden. Dabei verliert er spezi-
elle Parser-Attribute. In/Pri/Postfix—Notation kann auch in Funktionsdeklara-
tionen auftreten!

POSTFIX "I" \ oder
FUNC n! = \ FUNC ’!1’(n) =
if n=0 then 1 else n*(n-1)! \ if n=0 then 1 else n*’!’(n-1)

Wenn mehrere Parser-Deklarationen aufeinander treffen, kann es zu Konflikten
kommen. Aus diesem Grunde gibt es Bindungsstdrken und Assoziativitdtsre-
geln. Die meisten Infix-Operatoren sind links-assoziativ; nur wenige (z.B. ‘::’, das
Infix-Cons) sind rechts-assoziativ. Es gibt 5 Bindungsstarken (1-5), 5 bindet am
starksten. Die Angabe von Bindungsstiarken bei der Parserdeklaration ist optio-
nal, als Voreinstellung wird 3 angenommen. Die Standard-Funktionsanwendung
bindet starker als Postfix, Postfix bindet stiarker als Préfix, Prafix bindet starker
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als Infix. Gleichstarke links- und rechtsassoziative Operatoren diirfen nicht ge-
mischt werden.

INFIX "and","or" :1
INFIX "=" R nyn R ngn .o

INFIX ||+||’||_|| :3
INFIX ll/ll s ll*ll :4
INFIX """ :5 \ Potenzierung

3>4 and a"b+c*d=42 \ (3>4) and (((a"b)+(c*d)) = 42)

POSTFIX "I"

PREFIX "sin"

sin 42 ! \ sin (42 1)

sin 3+4 \ (sin 3)+4

sin a(b) \ sin (a(b))

sin a!(b) \ sin ((42 1)(b))
R-INFIX "::" : 3

a::b::nil \ a::(b::nil)
a-b-c \ (a-b)-c
a-b-c::d::nil \ Syntax Error

Parser-Deklarationen sind lokal zum File. Es gibt die Parser-Deklarationen
L-INFIX (links-assoziativ infix), R-INFIX (rechts-assoziativ infix), INFIX (dassel-
be wie L-INFIX), PREFIX und POSTFIX. Nur die Infix-Deklarationen kénnen mit
Bindungsstiarken versehen werden. Nur die Ziffern ‘17,2’ 3’ ‘4’ und ‘5’ sind giilti-
ge Bindungsstirken. Die Namen der definierten Operatoren sind in Anfiihrungs-
zeichen zu setzen, wenn es sich um spezielle Namen handelt; bei normalen Be-
zeichnern sind die Anfithrungszeichen optional. Dies gilt auch fiir die Auflistung
von Operatoren in Im- und Exportlisten.

2.2.3 Funktionsapplikation

Die Standard-Form der Funktionsanwendung hat die Form
expr(argy, ... ,arg,)

Die Semantik ist einfach: die expr und die arg; werden in nicht festgelegter
Reihenfolge, moglicherweise auch parallel, ausgewertet. Ist dies geschehen, wird
das Ergebnis der Auswertung von ezpr auf die Argumente angewandt. Ist eine
Anwendung nicht moglich (weil expr sich zu keiner Funktion, zu einer Funkti-
on der falschen Stelligkeit oder eines falschen Typs ausgwertet hat), liegt eine
Fehlersituation vor; das Ergebnis der Funktionsapplikation ist bottom.
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Syntaktisch andere Formen der Funktionsapplikation (In/Pra/Postfix-Ope-
ratoren) verhalten sich semantisch nicht anders. Man kann sich vorstellen, daff
ein komplexer Ausdruck mit nicht-Standard-Applikationen vom Compiler in
einen Standard-Ausdruck umgewandelt wird, der dann zur Laufzeit ausgefiihrt
wird:

sin a+b!*42 — ’+’(sin(a),(’*’ (1’ (b),42))

Im Gegensatz zu anderen Sprachen sind die logischen Operatoren and und
or normale Funktionen, deren Argumente alle ausgewertet werden.

2.2.4 Sequenzen
Eine Sequenz hat die Form
seq stmt; ; ... stmi, ; expr endseq

Eine Sequenz wird ausgewertet, indem die stmts der Reihe nach, von links nach
rechts, ausgefithrt werden; am Ende wird die ezpr berechnet und ihr Resultat
als Ergebnis der Sequenzauswertung zuriickgegeben. Eine Sequenz ist ein syn-
taktischer Block, d.h. innerhalb der Sequenz definierte Namen sind auflerhalb
der Sequenz nicht sichtbar. Sequenzen werden eingesetzt, um Nebeneffekte zu
erzeugen:

proc readFileObj(name: String): 0bj =
seq
fd=openFile(name);
(obj,fd) =readFile(£d);
closeFile(fd);
obj
endseq

Der Einsatz von Sequenzen ist dort notwendig, wo eine Auswertungsreihen-
folge vorgegeben oder Parallelitit verhindert werden mufl. Dies sollte nur bei
der Erzeugung von Nebeneffekten der Fall sein. Wie die Statements, die in der
Sequenz auftreten, aussehen, erkldrt der nichste Abschnitt.

Wertet sich ein Statement in einer Sequenz zu einer Suspension aus, so
blockiert die Auswertung der Sequenz, bis die Suspension ausgewertet ist. Es
gilt die Transformationsregel

seq stmt ; ...rest... endseq
= suspend seq ...rest... endseq until sémi within 0,0

2.2.5 Statements

Es gibt zwei Arten von Statements: Prozeduraufrufe und sequentielle Defini-
tionen. Letzere lassen sich durch ’normale’; geschachtelte lokale Definitionen
beschreiben; erstere sind nebeneffektbehaftete Expressions, kénnen also auch
auferhalb von Sequenzen auftreten.
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Prozeduraufrufe

Der Aufruf einer Prozedur unterscheidet sich nicht vom normalen Funktions-
aufruf. Es wird empfohlen, keine Prozeduren als In/Pra/Postfix-Operatoren zu
vereinbaren und die Nebeneffektbehaftetheit der Prozeduren durch sinnfallige
Namen (wie Set XXX oder assign XXX oder Do XXX) deutlich zu machen.

Sequentielle Definitionen

Eine einfache sequentielle Definition hat die Form name = stmt. Die Definition
wird ausgefiihrt, indem das stmf ausgewertet wird und der entstehende Wert
im aktuellen Environment an den Namen gebunden wird. Der Giiltigkeitsbe-
reich von Namen in Sequenzen ist die Restsequenz rechts von der Definition des
Namens: In der Sequenz

seq fd=OpenOutputFile("bla",Byte);
fd=writeToFile(fd,42);
closeFile(£fd)

endseq

erstreckt sich der Giiltigkeitsbereich des ersten £d vom zweiten Statement bis
zum Ende; im zweiten Statement wird ein neues f£d definiert, das vom drit-
ten Statement bis zum Ende gilt und das erste £d {iberdeckt. Aufgrund dieser
Sichtbarkeitsregel ist es nicht mdoglich, mit sequentiellen Definitionen Rekursi-
vitit zu erreichen®. Sequentielle Definition werden benutzt, um die Ergebnisse
von Prozeduraufrufen weiterverwenden zu kénnen.

2.2.6 Das Konditional

Die einfachste Form des Konditionals ist die Expression der Form
if expries: then expripen, endif

Bei der Auswertung dieses Ausdrucks wird zuerst expri.; ausgewertet; ist das
Ergebnis gleich dem Objekt true, so wird expripe, ausgewertet und das Resul-
tat als Ergebnis der Auswertung des Konditionals zuriickgegeben. Wenn sich
expriesy zu false auswertet, ist das Ergebnis bottom. Wenn sich expri.s¢ zu et-
was anderem als true oder false auswertet, liegt eine Fehlersituation vor; das
Ergebnis ist bottom.

Die zweiteinfachste Form des Konditionals ist

if expries: then expripen else expres. endif

Die Auswertung ist dieselbe wie die im vorigen Fall; wenn sich allerdings ezpryes:
zu false evaluiert, wird ezprese evaluiert und das Resultat als Ergebnis des
Konditionals zuriickgegeben.

Die allgemeine Form des Konditionals ist

3Wir wollen hier die Méglichkeit des Y-Kombinators aufier acht lassen.
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if erpries:, then expripen,
| EIPTtest, then EIPTtheno

| expricst, then expripen,
else €TPTthen,, 11
endif.

Bei der Auswertung dieses Ausdrucks werden die expriest, nacheinander aus-
gewertet, solange sich alle zu false auswerten, bis sich eins zu true evaluiert.
Evaluiert ein expriest, sich vorher zu einem Wert ungleich false, liegt eine Feh-
lersituation vor, und die Auswertung terminiert mit bottom als Ergebnis. Hat
sich expriest, zu true evaluiert oder gibt es nur k£ — 1 lest-Klauseln, aber eine
else-Klausel, so wird expripen, ausgewertet und das Ergebnis als Resultat des
Konditionals zuriickgegeben.

2.2.7 Die Abstraktion

Eine Abstraktion ist ein Ausdruck, von dem abstrahiert wird, d.h. der parame-
trisiert ist. Jeder Ausdruck kann als Kérper einer Abstraktion auftreten. Das
Ergebnis einer Abstraktion ist eine Funktion®. Ein Header definiert den Namen
der Funktion und die Parameter. Optional kénnen die Typen der Parameter
und der Typ des Funktionsergebnisses genannt werden.

Eine Standard-Funktionsdefinition hat die Form

func namey ( namey, ... , name,) = erpr.

Jeder der Namen namey, ... ,name, kann mit einer Typdeklaration der Form
: typ versehen werden.

Eine Funktionsdefinition wird ausgefiihrt, indem ein Objekt vom Typ Function
erzeugt wird. Wenn dieses Objekt spater im Rahmen einer Funktionsapplikati-
on auf n Argumente arg; ... arg, angewandt wird (nachdem diese ausgewertet
sind), wird die ezpr in einem Environment ausgewertet, das dem Environment
an der Stelle des Programms, an dem das Funktionsobjekt erzeugt worden 1st,
erweitert um das Environment, in dem jeder name; mit dem entsprechenden
arg; assozilert ist, entspricht.

Dies entspricht den ‘normalen’ Scope-Regeln, wie sie z.B. aus PASCAL und
C bekannt sind.

Wenn Parameternamen mit Typen attributiert werden, so verdndert dies
die Semantik des entstehenden Funktions/Prozedurobjekts dahingehend, dafl
der Definitionsbereich der Funktion/Prozedur fiir dieses Argument auf den ent-
sprechenden Typen eingeschrankt wird, d.h. jeder Aufruf mit einem Argument
“falschen” Typs eine Fehlersituation darstellt und bottom als Resultat liefert.

Eine syntaktische Variante der Typisierung der Einzelparameter ist die Ty-
pisierung der ganzen Funktion/Prozedur: nach der schliefenden Klammer der

40der ein parametrischer Typ oder eine Prozedur.
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Paramterliste kann ein : typ stehen, das die Typisierung des Resultats angibt. Die
Typisierung des Resultats bringt eine der Typisierung von Argumenten dhnliche
Semantik mit sich: resultiert eine Applikation des Funktions/Prozedurobjekts
in einem Wert falschen Typs, so liegt eine Fehlersituation vor; der resultierende
Wert ist bottom.

Weitere syntaktische Varianten von Funktionsdefinitionen sind Pra-, Post-
und Infix-Operatoren, die auch in Funktionsdefinition so geschrieben werden
miissen wie in der Applikation: statt

func ’+’(a,b)=

callAddRoutine(a,b)
func ’!’(n)=

if n=0 then 1 else n*(n-1)! endif
func ’cos’(x)=

sin(x-pi/2)

kann es

func atb =

callAddRoutine(a,b)
func n! =

if n=0 then 1 else n*(n-1)! endif
func cos x =

sin(x-pi/2)

heiflen. Will man dies dann typen, muss man den Typen der Funktion als Ganzes
angeben. Die typisierten Varianten der o.a. Beispiele konnte so aussehen:

func a + b : (number,number -> number) =
callAddRoutine(a,b)

func n! : (nat -> nat) =
if n=0 then 1 else n*(n-1)! endif

func cos x : (real -> real) =
sin(x-pi/2)

Funktionen hdherer Ordnung

Eine Funktion héherer Ordnung (higher-order function) ist eine Funktion, deren
Resultat eine Funktion ist >. ALDiSP erlaubt die Definition von Funktionen be-
liebiger Ordnung. Ein Beispiel ist die Kompositionsfunktion fo g = A z.f(g(x)):

func comp(f,g) =

5Prazise: eine Funktion, die eine Funktion der n-ten Ordnung zum Ergebnis hat, ist selbst
von der Ordnung n+1. Daten sind ‘Funktionen der Ordnung 0’. Aber so genau nimmt man es
im Allgemeinen nicht; eine Sprache erlaubt entweder gar keine Funktionen héherer Ordnung,
oder alle.
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let
func tmp(x)=
f(g(x))
in
tmp
endlet

Hier wird eine Funktion (tmp) erzeugt und als Resultat zuriickgegeben. Eine
dquivalente Formulierung erspart die, eigentlich unnétige, Benennung der Funk-
tion:

func comp(f,g)(x) = £(g(x))

Es ist in ALDiSP nicht moglich, Funktionen variabler Stelligkeit zu notieren;
daher kann keine allgemeine Kompositionsfunktion definiert werden.®

2.2.8 Parametrische Typen

Ein parametrischer Typ ist eine Funktion, die einen Typen zum Resultat hat.
Typwertige Funktionen werden statt des des Schliisselworts func mit type de-
finiert. (Unter der operationalen Typ-Interpretation ist dies nicht notwendig,
aber faktisch unterliegen Typterme eigenen Bildungsregeln. Auch ist der Doku-
mentationswert nicht zu unterschitzen.

type IntegerBetween(l,h)(x) =
isInteger(x) and x>=1 and x<h

Auch einfache Typgleichungen sind mit type einzuleiten:
type OddIntegers = Integer and is0dd

Bei diesen Beispielen zeigt sich wieder die Gleichwertigkeit von einstelligen
Pradikaten und Typen.

2.2.9 Prozeduren

Eine Prozedur ist eine Funktion, die Nebeneffekte erzeugen kann. Fine Prozedur
wird wie eine Funktion definiert, aber mit dem Schliisselwort proc statt func.
Auch der Aufruf erfolgt auf gleiche Weise. Beispiel:

6Es ist aber klar, wie eine Erweiterung aussihe: Man 148t einfach die Klammern bei der
Applikation weg; eine Variable (bzw. eine Expression) steht dann fiir die ganze formale (bzw.
aktuelle) Parameterliste: func comp(f,g) x = £ g x Das syntaktische Problem dabel ist die
Unterscheidung zwischen dem 1-Tupel und seinem Inhalt. £(g x) impliziert, das g genau
einen Wert als Resultat liefert, kann aber auch als einfache Klammerung gesehen werden!
Um diesen Problemen zu entkommen (und weil die Struktur eines Programms nicht gerade
lesbarer wird, wenn mit variabelstelligen Funktionen gearbeitet wird), ist diese Erweiterung
nicht iibernommen worden.
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\ Diese Prozedur schreibt einen Word-Wert byteweise in falscher
\ Reihenfolge in einen Port.
proc writeIntelWord(P:Port, V:Word) =
seq
WriteToPort (P, [!Byte] (V and 16#ff));
WriteToPort (P, [!Byte] (rshift(V, 8) and 16#ff));
endseq

2.2.10 Lokale Variablen
Ein Konstrukt der Form

let vary = expry

var, = expry
in
expr
endlet

definiert n lokale Variablen. Diese Deklaration wird ausgewertet, indem die n
expr; in unbestimmter Reihenfolge, u.U. auch simultan, evaluiert werden und
an die n var; gebunden werden. Hierbei sind rekursive Funktionsdefinitionen
moglich (Funktionen werden tiber das normalen func-Schliisselwort deklariert),
d.h. die var; sind wahrend der Evaluierung der exzpr sichtbar, aber mit unbe-
stimmten Werten belegt.

Die Bindung der Variablen findet in einem neuen Environment statt und
hat keinen Einfluff auf das Environment, in dem die lokale Definition stattfindet
(d.h., ein neuer Scope wird aufgemacht); in diesem Environment wird dann die
expr ausgewertet und ithr Wert als Ergebnis der lokalen Definition zuriickgege-
ben.

Eine syntaktisch andere, aber semantisch dquivalente Ausprigung der loka-
len Variablendefinition ist

let expr
where
var; = expr;

var, = expry
endlet

Oft 1st diese Formulierung lesbarer.
Die lokalen Variablen sind (trotz ihres Namens) keine ‘echten’ Variablen,
deren Wert gedndert werden kann, sondern ‘single-assignment’ Namen, also
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‘temporédre Namen’ fiir Ausdriicke. Es liegt keine Verletzung der referentiellen
Transparenz vor!”

2.2.11 Multiple Riickgabewerte

Funktionen (eigentlich alle Ausdriicke) kénnen mehr als einen Wert zum Resul-
tat haben. Das Konstrukt

Cexpry , ... ,expry)

berechnet die n expr; in unspezifizierter Reihenfolge (oder auch parallel) und
bildet einen n-stelligen multiplen Wert. Das einzige, was mit einem solchen mul-
tiplen Wert gemacht werden kann, ist die Riickgabe als Funktionswert und die
Benutzung in einer n-stelligen Variablendeklaration. Es ist weder moglich, mul-
tiple Riickgabewerte direkt in Funktionsapplikationen einzusetzen, noch sie in
Einzelvariablen zu speichern. Ein n-stelliger Wert mufl in einem Schritt n Va-
riablen zugewiesen werden!

Bsp:

(x,y) = (3,4 \ ok

func foo(n)=
(n+1,n-1)

(x,y)=foo(3) \ x=4,y=2
z=foo(3) \ Syntax Error
(a,b,c)=foo(3) \ Syntax Error

func diff(a,b)
abs(a-b)

diff(foo(3)) \ Syntax Error

2.2.12 Module

ALDiSP-Programme sind in unterschiedliche Module aufgeteilt. Ein Modul kap-
selt eine Reihe von Variablen- und Funktionsdeklarationen von der Umgebung
ab. Jedes Modul verfiigt iiber eine Schnittstelle in Form von Import- und Export-
Deklarationen, die festlegen, welche Definitionen aus welchen anderen Module
benutzt werden und welche Definitionen das Modul exportiert, d.h. offentlich
macht.

Die syntaktische Form eines Moduls 1st

"Diese Erliauterung erfolgt auf besonderen Wunsch des Betreuers.
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Module ModulName

Exports namei,, ..., names,
Exports name;, ... namej,
...Deklarationen...

EndModule ModulName

Innerhalb der Deklarationen kénnen Importe auftreten (genauer: Importe
sind Deklarationen). Eine Import-Deklaration hat die Form

Import namey, ..., name, From ModulName

und ist gleichwertig mit Standard-Deklarationsform

name; = ModulName("name;")

name,, = ModulName("name,")

Natiirlich ist dieser “qualifizierte Zugriff” auch in einer Expression méglich.
Aus Ubersichtlichkeitsgriinden wird dennoch empfohlen, die Standard Import /-
Export-Deklarationen zu benutzen; sie sind méachtig genug und vergréfern die
Ubersichtlichkeit.

Sowohl in den Import- als auch in den Export-Listen kénnen optionale Typ-
deklarationen der Form :typ und Umbenennungen der Form as NeuerName
gemacht werden. Ersteres wird empfohlen, um die ‘Signatur’ der im- und expor-
tierten Funktionen klar zu machen; aulerdem ermdoglicht es die so gewonnene
Redundanz dem Compiler, mehr Fehler festzustellen und stérker zu optimieren.
Letzteres ermoglicht es; Namensiiberschneidungen zu vermeiden. Beispielfrag-
ment:

Module LongInt
exports + as LongIntAdd: (LongInt,LongInt —> Longlnt)

Module sind reine Deklarationstrager; in ihnen darf es keine imperativen
Teile geben. So kann ein Modul wie ScreenI0 kein bereits getffnetes File wie
keyboard: InputFile exportieren — das Offnen eines Files ist ein Nebeneffekt.
reminder:

Das édndert sich vielleicht noch!

Die Deklarationen erfolgen ‘parallel’, d.h. es Rekursivitat ist erlaubt. Module
diirfen zwar Prozeduren definieren und exportieren, wihrend der Modulauswer-
tung diirfen aber keine Nebeneffekte auftreten.

Module entsprechen grob Files — ein Modul kann nicht auf mehrere Files
aufgeteilt werden; meist gibt es daher eine 1:1-Relation zwischen Modulen und
Files. Es ist aber auch moglich, mehrere Module (oder auch das ganze Pro-
gramm) in ein File zu schreiben. Mehr dazu im Abschnitt 2.4. Der Name main
ist als Modulname nicht erlaubt. Module sollten nicht geschachtelt werden.
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2.2.13 Ausnahmefall-Vorbereitung

Eine Ausnahmefall-Vorbereitung (exception handler) ist ein Konstrukt, das er-
wartete Fehlersituationen handzuhaben in der Lage ist. Die grundlegende Idee
dabei ist die des direkten Verlassens einer Berechnung, wenn ein Fehler auftritt.
Das typische Beispiel fiir einen Fehler ist die Division durch Null: Wenn mit
interaktiv eingegebenen Daten gearbeitet wird, sind fehlerhafte Daten aller Art
jederzeit moglich. Es ist sehr aufwendig, alle Daten vor ihrer Verwendung auf
ihre Korrektheit hin zu iiberpriifen. Sinnvoller scheint es, einen Mechanismus zu
konstruieren, der dafiir sorgt, dafl, wenn ein Datensatz zu Fehlern fiihrt, er neu
eingelesen wird. Das sieht dann so aus:

proc do_interaktion() =
seq
daten = read_datensatz();
guard verarbeite_datensatz()
on DivisionByZero(n) = \ im Lauf der Berechnung
seq \ wurde n durch 0 geteilt.
writeMessage("Division durch Null: "
++ "Bitte Daten neu eingeben!");
do_interaktion()
endseq
on NumericOverflow() =
seq
writeMessage("Numerischer \"Uberlauf: "
++ "Bitte Daten neu eingeben!");
do_interaktion()
endseq
endguard

Die Exceptions DivisionByZero und NumericOverflow sind vordefiniert
(Sie werde im Pseudo-Modul Numbers definiert) und werden von numerischen
Funktionen im Fehlerfall aufgerufen.

Das Konstrukt hat die allgemeine Form

guard expr

on FEzception-Definitiong
on FEzception-Definition,,
enguard

Jede Ezception-Definition; ist dabei syntaktisch eine Prozedurdefinition, aller-
dings ohne der das Schliisselwort proc. Die Prozeduren miissen verschiedenen
Namens sein. Es ist nicht erforderlich, die Namen vorhandener Exceptions zu
benutzen.



KAPITEL 2. ALDISP REPORT 31

Wie wird eine Exception aufgerufen? Die Definition der Division kénnte so
aussehen:®

exception DivisionByZero(n) = \ standard-exception, sollte

seq \ im top-level definiert sein
writeMessage(NumberToString(n));
writeMessage("sollte durch O geteilt werden");
return(bottom)

endseq

func ’/’(a,b) =
if b=0 then DivisionByZero(a)
else divide(a,b)
endif

Exceptions sind spezielle Funktionen. Wenn im Rahmen der Aufrufreihen-
folge kein guard-Konstrukt aufgetreten ist, so wird die urspriingliche Excep-
tion-Funktion aufgerufen. Ein guard-Konstrukt ersetzt diese Funktion durch
eine andere. Dies gilt jedoch nur lokal zu dem Ausdruck, der durch das guard
bewacht wird. Wenn guard—Ausdriicke geschachtelt werden, gilt immer der in-
nerste Ausdruck.’

Nachdem eine Exception abgearbeitet ist, kehrt die Auswertung nicht au-
tomatisch zum Punkt des Aufrufs zuriick, sondern macht ‘hinter dem guard’
weiter. Will man dort weiterfahren, wo der Fehler aufgetreten ist, so verrichtet
die (Pseudo—) Funktion return diesen Dienst. Beispiel: Unter den Definitionen

func reziproki(x) =
guard 3+(1/x)

on DivisionByZero(n)
endguard
func reziprok2(x) =
guard 3+(1/x)

on DivisionByZero(n) = return(42)
endguard

42

gilt:
reziproki1(0) = 42
reziprok2(0) = 45

8Man kann sich jetzt fragen, warum ‘/’ als func definiert werden kann, wenn es denn einen
Nebeneffekt erzeugen kann. Es gibt mindestens drei Erklarungen dafiir: a) Exceptions ‘zihlen
nicht’ als ‘echte’ Prozeduren, b) writeMessage erzeugt keinen ‘echten’ Nebeneffekt, c) da der
zuriickgegebene Wert L ist, liegt eine Fehlersituation vor. Wenn aber der Programmierer ex-
plizit signalisiert, daf3 eine Berechnung fehlerhaft war, muf} ihn der Interpreter/Compiler nicht
noch darauf hinweisen... Keine von diesen Erklirungen ist die ‘richtige’; fest steht: aus prag-
matischen Griinden miissen auch Funktionen in der Lage sein, Fehlermeldungen abzugeben.

9Faktisch implementieren Exceptions das ‘dynamic binding’ frither LISPs.
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2.2.14 Rundungs- und Uberlaufmechanismen: Makros

ALDiSP ist stark numerisch orientiert. Der IEEE-Standard fiir Floating-Point-
Zahlen sieht mindestens vier Rundungs-Modi vor (‘round to nearest / to 400 /
to +00 / to 0°), die durchaus noch weiter verfeinert werden kénnen (Anzahl der
zu rundenden Bits). Weitere Rundungsmethoden werden in DSP-Prozessoren
und -Sprachen eingesetzt. Auch die Behandlung von Uberliufen fallt unter den
allgemeinen Rundungsbegriff (‘Behandlung von Ergebnissen, die nicht in voller
Prazision darstellbar sind’).

All diese Rundungsmethoden miissen in ALDiSP darstellbar sein. Behufs
diesen Zweckes gibt es einen generellen Mechanismus, der jeden denkbaren Run-
dungsmechanismus zu modellieren in der Lage ist.

Grundlage sind die Exceptions. Bei jeder numerischen Bereichsiiberschrei-
tung wird eine ‘Overflow’-Exception aufgerufen (genauer gesagt, gibt es fiir je-
den distinkten breitesten numerischen Typen eine derartige Excpeption, also
auf jeden Fall fiir Integer, Fixpoint und Real). Diese bestimmt, was als Ergeb-
nis geliefert werden soll. Per Default gilt:

e Die Integer- und Fixpoint- Typen melden einen Fehler und liefern bottom

e Die Real-Typen melden keinen Fehler und liefern einen der Unendlich-
keits-Werte.

Die Behandlung der Rundung in Reals und bei Integer-Divisionen ist nicht
so einfach, aber machbar: Es gibt eine DivisionRoundException, die als Ar-
gumente den Divisor und den Dividenden erhilt und als Ergebnis +1 oder -1
liefert, je nachdem, ob auf- oder abgerundet werden soll.

Der hiufigste Fall eines nicht-Standard-Uberlaufverhaltens ist das Rechnen
mit Saturierten Zahlen (MAXINT = +o00). Fiir diesen Spezialfall gibt es spezi-
elle saturierte Operatoren. In allen anderen Féllen muf} jedoch eine Abweichung
von der normalen Rundungsdisziplin explizit markiert werden. Eine Expression
der Form

guard atb
on IntegerOverflow(X) = SaturatedIntegerOverflow(X)
on RealOverflow(X) SaturatedRealOverflow(X)
on FixpointOverflow(X) = SaturatedFixpointOverflow(X)
endgaurd

wertet die Expression a+bin einer Umgebung aus, in der ein saturiertes Overflow-
Verhalten herrscht. Dieser Ausdruck ist etwas unhandlich. Leider kann man,
aufgrund der call-by-value Aufrufstrategie, keine Funktion schreiben, die das
guard schachtelt. Es gibt daher, speziell fiir diesen Zweck, eine Funktionsart
macro, die call-by-name ausgewertet wird, also durch textuelle Substitution.
macro—Funktionen diirfen nicht rekursiv sein! Ein Beispiel:
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macro Saturated(expr) =
guard expr
on IntegerOverflow(X) SaturatedIntegerOverflow(X)
on RealOverflow(X) SaturatedRealOverflow(X)
on FixpointOverflow(X) = SaturatedFixpointOverflow(X)
endguard

Unter dieser Definition wird Saturated(a+b) zum o.a. Term ausgeweitet, ist
also voll dquivalent. Man kann sich jetzt vorstellen, dafl eine primitive Funktion
, also die saturierte Addition, folgendermaflen definiert ist:

Wie ((+h77
macro ’+°’ (expril,expr2) =
Saturated(expri+expr2)

2.2.15 Das Delay
Ein Konstrukt der Form
delay ecxpr

wird Delay genannt. Es ermdglicht die verzdgerten Auswertung (lazy evaluati-
on) von Ausdriicken; eine Technik, die bei der Implementierung von Streams
Verwendung findet.

Ein Delay evaluiert sich zu einem Objekt (genannt Promise!”), das, wenn
spater durch eine primitive Funktion auf dessen Wert zugegriffen wird, den
Wert annimmt, der bei der Auswertung von ezpr entstehen wiirde. Man kann
sagen, dafl expr erst dann ausgewertet wird, wenn das Ergebnis fiir den Fort-
gang des Auswertungsgeschehens gebraucht wird (daher auch die gebriuchli-
che Bezeichnung call-by-need. Die normale Auswertungsstrategie in ALDiSP ist
call-by-value.). Der Aufwand bei der Promise-Bildung ist konstant. Es gibt kei-
ne Moglichkeit, einen ‘verzégerten” Wert von einem ‘ausevaluierten” Wert zu

unterscheiden.
Als kleines Beispiel fiir die Benutzung von Delays folgt ein Programm, das
die Summe der ersten n Primzahlen berechnet.

10)

func nat(n) = \ die Zahlen n...unendlich
n :: delay nat(n+1)

func filter(x,s) = \ Aus s werden alle Vielfache von x entfernt
if mod(head(s),x)=0 then filter(x,tail(x))
else head(x) :: delay filter(x,tail(x))
endif

1°Der begriff entspringt dem Scheme-Jargon [2][5]. Andernorts werden die entstehenden
Objekte ‘Suspensions’ genannt; aber dieser Begriff ist in ALDiSP schon verbraucht. Funktio-
nale Sprachen, die ‘lazy’ sind, brauchen keinen dementsprechenden Begriff, da jeder nicht-
Konstante Ausdruck eine Promise (ein Apply-Knoten) ist.
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func first(n,s) = \ die ersten Elemente einer Liste
if n=0 then EmptyList
else head(s) :: first(n-1, tail(s))
endif

func nPrims(n) = \ die ersten n Primzahlen
let
func prim(s) = \ alle gegenseitigen Vielfachen aus s entfernen
head(s) :: delay prim(filter(head(s),tail(s)))

in
first(n, prim(nat(2)))
endlet
func summePrim(n) = \ summe der ersten n Primzahlen

reduce(’+’ ,nPrims(n))

2.2.16 Typ-Deklarationen

Jeder Ausdruck liefert bei der Auswertung ein Ergebnis. Es ist syntaktisch
moglich, so ziemlich allen Ausdriicken Typen zuzuordnen. Eine solche Typzu-
ordnung manifestiert die Intention des Programmierers, dafl der Ausdruck sich
zu Werten des angegebenen Typs auswertet. Es gibt in ALDiISP keinen Zwang,
irgendwelche Typangaben zu machen; der Compiler/Interpreter inferiert alle
Typen von selbst bzw. meldet sich mit Fehlermeldungen, wenn keine ‘ordentli-
che’ Typisierung gefunden werden kann. Es ist jedoch aus mehreren Griinden
sinnvoll, selbst Typangaben zu machen:

e Typisierungen sind ein zentrales Software-Dokumentations-Konzept.

e Der Interpreter/Compiler hat die Moglichkeit, herauszufinden, ob die von
ihm gefundene Typisierung (das ist die allgemeinste mogliche Typisiserung
eines Ausdrucks) mit der Vorgabe iibereinstimmt.

o Viele automatische Programm-Optimierungen sind nur moglich, wenn ex-
tensives Wissen {iber Wertebereiche (und nichts anderes sind Typen!) von
Variablen und Parametern vorgegeben werden.

Die allgemeine Typdeklaration hat die Form [typ] expr. Die Laufzeit-Semantik
ist die, dafl nach der Evaluation von ezpr gepriift wird, ob das Ergebnis vom
Typ typ ist. Ist dies nicht der Fall, liegt eine Fehlersituation vor, das Ergebnis
ist bottom.

2.2.17 Typumwandlung

Typumwandlung (Casting) ist die Umwandlung eines Objekts in ein “Aquiva-
lentes” Objekt eines anderen Typs. Nicht zwischen allen Typen ist eine solche
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Umwnadlung moéglich. Die syntaktische Form der Umwandlung ist
L' typl expr

Bei der Auswertung der Umwandlung wird zuerst die expr ausgwertet, da-
nach wird sie zum &dquivalenten Objekt des Typs typ gewandelt. Die Umwand-
lung geschieht iiber den Aufruf einer Umwandlungsfunktion. Eigene Umwand-
lungsfunktionen kénnen leicht in das System integriert werden. Die global be-
kannte iiberladene Funktion coerce dient diesem Zweck. Hat man z.B. gerade
einen neuen Typ Real42 samt Umwandlungsfunktionen Real32ToReal42 und
Real42ToRealb4 definiert, so kann mit der Deklaration

module Real42
export Real32ToReal42 as Coerce : (Real32 -> Real42),
Real42ToReal64 as Coerce : (Real42 —> Real64)

die Funktion Coerce im Definitionsbereich erweitern. Eigentlich ist dies keine
korrekte Uberladung (da normalerweise nur der Definitionsbereich iiberladen
wird (ALDiSP ist nicht ADA!)), sondern eine globale Deklaration aus einem Mo-
dul heraus, die als Overloading getarnt ist, um nicht ein neues Syntax-Konstrukt
einfithren zu miissen.

Bei der Typwandlung sollte kein Informationsverlust stattfinden'!.

2.2.18 Saturierte Typumwandlung

Eine saturierte Typumwandlung ist die Umwandlung eines numerischen Objekts
in ein numerisches Objekt eines anderen Typs, der iiber maximale und minimale
Werte verfiigt. Ist eine ‘korrekte’ Umwandlung nicht méglich, weil das umzu-
wandelnde Objekt zu grofi oder zu klein ist, ist stattdessen dieser maximale bzw.
minimale Wert Ergebnis. Eine saturierte Typumwandlung hat die Form

[ typ] expr

Beispiele:

["Integer16165000 =—> 32767
[“Cardinall6]65000 — 65000
["Integer16]-65000 =—>  -32768

["Cardinal16]-65000 = 0
["Integer16] plusInfinity = 32767

HSjehe dazu: ?7. Natiirlich ist dies vom Compiler nicht nachpriifbar!
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2.2.19 Typterme

Typterme sind die Argumente von Typdeklarationen und Typumwandlungen.

Da Typen Datenobjekte sind, werden Typterme durch normale Ausdriicke geform
Die einfachsten Typterme sind die Namen der primitiven Typen wie Bool, Int16

oder Real. Die komplexere Typen haben Argumente, wie z.B. List ({ype) oder

Array(size). Schliefilich lassen sich Typen durch and (Schnittmenge zweier Ty-

pen), or (Vereinigungsmenge) und not (Komplementmenge eines Typs) kom-

binieren. Die allgemeinste Form eines Typterms ist die des Pradikattyps: Jede

Expression, die sich zu einem einstelligen Pradikat auswertet, wird als der Typ

verstanden, der alle Objekte enthalt, auf die das Pradikat zutrifft.

t12,

2.2.20 Abstrakte Datentypen

Ein abstrakter Datentyp definiert sich iiber eine Menge von Konstruktoren und
Selektoren. Die Elemente abstrakter Datentypen heiflen Terme. Ein einfacher
abstrakter Datentyp sind die natiirlichen Zahlen:

abstype Nat = Null | Succ(Pred: Nat)

overloaded func ’>’(x:Nat, y:Nat) =
if x is Null and y is Null then false
| x is Null and y is Succ then false
| x is Succ and y is Null then false
| x is Succ and y is Succ then Pred(x)>Pred(y)
endif

overloaded func ’+’(x:Nat, y:Nat) =
if x is Null then y
else Pred(x)+Succ(y)
endif

Die Datentyp-Definition im Beispiel fithrt zwei Konstruktoren ein; einer davon
ist nullstellig (ein ‘unechter’ Konstrutor), einer einstellig. Zu jedem n-stelligen
‘echten’ Konstruktor gibt es n Selektor-Funktionen, die implizit (durch die An-
gabe der Argumentnamen) mitdefiniert werden. Die Typisierung der Argumente
ist optional. Die primitive is-Funktion stellt fest, ob ein Objekt von einem gege-
benen Konstruktor erzeugt worden ist. Die Definition eines Typen Foo erzeugt
zugleich ein Pradikat des Namens isFoo.

Datentypen kénnen auch parametrisiert werden; es entstehen dann Typkon-
struktoren:

12Eine Implementation darf jedoch Beschrinkungen aussprechen, d.h. es kann syntaktisch
und semantisch korrekt geformte Typen geben, die in bestimmten Kontexten, speziell in Um-
wandlungen und bei der Partialisierung von Funktion, nicht als Typen ‘anerkannt’ werden.
Siehe dazu den Abschnitt 4.7.
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abstype List(a) = Leer | Cons(Head:a, Tail:List(a))

func sumlist(1l:List(Number)) =
if 1 is Leer then O
else Head(1l)+sumlist(Tail(1l))
endif

Die allgemeine Form der Typdefinition ist

typdef TypName = Konstruktor;
| :

| Konstruktor,

Ein Konstruktor ist entweder eine Konstante oder eine n-stelliges Gebilde der
Form

KonstruktorName(SelektorName, , ..., SelektorName, )

,wobei die Selektoren beliebig getypt werden kénnen.
Konstruktoren sind Typen nicht eindeutig zugeordnet. Unter den Deklara-
tionen

abstype farbel = rot | gruen | blau
abstype farbe2 = rot | gruen | blau | magenta | cyan | gelb

st nicht feststellbar, ob rot ein Objekt der Typen farbel oder farbe? ist.

Es sollte vermieden werden, gleich benannte Konstruktoren mit unterschied-
licher Stelligkeit zu definieren, da is nur iiber den Namen definiert ist und eine
effiziente Implementierung grofle Probleme bereiten kann. Beispiel: Unter den
(zuldssigen) Deklarationen

abstype colourl = colour(rot: Byte, gr\"un: Byte, blau: Byte)
abstype colour2 = colour(rot: Word, gr\"un: Word, blau: Word)

ist nicht feststellbar, ob colour(0,0,0) ein colourl oder ein colour?2 ist.
Das ist an sich nichts schlimmes (es ist eben beides), nur 148t sich keine op-
timale Speicherplatzanforderung bestimmen — u.U. werden 3 nutzlose Bytes
angefordert.!3

®Diese Beispiele sehen, so wie sie hier stehen, dumm aus. Man fragt sich: Wer schreibt
schon gleich benannte Konstruktoren? Als Antwort hierauf kann ich nur erwiedern, dafl dies,
gerade in groflen Programmsystemen, oft vorkommt. Meist liegt dem ein Drang zugrunde,
zu viele Namen unqualifiziert zu exportieren, so sich dafl im TLE einige hundert Namen aus
verschiedensten Modulen tummeln. Dann sind ‘name clashes’ unvermeidlich!
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2.2.21 Uberladung

Uberladung (Overloading) kann auftreten, wenn es mehrere Definitionen einer
Funktion (d.h., eines Namens) gibt. Wenn sich die Definitionsbereiche der ein-
zelnen Definitionen {iberlagern, liegt ein Fehler vor; sind sie getrennt, so werden
die Funktionen ‘vereinigt’, d.h. bei der Applikation der Funktion wird gepriift,
welche Argumenttypen vorliegen; die partikulédr passende Einzeldefinition wird
dann angewandt. Ein Beispiel:

\ so k\"onnte die Funktion ’+’ definiert sein!

overloaded '+’ = Integers("+")
overloaded ’+’ = Reals("+")
Rationals("+")

overloaded ’+’

\ oder
overloaded import ’+’,°-’,’%’ °/’ from Integers
\ oder
import overloaded ’+’, overloaded ’-’,
overloaded ’*’, overloaded ’/’ from Integers
\ oder

import overloaded AddInt as ’+’ from Integers
\ so schaut eine \'"uberladene Funktionsdefinition aus

overloaded ’#*’(a: Vector, b: Vector) = \ Vektorprodukt
if sizeOfArray(a)=sizeOfArray(b) then reduce(’+’,map(’*’,a,b))
else bottom
endif

Der overloaded-Indikator kann vor jede Form von Funktions-, Typkon-
struktor- oder Prozedur-Deklaration gestellt werden. Funktionen diirfen nur
mit Funktionen iiberladen werden, d.h. die ‘Vereinigung’ einer Prozedur mit
einer Funktion muf} als Prozedur notiert sein. Es ist nicht moglich, Exceptions
zu iiberladen (Sei iiberdecken sich stets vollstandig). Es wird nicht empfohlen,
Typen zu iiberladen.
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2.2.22 Die Suspension

Die Suspension'? ist das zentrale Konstrukt zur ProzeBbildung und Zeitspezifi-
kation. Sie hat die Form

suspend expr; until exrprs: within time; , fimes

Die Semantik der Suspension ist nicht ganz einfach. Wenn die Suspension aus-
gewertet wird, entsteht ein Prozef3; der der Auswertung von ezpr; gewidmet ist.
Der Prozefl schlift, solange die Bedingung ezprs nicht true ergibt. Der Auge-
blick, an dem expry gilt, ist der Zeitpunkt Null fiir den Zeitrahmen [time; ...
times], der ein Intervall der Lange > 0 beschreibt dieses Zeitrahmens nun wird
der schlafende Prozefl aufgeweckt und ausgewertet. Bei der Spezifikation des
Auswertungszeitpunkts von Prozessen wird von der Vorstellung des wvirtuellen
Zeitpunktes eines Prozesses ausgegangen: wahrend ein Prozefl 1duft, verdndert
sich seine Position in der Zeit nicht; nur durch Suspensions kann dies gesche-
hen. Alle T/O eines Prozesses geschieht zum selben logischen Zeitpunkt (daher
ist es meist sinnvoll, daf ein Prozefl wahrend seiner Existenz maximal eine I/O-
Operation vornimmt). Der Scheduler (also das Laufzeitsystem, dafi das Ein-
schlafern und Aufwecken von Prozessen erledigt) muf} dafiir sorgen, daf§ die rea-
len Zeitpunkte der von den Prozessen vollfithrten I/O-Operationen mit der vir-
tuellen Prozefizeit synchronisiert werden. Zuriick zur Suspension: nachdem der
Prozef} erzeugt (und schlafengelegt) worden ist, evaluiert sich das Suspension-
Konstrukt zu einem nicht n&her spezifizierten Wert (vom Typ Suspension),
den man sich grob als Mischung aus Prozef3-ID und Mailbox-Variable vorstellen
kann. Wenn spiter der Prozef3 gelaufen ist und ezpr; berechnet worden ist, dann
iiberschreibt der Ergebniswert diese Suspension. Wird vorher auf die Suspensi-
on zugegriffen, so suspendiert sich der zugreifende Prozefl selbst, bis der Wert
da ist, d.h. der Zugriff auf eine Suspension ist blockierend. Es gibt ein primiti-
ves Priadikat isSuspended, das feststellt, ob ein Wert eine Suspension, also ein
schlafender Prozef}, ist, oder nicht. Nachdem der Prozefl gelaufen ist, kann man
nicht mehr feststellen, dal der nun iiberschrieben Wert je eine Suspension war.
Einige offensichtliche Nebenbedingungen des Suspension-Konstrukts sind:

e cxprs muB ein nebeneffektfreier Ausdruck sein, der sich zu Bool evaluiert.

o exprs muf} eine Zeitangabe (Typ Time) > 0 sein. Die Umwandlung von
Number nach Time geschieht mit der Postfix-Funktion sec, die so definiert
ist, daBl 1 sec genau eine Sekunde ist. Zeit ist, fiir alle praktischen Belan-
ge, ein Fixpunkt-Datentyp, dessen Auflésung durch die System-Konstante
MinTimeDelta vorgegeben ist (sollte in der Gréfienordnung von 0.1 ms lie-

gen).

14Das Konstrukt und die Begriffsbilsdung sind neu. Der Begriff ‘Suspension’ wird manchmal
an Stelle von ‘Promise’ gesetzt. Im Unterschied zu einer Promise ist eine Suspension jedoch
nicht beliebig auswertbar, sondern von einem Zustand abhéngig (und zeitlich festlegbar).
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e exprs muf ein ‘echtes’ Intervall sein, d.h. ¢; <t; muf} gelten.

o erpry und exprs sollte zur Ubersetzungszeit berechenbar sein, damit ein
statischer Schedule angefertigt werden kann.

Niitzliche Abkiirzungen

Eine spezielle Suspension-Ausdriicke sind als “Abkiirzungen” (sprich: Makros)
definiert. Diese Makros haben den Status ‘echter’ Makro-Funktionen, es sind
keine reservierten Bezeichner!

erpr after fime = suspend expr until true within fime, fime
erpr; when expry = suspend erpr; until erprp within 0,0

After sperzifiziert ein konstante Wartezeit, d.h. eine Verschiebung des virtuel-
len Prozesses. When spezifiziert das Warten auf eine Zustandsinderung. Man
kann sagen, dal after und when die ‘synchrone’ bzw. ‘asynchrone’ Seite der
Suspension beschreiben.

erpr all duration =

let
StartTime = SystemClock()
tmp() = suspend seq expr;
tmp ()
endseq
until (SystemClock()-StartTime) mod duration = 0,
(SystemClock()-StartTime) mod duration = 0
in tmp()
endlet

A11 ist ein harmlos aussehender Operator, der recht komplex arbeitet: Vom
(virtuellen) Zeitpunkt des Aufrufs ausgehend wird alle duration Zeiteinheiten
der Ausdruck ezxpr ausgewertet. Der Ausdruck writeRegister(4,1) all 10
sec, aufgerufen um 12:34:17, bewirkt also, das um 12:34:27, 12:34:37,. .. eine 1
in das Register A geschrieben wird.

2.2.23 Die Netzbeschreibung

Ein Programm besteht aus einer Reihe von Definitionen und einer Netzbeschrei-
bung. Die Netzbeschreibung ist eine Sammlung rekursiver Definitionen, die be-
stimmt, was das Programm zur Laufzeit ‘macht’ (Die Definitionen erkliren, wie
etwas gemacht wird). Ein einfaches Beispiel ist ein Programm, das Daten aus
zwel Ports addiert. Die Synchronisation wird dabei durch die Ports vorgegeben.
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func PipeFromPort(X) =
readFromPort (X) :: delay PipeFromPort(X)

func PipeToPort(X,P) =
seq
writeToPort(X,head(P));
PipeToPort(X,tail(P))

endseq
net
InputPipeA = PipeFromPort(A)
InputPipeB = PipeFromPort(B)
in
WriteToPort(C,Map(’+~’, InputPipeA, InputPipeB)
endnet

Eine Netzbeschreibung muf} nicht unbedingt ein Datenflufinetz beschreiben — es
wird aber in den meisten Féllen so sein.

Die Datenflufinetze erméglichen es, Funktionen mit lokalem Zustand zu mo-
dellieren, indem die Zustandsvariablen als Pipes exportiert und importiert wer-
den.

2.2.24 Das Top-Level-Environment

Man kann sich vorstellen, dafi alle Definitionen auf der obersten Ebene des
Programms in groflen lokale Definition stehen, die von einer Expression gefolgt
werden, die auszuwerten der eigentliche Sinn des Programms ist. Auflerhalb die-
ser Definitionen ist nur das leere Environment, innerhalb sind alle Module und
Objekte definiert. Der Programmierer schreibt den “unteren” Teil der Definiti-
on, d.h. es sind, fiir ihn unsichtbar, schon eine Reihe Definition vorgenommen
worden. Diese Definitionen etablieren das Top-Level-Environment (TLE). Im
néchsten Abschnitt 2.3 finden sich die Namen und Beschreibungen aller im TLE
bekannten Module, Funktionen und Objekte. Es ist nicht moglich, im TLE de-
finierte Namen zu verdndern. (Funktionen kénnen allerdings durch Uberladung
erweitert werden.)
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2.3 Vorgegebene Typen und Funktionen

In diesem Abschnitt werden die vorgegebenen Typen und die auf ithnen definier-
ten primitiven Funktionen beschrieben. Um die Beschreibung zu vereinfachen,
wird vom Konzept des ‘Subtyps’ Gebrauch gemacht. Ein Subtyp erbt alle Ei-
genschaften seines Supertyps, aufler denen, die explizit gedndert sind. Einige
Primitive sind als ‘essentiell’ gekennzeichnet. Dies bedeutet, dafl jede ALDiSP—
Implementierung diese Primitive enthalten mufl. Fiir die anderen Primitiven
gilt lediglich, daf sie, wenn sie unter den hier genannten Namen implementiert
werden, auch die hier genannte Funktionalitdt aufweisen miissen.

2.3.1 Allgemeines

In ALDiSP ist jeder Typ ein Priadikat, und jedes Pradikat kann als Typ Ver-
wendung finden. (Als Pradikat verstehe man hier jede Funktion, die beliebige
Objekte auf die Menge {true, false} abbildet). Es gilt die Konvention, daf
das einem Typ Foo entsprechende Préadikat isFoo heifit. Ist Foo ein parame-
trisierter Typ wie z.B. List0f, so ist isFoo ein entsprechend parametrisiertes
Typpradikat. In diesem Fall gibt es eine zweite Konvention, die als Namen fiir
ein allgemeines Pradikat (entsprechend einer Parametrisierung mit 0bj) isAFoo
(oder isAnFoo) vorgibt. Semantisch gesehen ist ein Typ mit ‘seinem’ Typpradi-
kat identisch (d.h., ein Typ hat keine iiber das Pradikat hinausgehende Bedeu-
tung, etwa konstruktiver Art), aus Dokumentationsgriinden werden sie jedoch
getrennt. Das elementarste Typsystem, auf das sich alles zuriickfiithren 148t, ist
die Menge der Basis-Typen, verbunden mit der Méglichkeit, ein Pradikat zum
Typen zu erkldren. Syntaktisch und semantisch sind Typen normale Expressi-
ons, die jedoch weniger Bildungsmoglichkeiten haben kénnen. Es gibt Typkon-
stanten und Typkonstruktoren ("typwertige Funktionen’), in deren Definitionen
Typvariablen auftauchen.

2.3.2 Grobeinteilung der Typen: Typklassen

Vor allem aus Griinden der Ubersichtlichkeit werden die vorgegebenen Typen
in Typklassen aufgeteilt. Diese Klassen sind von keiner praktischen (semanti-
schen) Bedeutung; die Aufteilung erfolgt nicht nach eindeutig nachvollziehbaren
Kriterien.

Basistypen

Basistypen sind grundlegende Typen, die in den Sprachkonstrukten bendtigt

werden und es ermdglichen, ein vollstindiges Typsystem aufzubauen'®.

I5Natiirlich stellen die drei Konstrukte Applikation, Abstraktion und Variablen-Lookup
bereits ein dem A-Kalkiil Aquivalentes System dar — mehr braucht es nicht. ‘Aufbau eines
Typsystems’ meint daher ‘Aufbau innerhalb der Sprache’. (Im Gegensatz zum A-Kalkiil, wo
ein Interpretationsschritt notwendig ist — (Az.Ay.z ist nicht aus sich heraus “true”.))
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Es gibt eine fixe Zahl von Basistypen, die normalerweise durch ihre Namen
benannt werden.

Atomare Typen

Atomar sollen die Typen heiflen, die nicht “zerlegbar” sind. Ein Array ist of-
fensichtlich zerlegbar, ein Bit nicht. Implementierungstechnisch gesehen ist ein
atomarer Typ meist in der Wortbreite einem Maschinenregisters reprisentier-
bar!®. Alle Zahlen (die eine komplexe Typhierarchie bilden) gehéren in diese
Klasse.

Die Menge der atomaren Typen ist offen; dies vor allem, weil gerade von den
Zahlen eine uniiberschaubare Menge moglicher Subtypen (Teilmengen) bestehen
(natiirlich ist jeder Subtyp eines atomaren Typs wieder ein atomarer Typ).
Atomare Typen werden entweder iiber ihre Namen oder iiber durch Préadikate
hergestellte Verbindungen zwischen anderen atomaren Typen definiert.

Arrays

Die wichtigste Klasse nicht-atomarer Typen ist die der Arrays. Ein Array ist
eine n-dimensional geordnete Sammlung von Objekten des gleichen Typs. Arrays
konnen in ihrer Grofle fixiert sein oder sich dynamisch der Benutzung anpassen.
Es gibt unzéhlige Spezialfille von Arrays (Bit-Arrays, Diinne Arrays, Dreicks-
Matrizen, ...), die auch nicht annihernd vollstdndig aufgezihlt werden koénnen.
Array-Typen kommen vorgefertigt daher; nur wenige Paramter (meist Basis-Typ
und Ausmafle) miissen instanziiert werden.

Produkttypen
Produkktypen erméglichen die Bildung von n-Tupeln. Ein n-Tupel 148t sich als
eindimensionales Array der festen Lange n interpretieren.

Summentypen

Ein Summentyp entspricht der Vereinigungsmenge mehrerer anderer Typen.

Funktionen

Funktionen sind Datenobjekte; daher haben sie Typen. Function ist ein Basis-
typ. Es ist 1.A. nicht moglich, festzustellen, wie der “exakte” Typ einer Funktion
aussieht (d.h., welches die Definitions- und Wertemengen sind). Es gibt aller-
dings einen speziellen Typ ’Predicate’, der die Menge der Pradikate beschreiben
soll.

18 Natiirlich ist diese Unterscheidung im Einzelfall nicht gerechtfertigt: ein 4x4-ArrayOf(Bit)
ist sicherlich maschinennéher als eine 80-Bit LongReal.
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Maschinentypen

Maschinentypen erlauben den direkten Zugriff auf Gegebenheiten der konkre-
ten Hardware, auf der ein Programm lauft. Der Abstraktionsgrad dieser Typen
ist niedrig; auch lassen sie sich nicht vollstdndig funktional beschreiben (Dies
erfordert lokale Zusténde, also Zuweisungen).

2.3.3 Basistypen

Bottom — Type Fehlertyp
bottom — Bottom Fehlerkonstante

Das ausgezeichnete Element bottomist der einzige Wert des Pseudo-Typs Bottom.
bottom reprisentiert eine Berechnung, deren Wert (in der Terminologie der de-
notationellen Semantik) L ist. Insbesondere ist bottom das Ergebnis von Funk-
tionsaufrufen mit Argumenten, die nicht in der Definitonsmenge sind. bottom
steht nicht fiir der Wert einer nichtterminierden Berechnung. bottom ist kein
echtes Objekt; es ist vielmehr der ‘am schwichsten definierte Wert’, der durch
jeden stirker definierten Wert (jedes echte Objekt) ersetzt werden kann.

0bj — Type Basistyp

Der Typ 0bj beschreibt die Menge aller Objekte, d.h. die Vereinigungsmenge
aller Typen. Jede aktive oder passive Entitat (bis auf bottom), die im Rahmen
eines Programmlaufs auftreten kann, ist ein 0bj.

Type — type Basistyp
Der Typ Type beschreibt die Menge aller Typen.

(Typer ... Typen —> Typeny1 ... Typem) — Type ess. Typkonstruktor

Der geklammerte Pfeil-Operator definiert einen Funktionstypen mit n Ar-
gumenttypen und m — n Resultattypen. Die Klammern sind nicht optional.
Funktionen kénnen keine Argumente und/oder keine Resultate haben. Dieser
Konstruktor beschreibt sowohl ‘echte’ Funktionen als auch Prozeduren und Ty-
pkonstruktoren.

Function — fype Basistyp

Der Typ Function beschreibt die Menge aller Funktionen. (Dies umfaft sowohl
‘echte” Funktionen als auch Prozeduren und Typkonstruktoren.)

Bool — type Basistyp
Der Typ Bool beschreibt die Menge der Konstanten false und true.'”
Predicate — fype Basistyp

17Was Konstanten sind, kann uns hier egal sein. Es reicht, zu wissen, das man sie ausein-
anderhalten kann.



KAPITEL 2. ALDISP REPORT 45

Der Typ Predicate beschreibt die Menge aller einstelligen Pradikate, d.h. aller
Funktonen des Typs 0bj—Bool. Jedes Prédikat, das iiber 0Obj definiert ist,
benennt einen Typen.

eq (Obj, 0bj) — Bool Basisfunktion

eq ist das Préadikat, das die Identitdt von Objekten festzustellen in der Lage
ist. Es ist fiir alle Paare von Objekten'® méglich, festzustellen, ob sie identisch
sind.!?

identity (Obj) — Obj Basisfunktion

identity ist die Identitdtsfunktion, d.h. die Funktion, die jedes Objekt auf sich
selbst abbildet.

Bool and Bool — Bool Basis-Infix-Funktion

Diese Infix-Operation implementiert das logische “A”.

Bool or Bool — Bool Basis-Infix-Funktion

Diese Infix-Operation implementiert das logische “v”.

not Bool — Bool Basis-Prefix-Funktion

Diese Prefix-Operation implementiert das logische “=”.

Function; and Function, — Function Infix-Funktion
Function; or Functiony, — Function Infix-Funktion
not Function — Function Prefix-Funktion

Die logischen Funktionen sind auf die n-stelligen Préadikate erweitert.
Beispiel: Seien F und G zwei n-stellige Funktionen nach Bool. Dann ist F and
G eine n-stellige Funktion nach Bool, die dadurch definiert ist, das gilt:

F(bi, ... ,by) and F(by, ... ,by) = (F and G) (b, ... ,bn)

Die Anwendung von and, or und not auf Funktionen verschiedener Stelligkeit
und/oder Funktionen, die nicht Bool zum Ergebnis haben, resultiert in bottom
oder einer Funktion, die bottom liefert.

Es gibt einen wichtigen Spezialfall: wenn F und G Préadikate (bzw. Typen) sind,
so stellt F and G den Schnitt der durch sie spezifizierten Objektmengen dar,
F or G die Vereinigung (d.h, den Summentypen) und not F die Komplement-
menge.

18Ausgenommen bottom
19¢q ist nicht zu verwechseln mit der Gleichheitsfunktion “=", die feststellt, ob zwei nume-
rische Objekte, die durchaus verschiedenen Typs sein kénnen, die gleiche Zahl repréasentieren.
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2.3.4 Numerische Typen . .
ALDISP verfiigt iiber eine Vielzahl numerischer Typen, die unter dem Superty-

pe Number gesammelt sind. Grundlegend ist die Trennung in Ganzzahl-Typen
(Integer und alle Subtypen), Fixpunkt-Typen (die ganze Zahlen, die um einen fe-
sten Betrag skaliert sind, beschreiben) und Floating-Point-Typen. Die Floating-
Point-Typen orientieren sich am TEEE-754-Standard, der spezielle Werte fiir
400 und —oo sowie eine negative Null vorsieht. Statt einer negativ-Null gibt es
in ALDiSP drei Nullen: die echte Null, _I_%.o und %

Um zu ermitteln, von welchem Typ das Ergebnis einer Funktionsanwendung
ist, werden die folgenden Tabellen eingesetzt, die die Typisierung von Integern,
Cardinals, Integer- und Cardinal-Fixpunktzahlen zeigt. Zur Erlauterung:

e Ein Integer(n) ist ein n Bit langes Objekt, das ganze Zahlen im Intervall
—on=1 97=1 _ 1 zu reprisentieren in der Lage ist.

|_2n—1 | 2n—2 | 2n—3 | | 21 | 20 |

n

e Ein Cardinal(n) ist ein n Bit langes Objekt, das ganze Zahlen im Intervall
0...2" — 1 zu représentieren in der Lage ist.

|2n—1|2n—2|”.|21|20|

n

e Ein IntegerFixpoint(n,m) ist ein n+m Bit langes Objekt, in dem »n Bits
vor und m Bits nach dem Komma stehen. Es konnen Zahlen im Intervall

_andm—1 ndm—1_ . K
: 2,3 L représentiert werden.

AR il il YD A0 il PN Pl

n m
e Ein CardardinalFixpoint(n,m) ist ein n+m Bit langes Objekt, in dem

n Bits vor ung m Bits nach dem Komma stehen. Es kénnen Zahlen 1m
Intervall L2 "= reprisentiert werden.

2m
([ [ [ 2 [ [ 27 ]
In den folgenden Tabellen gilt: n” = max(n,n’), m” = max(m,m’). Der

Tabelleneintrag in der Zeile X und der Spalte Y definiert den Typen von
X ®Y, wobei ® die zu spezifizierende Funktion ist. m ist der maximale Wert
fir m, der im Kontext, in dem m steht, moglich ist. I steht fiir Integer und
IntegerFixpoint, C steht fiir Cardinal und CardinalFixpoint.
Fir die Addition gilt:
I(n') C(n') I(n',m’) C(n',m’)
I(n”4+1) | I(n" +1) I(n"” 4+ 1,m’) I(n"” 4+ 1,m’)
- C(n"” +1) I(n"” +1,m’) C(n"” 4+ 1,m’)
_ _ I(,n// _I_ 17m//) I(,n// _I_ 17m//)
- - - C(n” ¥ Lm//)
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Fiir die Subtraktion gilt:

I(n') C(n') I(n',m") C(n',m")
IRy [ I(n"+1) | I(n" +1) | I(n” +1,m)) I(n"” +1,m")
C(n') - I(n"+1) | I(n" 4+ 1,m’) I(n"” 4+ 1,m")
I(n',m") - - IR+ 1,m") | I(n"" + 1,m")
C(n/,m/) B _ R I(n” + l,m”)
Fir die Multiplikation gilt:
I(n') C(n') I(n',m’) C(n',m")
I(n") | n+n'—1) I(n+n') Iln+n —1,m') Iln+n" +1,m")
C(n') - C(n+n') I(n+n',m’) C(n +n',m’)
I(n',m’) - - I(n+n" —1,m+m) I(n+n',m+m’)
C(n',m") - - - Cln+n' +1,m+m')
Fir die Division gilt:
I(n') C(n') I(n',m’) C(n',m’)
I(n) | I(n,m) | I(n,m) | Iln+m’,m) | I(n+m' +1,m)
C(n') - C(n,m) | I(n+m',m) I(n+ m’',m)
I(n',m’) - - I(n +m’,m) I(n+ m’',m)
C(n',m") - - - Cln+m’+1,m)

Die Division stellt ein Problem dar, weil méglichst viele Nachkommastellen
zur Verfiigung gestellt werden sollten. Bei einer begrenzten Anzahl méglicher
Typen (z.B. alles, was in 32 Bit unterzubringen ist) ist dies aber abhingig von
der Anzahl der Vorkommastellen.

Dasich alle mathematischen Funktionen auf die vier Grundrechenarten zuriickfiithren
lassen, werden nur fiir diese explizite Ergebnistyptabellen angegeben. Ist eine
Typisierung nicht durchfiihrbar, weil ein entsprechend breiter Typ fiir das Er-
gebnis nicht zur Verfiigung steht, geschieht das folgende:

Die Berechnung wird ausgefiihrt. Tritt ein Uberlauf (oder Unterlauf) auf,
wird eine entsprechende Exception aufgerufen, die ein Ergebnis erzeugt und u.U.
eine Fehlermeldung absetzt. Ansonsten wird das Ergebnis im grofiten verfiigba-
ren Typen dargestellt und zuriickgegeben.

Fir die Rundung gilt folgendes: Tritt eine Rundung auf (weil nicht genug
Nachkommastellen zur Verfiigung stehen oder weil eine Division ausgefiihrt wur-
de), wird eine Rundungs-Exception mit den Argumenten, dem ungerundeten
(d.h, einfach abgeschnittenen) Ergebnis und dem ersten abgeschnittenen Bit
aufgerufen; diese Exception gibt das gerundete Ergebnis zuriick.

Fiir FlieBkomma-Typen gilt eine einzige Regel: ist mindestens ein Argument
einer primitiven Funktion eine FlieBkommazahl, so ist das Ergebnis vom brei-
testen FlieBkommatyp, der unter den Argumenten auftritt. Beispiele:

[ShortFloat]1+[Integer]1 — [ShortFloat]2
[ShortFloat]1+[LongFloat]1 — [LongFloat]2

Number )
Number — Type numerischer Typ
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Number ist der allgemeinste numerische Typ. Alle anderen als ‘numerisch’ ge-
kennzeichnete Typen sind Subtypen von Number. Die allgemeinen numerischen
Funktionen werden daher hier aufgefiihrt.

Number; = Numbers — Bool essentielle Infix-Funktion
Number; <> Numbers — Bool essentielle Infix-Funktion
Number; > Numbers — Bool essentielle Infix-Funktion
Number; >= Numbers — Bool essentielle Infix-Funktion
Number; < Numbers — Bool essentielle Infix-Funktion
Number; =< Numbers — Bool essentielle Infix-Funktion

Dies sind die elementaren Vergleichsoperationen. Wenn der Zeichensatz ent-
sprechendes enthélt, sollte “#£” statt “<>” | “>” statt “>=" und “<” statt “=<”
geschrieben werden.

Bei komplexen Zahlen bestimmt der Vergleich der Realteile das Ergebnis;
sind diese gleich, so werden die Imaginé&rteile verglichen.

Number; + Numberys — Number essentielle Infix-Funktion
Number; = Numberys — Number essentielle Infix-Funktion
Number; * Numbers — Number essentielle Infix-Funktion
Number; / Numberys — Number essentielle Infix-Funktion

Dies sind die elementaren arithmetischen Funktionen. Die Typisierung des
Ergebnisses ist nicht statisch festgelegt. Das Ergebnis wird von dem Typen sein,
der das numerische Resultat am besten reprasentieren kann (und implementiert
ist!).

sqrt Number — Number
sin Number — Number
cos Number — Number
tan Number — Number
asin Number — Number
acos Number — Number
atan Number — Number

atan (Number, Number) — Number

1n Number — Number
1d Number — Number
exp Number —» Number

Prafix-Funktion
Prafix-Funktion
Prafix-Funktion
Prafix-Funktion
Prafix-Funktion
Prafix-Funktion
Prafix-Funktion

Funktion
Prafix-Funktion
Prafix-Funktion
Prafix-Funktion

Number, ** Numbers — Number Infix-Funktion
abs (Number) — Number essentlelle Funktion

Diese Funktionen sind definiert durch:
sqrt n = /n

Der Definitionsbereich von Sqrt hat eine Besonderheit: sqrt(-1) wertet sich zu
einem Fehler aus; sqrt (makeComplex(-1,0)) wertet sich zur komplexen Zahl ¢
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aus.
sinn = sinn

Die trigonometrischen Funktionen sind im Bogenmaf skaliert. Sie sind nur iiber
Fixpunkt- und Real-Typen definiert, nicht aber {iber Ganzzahltypen. Die Er-
gebnisse sind als Fixpunkt- oder Real-Zahlen getypt; die Implementierung ist
darin frei. Es sollte sich aber um die prazisestmogliche Darstellung handeln; im
Normalfall diirften dies Fixpunktzahlen sein.

CoS N= cosn
tan n = tann

Das Overflowverhalten der Tangensfunktion ist nicht explizit spezifizierbar. Da
sich tanx = S22 definieren 1afit und Sinus und Cosinus kein Overflow-Verhalten
zeigen konnen, reicht es aus, das Overflowverhalten der Division zu spezifizieren.

asin n = arcsinn

Die inversen trigonometrischen Funktionen geben Ergebnisse im halboffenen
Intervall [0...27[ zuriick.

acos n = arccosn

atan n = arctan n atan(n,m) = arctan n/m

Der Arcus Tangens liefert Ergebnisse im Intervall [—27...27].
In n= logen

ld n

logan
expn= e"

n*x m= n"
abs(m) = |n|

Der Absolutwert einer komplexen Zahl ist ihr Betrag.

max (Number;, Numbers) — Number essentielle Funktion
min (Number;, Numbers) — Number essentielle Funktion
max (Numbery, ..., Numbery, ) — Number Funktion
min (Numbery, ..., Numbery, ) — Number Funktion

Diese Funktionen bestimmen das Maximum bzw. Minimum ihrer Argumen-
te.

signum Number — Number Prafix-Funktion

Die Signum-Funktion bestimmt bei Skalaren das ‘Vorzeichen’, bei komplexen
Zahlen die ‘Richtung’.
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) [ a  fallsjz[=0

signum(r) = & fallsje] # 0
Number, +" Numbery, — Number Infix-Funktion
Number, =" Numbery, — Number Infix-Funktion

Dies sind ‘saturierte’ Funktionen. Sie sind iiber allen Zahlentypen aufler den
Reals definiert. Fiir letztere gibt es spezielle ‘Unendlichkeitswerte’. Die satu-
rierten Funktionen sind nur iiber Zahlen gleichen Typs definiert. Das Ergebnis
dieser saturierten Funktionen hat den gleichen Typ wie die Argumente. Im Fall
eines Uber— oder Unterlaufs wird der maximale bzw. minimale Wert zuriickge-
geben. Bei der saturierten Division ist der Divident saturiert; Beispiele:

[Integer16]20000 +" [Integer16]130000 — 32767
[Cardinal16]20000 -"[Cardinall6]30000 — 0

Es gibt keine saturierte Multiplikation oder Division; stattdessen muf eine sa-
turierte Typwandlung vorgenommen werden. Wenn der Zeichensatz dies zulafit,
sollten die saturierten Funktionen mit + und — oder & bzw = denotiert werden.

WrapAround (expr) — expr Makro
Saturated (expr) — expr Makro
Ignore (expr) — expr Makro

Diese Makros sorgen dafiir, das eine Expression unter einem bestimmten
Overflow-Verhalten ausgewertet wird. Sie kénnten so definiert sein:

macro WrapAround(expr) =
guard expr
on AddOverflow = WrapAroundAddOverflow
on SubOverflow = WrapAroundSubOverflow
on MultOverflow= WrapAroundMultOverflow
on DivOverflow = WrapAroundDivOverflow
endguard

Integer und seine Subtypen

Integer — Type essentieller numerischer Typ
MinInt — Integer essentielle numerische Konstante
MaxInt — Integer essentielle numerische Konstante

Integerist der ‘Standard-Integer’. Die minimalen und maximalen Werte, die ein
Integer-Objekt annehmen kann, sind iiber den Konstanten MinInt und MaxInt
abrufbar. Typische Werte hierfiir sind MinInt= -8388608, MaxInt= 8388607
(dies entspricht 24 Bit, Zweierkomplement). Integer muf) ‘geniigend grof}’ sein.

Was das heifit, bleibt undefiniert.
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nBitInteger (Cardinal) — Type numerischer Typkonstruktor
IntegerN — Type Namenskonvention numerischer Typen

Integer N (das Ergebnis von nBitIntegerN) ist (per Namenskonvention) der
Integer-Subset, der bei Zweierkomplementrepriasentation in N Bits unterzubrin-
gen ist. Es gibt normalerweise eine ganze Anzahl von Integer N-Typen (auf
einem 68000-basierten System wahrscheinlich alles; was kleiner als Integer32
ist).

round (Number) — Integer essentielle numerische Funktion

truncate (Number) — Integer essentielle numerische Funktion

round wandelt eine Zahl beliebigen Typs in den ‘n&dchsten’ entsprechenden
Integer. Liegt die Zahl exakt zwischen zwei Integern, wird zum geraden Integer
gerundet. truncate schneidet alles hinter dem Komma ab. Beispiele:

round(3.4) = 3
round(3.5) = 4
round(4.5) = 4
truncate(4.99) = 4
truncate(-4.99) = -4

Integer; mod Integers — Integer essentielle Funktion
mod ist die Modulo-Funktion.

isEven (Integer) — Bool essentielle Funktion
is0dd (Integer) — Bool essentielle Funktion

Diese Pridikate stellen fest, ob eine (ganze) Zahl gerade oder ungerade ist.

Cardinal — Type essentieller numerischer Typ
MaxCard — Cardinal essentielle numerische Konstante

Cardinal ist der ‘Standard-Cardinal’ in der gleichen Weise, wie Integer der
‘Standard-Integer’ ist. Ein typischer Wert fiir MaxCard ist 16777215 (24 Bit).

nBitCardinal (Cardinal) — Type numerischer Typkonstruktor

Cardinal Nist (per Namenskonvention) der Cardinal-Subset, der in N Bits un-
terzubringen ist.

Reeclle Zahlen

Real — Type essentieller numerischer Typ
ShortReal — Type numerischer Typ
LongReal — Type numerischer Typ
SmallestReal — Real numerische Konstante
LargestReal — Real numerische Konstante

SmallestShortReal —— ShortReal numerische Konstante
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LargestShortReal — ShortReal numerische Konstante
SmallestLongReal — LongReal numerische Konstante
LargestLongReal — LongReal numerische Konstante

Reals sind Fliefkomma-Zahlen nach IEEE 754. Es gibt drei Real-Varianten
unterschiedlicher Genauigkeit. Der “Standard”-Real kann mit dem ShortReal
oder dem LongReal identisch sein. Die Konstant SmallestReal beschreibt den
kleinsten Real > 0, LargestReal den gréfiten darstellbaren Real < +oo.

Typische Langen fiir die drei Real-Typen sind 32 Bit (2448), 64 Bit (48+16)
und 80 Bit (64 4 16).

Uneigentliche Zahlen

plusInfinity — Real numerische Konstante
minusInfinity — Real numerische Konstante
pointInfinity — Real numerische Konstante
plusInfiniteSmall — Real numerische Konstante
minusInfiniteSmall — Real numerische Konstante

Es gibt finf ‘uneigentliche’ Zahlenkonstanten (Exceptional Numbers), die, re-
spektive, fiir ‘400’, ‘—00’, den ‘Punkt Unendlich’ der komplexen Zahlen, den
‘unendlich kleinen positiven Wert’ und den ‘unendlich kleinen negativen Wert’
(_I_%.o und _I_%.o) steht. Die uneigentlichen Zahlen sind Real-Konstanten, die als
Ergebnis von Overflow und Underflow auftreten kénnen, nie aber als Ergebnis

saturierter Funktionen.

Fixpunktzahlen

ScaledFixpoint (Type, Cardinaly) — Type numerischer Typ
Eine Fixpunktzahl ist ein skalierter Integer, d.h. ein Element der Menge {n -
k,n € Integer}. k ist dabei typischerweise ein ziemlich kleiner Wert, z.b. 0.01
(wenn man mit DN-Betrdge reprasentieren will), 0.0005 (wenn eine 5ms-Clock
die Zeit schligt) oder 0.000000125 (8 Mhz).

ScaledFixpoint (A,B) definiert den Fixpunkttypen, der dadurch definiert
wird, daf der Integer-Typ A als Vielfaches der (wahrscheinlich reellen) Zahle
B interpretiert wird. So beschreibt ScaledFixpoint(Cardinali6,0.01) den
Zahlenbereich zwischen 0 und 655.35, in Schritten zu 0.01 aufgeteilt.

FixInt (Cardinal, Cardinal) — Type numerischer Typ
FixCard (Cardinal, Cardinal) — Type numerischer Typ
FixInt NM — Type Typ-Namenskonvention
FixCard NM — Type Typ-Namenskonvention

Die am héufigsten auftretenden Fixpunkttypen haben die Form {3%,a € 0..24+t8_
1}. Genau diesen Typen definiert FixCard(A, B). Ein typisches Beispiel ist
FixCard(0,16). Dieser Typ beschreibt die Zahlen zwischen 0 und 0.999984741,
in Schritten von 1.52 %« 1075, Man kann sich vorstellen, dal FixCard(A,B)
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eine Bindrzahl mit A Stellen vor und B Stellen nach dem Komma ist. Eine
ebenfalls hdufige Variante ist der Typ FixInt(A, B), der die durch {5%,a €
—24-1.24=1 1 >} beschriebenen Objekte enthélt. FixInt(1,15) beschreibt
die Zahlen zwischen -1 und 0.999969482, in Schritten von 3.05%107°. FixInt (0, 16)
beschreibt die Zahlen im Bereich [—0.5...0.499984741], in Schritten von 2716 al-
80 0.000015259. Kleinere Intervalle (etwas Integer(-2,18)) sind, obwohl denk-
bar, nicht erlaubt.

Als Namenskonvention gilt, da} ein Typ FixCardNM fiir FixCard(N,M)
steht. Beispiele:

FixCard0016= FixCard(0,16)
FixInt0115 = FixInt(1,16)
FixCard44 = FixCard(4,4)
FixInt48 = FixInt(4,8)

Von besonderem Interesse sind die Fixpunktzahlen mit Betriagen < 1, da
dies die Standard-Ergebnistypen der trigonometrischen Funktionen sind. Wenn
eine Implementierung Fixpunktzahlen von maximal 16 Bit implementiert, so
wird z.B. sin Ergebnisse vom Typ FixInt0116 liefern, d.h. Zahlen im Intervall
[—1...1—271%].29 Gleichermaflen wiirde die atan-Funktion (die als Wertebereich
—m/2...m/2 hat) auf FixInt0216 abbilden.

Komplexe Zahlen

Complex (Type) — Type numerischer Typ
makeComplex (Number;, Numbers) — Complex numerische Funktion
realPart (Compler) — Number numerische Funktion
imagPart (Complex) — Number numerische Funktion
phase (Compler) — Number numerische Funktion

Eine komplexe Zahl wird als Tupel zweier nicht-komplexer Zahlen gleichen Typs
implementiert. makeComplex (a,b) bildet die komplexe Zahl a + ¢b. (Man kénn-
te auch a+sqrt(-1)*b schreiben). realPart ermittelt den reellen Anteil einer
komplexen Zahl, imagPart den imaginiren Anteil. phase bestimmt den Win-
kel der Polarreprésentation einer komplexen Zahl. (Der Betrag kann durch abs
festgestellt werden.)

Zeit )

Duration — Type essentieller Typ
n sec — Duration essentieller Typ
MinDuration — Number essentielle Konstante

Duration ist der Typ, der als Zeit-Argument fiir Suspensions ben&tigt wird. sec
wandelt numerische Argumente in Duration—Gréflen um (1 sec= eine Sekun-
de). MinDuration ist die kleinste sinnvolle Zeiteinheit (fiir Suspensions).

20Daf die ‘1’ in diesem Intervall nicht darstellbar ist, sollte nicht von Belang sein. Imple-
mentierer, die sich daran stéren, konnen natiirlich auch FixInt0216 benutzen.
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Time — Type Typ
SystemClock () — Time Prozedur
Year (Time) — Cardinal Funktion
Month (Time) — Cardinal Funktion
Day (Time) — Cardinal Funktion
Hour (Time) — Cardinal Funktion
Minute (Time) — Cardinal Funktion
Second (Time) — Cardinal Funktion
makeTime (Cardinalyeyy ... Cardinalgecond) —> Time Funktion
addTime (Time, Duration) — Time Funktion
Time; = Timey — Duration Funktion

Der Funktionsaufruf SystemClock() liefert einen Wert vom Typ Time. Die
sechs Selektor-Funktionen zerlegen ein Objekt dieses Typs in seine Bestandteile.
Fiir die einzelnen Werte gelten folgende Wertebereiche:

Year(Time) > 1990

1 > Month(Time) > 12
1 > Day(Time) > 31

1 > Hour(Time) > 24

1 > Minute(Time) > 60
1 > Second(Time) > 60

Ein Time—-Objekt kann durchaus mehr représentieren (z.B. die aktuelle Zeit-
zone oder Zeitwerte bis in den Nanosekundenbereich)!
makeTime ist eine sechsstellige Funktion, die ein Objekt vom Typ Time er-

zeugt.
addTime addiert eine Zeitdauer zu einer Zeit;
Der “~”-Operator bestimmt die Lange eines durch zwei Zeitpunkte vorgege-

benen Zeitraums. Es handelt sich hierbei um denselben (iiberladenen) Operator,
der auch fiir normale Zahlen benutzt wird; nur sind Argumente und Resultat
keine Zahlen (auch wenn sie so interpretiert werden kénnen).

Strings

String — Type Typ
Strings sind Sequenzen von Zeichen (was ein Zeichen ist, wird nicht erklart). Es
steht einer Implementierung frei, Strings als Vektoren, Listen oder wie auch
immer zu implementieren. String-Konstanten sind in Anfiihrungszeichen (")
geschlossen.

AsciiToString (Cardinal) — String Funktion

AsciiToString(n) erstellt einen String, der dquivalent zum ASCII-Zeichen n
ist. Dies gilt auch fiir die Kontrollzeichen BS, CR, LF, FF und DEL.
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String, ++ String; — String Funktion

‘++7 verkettet zwei Strings.

length (String) — Cardinal Typ

length bestimmt die Linge eines Strings.

ldrop (Cardinal, String) — String Typ
rdrop (Cardinal, String) — String Typ

ldrop(n,s) entfernt n Zeichen von links aus dem String s (rdrop analog von
rechts). Ist n>length(s), so ist der leere String das Ergebnis. Beispiele:

NumberToString (Number) — String Typ

Diese Funktion erstellt die textuelle Repriasentation einer Zahl.

2.3.5 Arrays .
Array — Type essentieller Typ

Array ist die Obermenge aller Array-Typen egal welcher Dimension. Arrays
sind Sammlungen von Objekten (meist gleichen Typs), die tiber Index-Tupel
ausgewidhlt werden konnen. Als Indizes dienen Kardinal-Zahlen. Arrays sind
(wie Listen) privil gierte Typen: wenn eine Funktion F auf ein Array ange-
wandt wird, und F ist nicht iiber den entsprechenden Array-Typ definiert, so
wird ein automatisches Mapping vorgenommen, d.h. F wird (in unspezifizierter
Reihenfolge) auf alle Elemente des Arrays angewandt; die Ergebnisse werden in
einem gleichgeformten Array gesammelt. Dies funktioniert fiir alle Funktionen
(nicht nur primitive), egal welcher Stelligkeit. Beispiel:

[3,4,5]+[10,20,30] — [13,24,35]
Die Arrays miissen gleich grof3 sein:
[1,2,3]1*[3,4]) = Fehlermeldung

Wenn nur einige Argumente Arrays sind, werden die anderen automatisch zu
entsprechenden Arrays gewandelt:

[3,4,5]+10 — [13,14,15]

1 1 1 1
MatrixLiteral([1,1,1,1]1,2,3,4) — 22202
3 3 3 3
4 4 4 4

Wenn einige Funktionsargumente Arrays sind, andere Listen, so miissen die
Listen Listen von Arrays sein. (Sind sie es nicht, versagt das Auto-Mapping).
Das Mapping erfolgt voll rekursiv:

[[1,2],3,4]1+[[10,20],0,30] — [[11,22],3,34]
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Zur Notation der Beispiele: Vektoren werden durch Aufzdhlung ihrer Elemente,
geklammert in [ und ], représentiert. Dies entspricht der Notation von Vektor-
Literalen. Es gibt keine derartige Notation fiir Matrizen, deswegen wird eine
Matrix direkt als Matrix dargestellt. Zur Klarheit wird sie in einem
gesetzt.

sizeOf (Array) — Cardinal essentielle Funktion

size0f (A) stellt fest, wieviele Elemente A hat. Eine Matrix der Grofie 4*5 hat
20 Elemente. Ein Vektor, der 4 Vektoren der Grofie 5 enthiilt, hat 4 Elemente!

Map (Function, Array) — Array essentielle Funktion
DestructiveMap (Function, Array) — Array Funktion
Die Funktion (die vom Typ (0bj -> 0bj) sein muf}) wird auf jedes Element des
Arrays angewandt. (Die Reihenfolge ist nicht definiert.) Die Resultate werden
in einem gleichgeformten neuen Array gesammelt.

DestructiveMap ist die destruktive Version von Map: das Argument-Array
wird {iberschrieben.

Vektoren

Vector — Type essentieller Typ

Vektoren sind eindimensionale Arrays. Die Elemente eines Vektors der Grofie n
sind von 0...n — 1 durchnumeriert.

CreateVector (Cardinal, Function) — Vector essentielle Funktion

CreateVector(n,f) konstruiert einen Vektor der Lange n, der an der Stelle
i durch f(i} definiert (initialisiert) ist. f mufl daher eine Funktion des Typs
Cardinal -> Obj sein.

LOby, ..., Obj,] — Vector essentielle Notation

Die eckigen Klammern sind keine ‘Funktion’, sondern eine Schreibhilfe zur Nota-
tion von Vektoren. Die Klammern kénnen beliebig viele Argumente haben (u.U.
durch eine Implementierungsschranke auf z.B. 255 beschrankt) und konstruieren
aus 1hnen einen Vektor.

Vector (n) — Object essentielle Funktion

Vektoren sind ihre eigene Selektionsfunktion: ein Vektor ist, funktional gesehen,
eine Funktion, die Indizes auf Werte abbildet. Also wird dies auch so geschrieben.

ChangeVector (Vector, Cardinal, Object) — Vector essentielle Funktion
DChangeVector (Vector, Cardinal, Object) — Vector Funktion

ChangeVector(V,i,0) liefert einen neuen Vektor, der mit V an allen Stellen
aufler ¢ identisch ist; dort ist der Wert o. DChangeVector iiberschreibt V an der

Imperativ!

Imperativ!
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Stelle ¢ mit 0. Das “D” steht fiir “destructive”.

Reduce (Function, Vector) — Obj essentielle Funktion
RReduce (Function, Vector) — Objy essentielle Funktion

Reduce(f, V) wendet die zweistellige Funktion f von links nach rechts auf den
Vektor V an. Beispiel:

Reduce(", [1,2,3,4]) = ((1-2)-3)-4

RReduce arbeitet wie Reduce, aber von rechts nach links. Die Vektoren miissen
die Mindestgrofie 2 haben.

rev (Vector) — Vector Funktion
rev dreht einen Vektor um, d.h.

rev([1,2,3]) — [3,2,1]

evens (Vector) — Vector Funktion
odds (Vector) — Vector Funktion
merge (Vectory, Vectory) — Vector Funktion

evens (V) liefert den Vektor A/, der nur aus den Elementen aus A besteht, die
an ‘geradzahligen’ Positionen stehen. odds liefert entsprechend den ‘ungeraden’
Teilvektor. merge vermischt die beiden Vektoren zu ithrem Ausgangsvektor.

evens([10,20,30,40]) — [20,40]
0dds([10,20,30,40]) —> [10,30]
merge([1,2,3:|,[4,5,6]) — [1’4’2’5’3’6]

evens([10]) — (]
odds ([]) = (]

subVector (Vector, Cardinaly, Cardinaly ) — Vector Funktion
compose (Vectory, Vectory) — Vector Funktion

subVector (A4,4,j) bildet den Vektor, der aus den Elementen A[i]...A[j — 1]
besteht.

compose (A, B) bildet den Vektor, der aus der Aneinanderreithung der Vektoren
A und B besteht.

subVektor([1,2,3,4,5,6],0,3) = [1,2,3]
subVektor([1,2,3,4,5,6]1,3,4) = [4]
subVektor([1,2,3,4,5,6],3,3) — ]

subVektor([1,2,3,4,5,6],3,2) — Fehlermeldung

subVektor([1,2,3,4,5,6],-3,2) — Fehlermeldung

subVektor([1,2,3,4,5,6],3,20) — Fehlermeldung
compose([1,2,3],[4,5,8]) — [1,2,3,4,5,6]
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Matrizen

Matrix — Type essentieller Typ

Matrizen sind zweidimensionale Arrays. Die Elemente einer Matrix der Grofle
m*n sind von 0,0...m — 1,n — 1 durchnumeriert. Die Reihenfolge ist

A= 1
Alm,1] -+ Alm,n]
CreateMatrix (Card, Cardy, Function) — Matrix essentielle Funktion

CreateMatrix(m,n,f) konstruiert eine Matrix der grofie m*n, die an der Stelle
i,j durch f(i,j) definiert (initialisiert) ist. f mufl daher eine Funktion des Typs
Cardinal, Cardinal —> Obj sein.

MatrixLiteral (Vector, ..., Vector, ) — Matriz essentielle Funktion

Dies ist das genaue Gegenstiick zum den eckigen Klammern, nur etwas unbehol-
fener geschrieben (Matrizen miissen seltener notiert werden, und es gibt kaum
weitere Klammern). Die Matrix

9 10 11 12

wird durch die Expression

MatrixLiteral([1,2,3,4],
[5’6’7’8] B
[9,10,11,121)

gebildet. Die Vektoren miissen gleich grof} sein.

hSize (Matriz) — Number Funktion
vSize (Matrizr) — Number Funktion

hSize(A) liefert die ‘Breite’ von A, vSize(A) die ‘Hohe’.
hSize(CreateMatrix(m,n, f)) — n
vSize(CreateMatrix(m,n, f)) — m

Matriz (Card, Card) — Object essentielle Funktion

A(n,m) Selektiert das Element in der n-ten Zeile und der m-ten Spalte aus
der Matrix A. Genauso wie Vektoren einstellige Funktionen sind, sind Matrizen
zweistellige Funktionen.

ChangeMatrix (Matriz, Card, Card, Obj) — Matriz essentielle Funktion
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DChangeMatrix (Matriz, Card, Card, Obj) — Matriz Funktion

ChangeMatrix(M,1,7,0) liefert eine neue Matrix, die mit M an allen Stellen aufler
7,71dentisch ist; dort ist der Wert o. DChangeMatrix liberschreibt A an der Stelle
1, mit o. Das “D” steht fiir “destructive”.

UnitMatrix (Cardinal) — Matriz Funktion
UnitMatrix (V) liefert eine Einheitsmatrix der Grofie N.
1 0 O
UnitMatrix(3) E 0 1 0
0 0 1
hrev (Matriz) — Matrix Funktion
vrev (Matriz) — Matrix Funktion

hrev spiegelt einen Array an der horizontalen Mittelachse, vrev an der vertika-
len.

1 2 3 4 9 10 11 12
hrev(| 5 6 7 & |) — 5 6 7 8
9 10 11 12 1 2 3
1 2 3 4 4 3 2 1
vrev(| 5 6 7 & |) — 8 7 6 5
9 10 11 12 12 11 10 9
drev (Matriz) — Matrix Funktion
orev (Matriz) — Matriz Funktion

drev((Q) spiegelt die Matrix @ an der Hauptdiagonalen. orev( Q) spiegelt die
Matrix @ an der Nebendiagonalen

1 2 3 4 ; 2 190
drev(| 5 6 7 8 ) —

9 10 11 12 3.7 1

4 8 12

1 9 3 4 12 8 4

11 7 3

orev(| 5 6 7 8 ) — 10 6 2

9 10 11 12 9 5 1
rot (Matriz) — Matriz Funktion
rot2 (Matriz) — Matrix Funktion
rot3 (Matriz) — Matrix Funktion

Die rot—Funktionen rotieren eine Matrix im Uhrzeigersinn um ihren Mittel-
punkt um, respektive, ein Vierteldrehung, eine halbe Drehung und eine Drei-

Imperativ!
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vierteldrehung.
1 2 3 4
rot(| 5 6 7 8 )
9 10 11 12
1 2 3 4
rot2(| 5 6 7 8
9 10 11 12
2 3 4
rot3( 6 7 8
10 11 12

hEvens (Matriz) — Matriz
h0dds (Matriz) — Matriz
vEvens (Matriz) — Matriz
v0dds (Matriz) — Matriz
hMerge (Matriz), Matriz, ) — Matriz
vMerge (Matriz), Matrizs ) — Matriz

hEvens(A) liefert die Matrix A/, die aus den ‘geraden Zeilen’ von A besteht.
h0dds liefert dementsprechend die ‘ungeraden Zeilen’, vEvens die ‘geraden Spal-
ten’ und v0dds die ‘ungeraden Spalten’. hMerge mischt zwei Arrays zeilenweise,
vMerge spaltenweise. Die Merge-Operationen muf) die zweite Matrix (der, der
die ‘odds’ enthilt, genauso grof} oder eine Zeile/Spalte kleiner als die erste sein.

1 2 3 4
5 6 7 8

hEvens( o 15 11 1o P
13 14 15 16
1 2 3 4
5 6 7 8

hodds(l g 5 3 12 P
13 14 15 16

1 2 3 4

5 6 7 8

vEvens( o 15 11 1o

13 14 15 16

1 2 3 4

5 6 7 8

vodds(l g 45 41 1

13 14 15 16

9 5 1

10 6 2

1 7 3

12 8 4
12 11 10 9
&8 7 6 5
4 3 2 1

4 8 12

3 7 11

2 6 10

1 5 9

60

Funktion
Funktion
Funktion
Funktion
Funktion
Funktion

5 6 7 8
13 14 15 16
1 2 3 4
9 10 11 12

2 4

6 8

10 12

14 16

1 3

5 7

9 11

13 15
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vMerge(

1 2
hMerge(| 3 4 |, 10720 ) —
30 40
5 6
1 2 3 102030):>
4 5 6 ’l 40 50 60

hSubMatrix (Matriz, Card;, Cards ) — Matriz
vSubMatrix (Matriz, Card;, Cards ) — Matriz
hCompose (Matriz, Matrizr) — Matrix
vCompose (Matriz,Matrizr) — Matrix

hSubMatrix (A, i, 5) bildet die Matrix die aus den Zeilen i . .. j—1 der Matrix

A besteht.

vSubMatrix liefert entsprechend einen Zeilenbereich.

61

1 2

10 20

3 4

30 40

5 6

10 2 20 3 30

40 5 50 6 60
Funktion
Funktion
Funktion
Funktion

hCompose (A, B) liefert die Nebeneinanderreihung der Arrays A und B. A und

B miissen die gleiche Zeilenzahl (=Hohe) haben.

vCompose (A, B) liefert die Ubereinanderreihung der Arrays A und B. A und B

miissen die gleiche Spaltenzahl (=Breite) haben.

vSubmatrix(

hCompose(

vCompose(

hSubmatrix(

hSubmatr

vSubmatrix(

Ut W
0O B

ix(

IS I U
0O N

w
o
-3
e

v =

[e2 3 )
-3
o

w =
SN )

ot W
—_
o

w =
SN )

10 20
'l 40 50

ot W

30
60

~

row (Matriz, Cardinal) — Vector

I

3 4
5 6
1 2
3 4
5 6
7 8
2
6
1 2 4
5 6 8
1 2 3 10 20
3 4 5 30 40
1 2 3
3 4 5
10 20 30
40 50 60
Funktion
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62
col (Matriz, Cardinal) — Vector Funktion
row und col selektieren einzelne Zeilen bzw. Spalten einer Matrix.

1 2 3 4
row(| 5 6 7 8 ,0) — [1,2,3,4]
9 10 11 12
1 2 3 4
c0l( 5 6 7 8 |00 = I[1,5,9]
9 10 11 12
diag (Matriz,Cardinal) — Vector Funktion
ndiag (Matriz, Cardinal) — Vector Funktion

diag(M,d) liefert eine zur Hauptdiagonalen parallele Diagonale von M als
Vektor. d bestimmt, welche Diagonale dies ist: es wird der Schnitt der Matrix
mit der Diagonalen [M(d,0),M(d+1,1),...] geliefert. Dies fiithrt dazu, das d =
0 die Hauptdiagonale, d > 0 die d-te Diagonale ‘unter’ und d < 0 die d-te
Diagonale ‘liber’ der Hauptdiagonalen liefert. ndiagl, d liefert entsprechend
zur Nebendiagonale parallele Diagonalen, die durch den Schnitt von M (M
habe die Breite b,,) mit [M(d,by,),M(d+1,b,,-1),...] definiert sind.

1 2 3 4
. 5 6 7 8
diag( 0 10 11 12 ,1) — [5,10,15]
13 14 15 16
1 2 3 4
. 5 6 7 8
diag( o 10 11 12 P 2) — [3,8]
13 14 15 16
1 2 3 4
. 5 6 7 8
ndiag( 0 10 11 12 ,1) — [8,11,14]
13 14 15 16
1 2 3 4
. 5 6 7 8
ndiag( o 10 11 12 P 2) — [2,5]

ndiag( 0 10 11 12 ,4) = Fehlermeldung
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det (Matriz) — Number Funktion
det (A) berechnet die Determinanter der quadratischen numerischen Matrix A.
hReduce (Function, Matriz) — Vector Funktion
vReduce (Function, Matriz) — Vector Funktion

hReduce(F', M) wendet die zweistellige Funktion F' auf die Zeilenvektoren von
M an; jeder Zeilenvektor wird so auf ein Element des Ergebnisvektors abgebil-
det. vReduce tut dasselbe mit den Spaltenvektoren.

1 2 3 4
5 6 7 8
I —_ —_ —_ —_
hReduce( 9 10 11 12 ) — [-8,-16,-24,-32]

13 14 15 16

1 2 3 4
5 6 7 8
1 _ - - -
vReduce( | 9 10 11 12 ) — [-26,-28,-30,-32]

13 14 15 16

2.3.6 Listen, Streams und Pipes

Die Liste ist in der Signalverarbeitung der grundlegende Typ iiberhaupt. Listen
modellieren Signale. Ein Signal ist eine geordnete Folge von Zahlenwerten, die
u.U. in Blécken (Vektoren oder Matrizen) gesammelt sind. In der DSP reprasen-
tieren diese Zahlen synchrone Abtastwerte (Samples).

Pipes und Streams sind spezielle Formen von Listen — genauer gesagt, speziell
erzeugle Listen. Ein Stream ist eine Liste, deren Auswertung durch den delay—
Operator verziigert ist. Eine Pipe ist eine Liste, deren Auswertung durch eine
Suspension verzogert ist.

Ein typisches Beispiel fiir einen Stream liefert das NOTCH-Filter-Programm:
(das Beispiel ist dem Silage Reference Manual[21], pp. 1-4, entnommen)

func NOTCH(bO,b1,b2.al,a2 :Number)(in :List)=

let
out = bO*in + s2
s2 =0 :: delay(bl*in + a2%out + s1)
sl =0 :: delay(b2#in + al*out)
in
out
endlet

Ein ‘0::delay tmp’—Ausdruck entspricht dem ‘@-Operator (‘delay’ genannt)
von Silage, d.h. dem Riickgriff auf den ‘vorigen’ Sample. Die Notwendigkeit des
delays liegt in der Rekursivitdt der Streams: der out-Stream wird als Input



KAPITEL 2. ALDISP REPORT 64

wiederverwendet. Da ALDiSP call-by-value auswertet, wiirde es hier zu einem
Problem kommen.?!

Im Gegensatz zu Streams tauchen Pipes selten explizit auf. Sie sind implizit
durch die synchronen und asynchronen Input-Objekte gegeben. Als Beispiel
soll die (primitive) Funktion PipeFromPort dienen, die so implementiert sein
konnte:

func PipeFromPort(p:InputPort) =
ReadFromPort(p) :: PipeFromPort(p)

Was in dieser Definition durch die Semantik der Ports implizit geschieht, sieht
explizit so aus:

func PipeFromPort(p:InputPort) =
suspend ReadFromPort(p) :: PipeFromPort(p)
until isPortReadable(p)
within 0,0

Suspensions ‘pflanzen sich fort’: der Zugriff auf eine Suspension suspendiert den
Zugreifer. Daher liefert eine Funktion des Typs (1ist -> list), die auf eine
Pipe zugreift, eine Pipe als Ergebnis. Dies steht im Gegensatz zu den Streams!

List (Type) — Type Typ
null — List Konstruktor
cons (Object, List) — List Konstruktor
Object :: List — Lust Konstruktor
head (List) — Object Selektor
tail (List) — List Selektor
isEmpty (List) — Bool Pradikat
select (Cardinal,List) — Object Funktion
length (List) — Cardinal Funktion
reduce (Function,List) — Object Funktional

Man kann sich Listen als den durch die folgenden Definitionen eingefiihrten
Datentyp vorstellen:

abstype list = null
| cons(head, tail: list)

r-infix ’::’
func ’::’ = cons

func isEmpty(alList: list) =

210der auch nicht: Das in-Signal wird wahrscheinlich eine Pipe sein; die impliziten Map-
pings wiirden also irgendwann durch eine Suspension aufgehalten. Es ist trotzdem gut, hier
Delays einzubauen, da man nicht im Voraus wissen kann, wie weit die out—Liste {iberhaupt
gebraucht wird.
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aList is null

func isSingleton(alist: list) =
not isEmpty(alist) and isEmpty(tail(alist))

func select(n,alist: list) =
if isEmpty(alist) then bottom
| n=0 then head(aList)
else select(n-1,tail(alist))
endif

func length(alist: list) =
if isEmpty(aList) then O
else 1+length(tail(aList))
endif

func reduce(f: Function, aList: list) =
let
r(akku, alList) =
if isSingleton(aList)
then f(akku,head(alList))
else r(f(akku,head(alList)),tail(alList))
endif
in
if length(alist)<2 then bottom
else r(head(alist),tail(alList))
endif
endlet

isEmpty testet, ob eine Liste leer ist. isSingleton testet, ob eine Liste einele-
mentig ist. select(n,l) liefert das n-te der Liste [. reduce schliefilich wendet
eine zweistellige Funktion von links nach rechts auf die Elemente einer Liste an
(die mindestens die Lange 2 haben muf). Beispiel:

reduce(’-’,cons(a,cons(b,cons(c,null)))) — (a-b)-c

Es steht jeder Implementierung frei, die elementaren Listenfunktionen so zu
definieren, wie es ihr geféllt, solange die Funktionalitdt, die durch die o.a. Defi-
nitionen vorgegeben ist, beibehalten bleibt.

Listen sind, wie Arrays, privilegierte Datenstrukturen: Wenn eine (beliebige)
Funktion auf Argumente angewandt wird, iiber die sie nicht definiert ist, und
mindestens eins der Argumente ist eine Liste, so werden aus den nicht-Listen-
Elementen Listen gebildet (d.h, aus 1 wird die unendliche lange Liste, die nur
Einsen enthilt), und die Funktion wird auf die (Tupel der) Listenelemente an-
gewandt. Die Listen diirfen endlich oder unendlich sein; die kiirzeste Input-Liste
bestimmt die Lange des Ergebnisses. Beispiel:
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1::2::3:: () + 10 — 11::12::13:: ()

ListToVector (List) — Vector Funktion
VectorToList (Vector) — List Funktion

ListToVector wandelt eine (endliche) Liste in einen Vektor um.
VectorToList tut das entgegengesetzte, wobei die enstehende Liste ‘verzogert’
sein sollte. Man kann sich die beiden Funktionen folgendermaflen definiert vor-
stellen:

func ListToVector(L:List) =

let
createVector(length(L),selectl)
where
func selectL(i) = select(i,L)
endlet

func VectorToList(V:Vector) =
let
func RestList(i) =
if i=size0f(V) then null
else V(i) :: delay RestList(i+1)
endif
in
RestList(0)
endlet

2.3.7 Maschinentypen

Im Folgenden werden Typen beschrieben, die in der I/O benutzt werden. Dies
sind keine ‘Datentypen’ im herkémmlichen Sinne, sondern Typen von ‘Interface-

Objekten’
Address — Type Typ
CardinalToAddress (Cardinal) — Address Typ

Eine Adresse ist ein maschinenspezifischer Identifikator, iber den Speicher adres-
siert wird. ALDiSP geht davon aus, das Maschinen-Objekte mit Speicherberei-
chen assoziiert werden.

Eine ALDiSP—Adresse muf3 nichts mit dem realen Adressierungsschema der
Maschine zu tun haben — es wire aber sinnvoll.

Anstelle der unhandlichen Funktion CardinalToAddress kann auch ein ein-
facher Cast [!Address] vorgenommen werden.

Register — Tlype Typ
InputRegister (Type) — Type Typ
OutputRegister (Type) — Type Typ
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DeclareInputRegister (Type, Addr) — InputRegister(Type) Prozedur
DeclareOutputRegister (Type, Addr) — OutputRegister(Type) Prozedur

Ein Register ist eine I/O-Variable, d.h. ein Input-Register ist eine Speicherstel-
le mit sich dnderndem Inhalt, ein Output-Register etwas, wo hineingeschrieben
werden kann. Register sind getypt. Typischerweise sind Register {iber Cardinal-
Ns oder Fix NM-s definiert.

writeToRegister (OutputRegister, Object) — I/O-Prozedur
readFromRegister (InputRegister) — Object I/O-Prozedur

Dies sind die Prozeduren zum Auslesen bzw. Beschreiben eines Registers. Diese
Prozeduren sind zeitsensitiv — der Prozef3, der sie aufruft, mufl einen definierten
Zeitzustand haben, um sie rufen zu kénnen. Beispiel:

proc SampleRegister(F : Duration; R: InputRegister ) =
readFromRegister(R)
suspend SampleRegister(F, R)
until true
within F,F

liefert Samples eines Registers. Ein Audio-Abtaster kénnte so aussehen:

InReg = DeclarelnputRegister(Integer16, [!Address]16#££££0020)
SampleRate = (1/44100)sec
InPipe= SampleRegister(SampleRate, InReg)

Die entsprechende Prozedur, die in regelmafiigen Abstdnden in einen Port schreibt,
ist:

proc WriteSamplesToRegister(FrameDuration : Duration;
R : Outputregister;
D : List) =
seq
suspend WriteSamplesToRegister(FrameDuration, R, tail(L))
until true
within FrameDuration,FrameDuration ;
writeToRegister(R,head(L))
endseq

Aus den Beispielen ist schnell ein lauffihiges Programm gemacht, z.B. ein ein-
facher unparametrisierter Lowpass-Filter:

func LowPass(in) =

let
out = 0 :: delay ((in+out)/2)
in
out
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endlet

net
WriteSamplesToRegister(SampleRate,
LowPass(SampleRegister(SampleRate, InReg)))

endnet

Port — Type Typ
InputPort (Type) — Type Typ
QutputPort (Type) — Type Typ
DeclareInputPort (Type, Address) — InputPort(Type) Prozedur
DeclareQutputPort (Type, Address) — OutputPort(Type) Prozedur
writeToPort (OutputPort, Object) — I/O-Prozedur
readFromPort (InputPort) — Object I/O-Prozedur
isPortReadable (InputPort) — Bool I/O-Prozedur
isPortWritable (OQutputPort) — Bool I/O-Prozedur

Ein Port ist ein ‘asynchrones Register’. Ports reprisentieren zeitlich geordnete
Sequenzen von Objekten. Input-Ports sind potentiell unendlich grofie Pufferspei-
cher. In der Deklaration, beim Lesen und Schreiben unterscheiden sich Ports in
der Benutzung nicht von Registern; jedoch kénnen Ports blockieren: Ein Lese-
zugriff auf einen Port, ‘hinter’ dem kein Objekt ‘steht’, blockiert den zugrei-
fenden ProzeB, bis ein Objekt eintrifft (wie und wann dies geschieht, kann hier
nicht erklirt werden — es ist 1/0, also zeitlich und semantisch unspezifiziert).
Gleichermaflen kann ein Schreibzugriff auf einen Port den schreibenden Prozef3
blockieren. Die Blockierung vollzieht sich iiber den Suspension-Mechanismus.
Man kann sich vorstellen, dal readFromPort und writeToPort folgendermafien
definiert sind:

proc readFromPort(P) =
suspend <nicht-blockierendes Read>(P)
until isReadable(P)
within 0,0

proc writeToPort(P) =
suspend <nicht-blockierendes Write>(P)
until isWritable(P)
within 0,0

isReadable und isWritable stellen fest, ob ein nicht-blockierendes Lesen bzw.
Schreiben moglich ist. Ein offenkundiges Problem liegt vor, wenn mehrere Pro-
zesse simultan auf einen Port zugreifen: ALDiSP kennt keine ‘critical sections’,
also ist das Ergebnis eines derartigen Zugriffs unspezifiziert — Es liegt eine Feh-
lersituation vor, wenn mehr als ein ProzeB zur selben virtuellen Zeit existieren

und I/O betreiben.
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File — Type Typ
InputFile (Type) — Type Typ
OutputFile (Type) — Type Typ
AccessFile (Type) — Type Typ
OpenlInputFile (Type, Name) — InputFile(Type) Prozedur
OpenOutputFile (Type, Name) — OQutputFile(Type) Prozedur
OpenAccessFile (Type, Name) — AccessFile(Type) Prozedur
CloseFile (File) — Prozedur
writeToFile (File, Object) — I/O-Prozedur
readFromFile (File) — Object I/O-Prozedur
setAccessPointer (File, Cardinal) — Object I/O-Prozedur
getAccessPointer (File) — Cardinal I/O-Prozedur
getFileSize (File) — Cardinal I/O-Prozedur
isEndOfFile (File) — Boolean I/O-Prozedur
isFileReadable (InputFile) — Bool I/O-Prozedur
isFileWritable (OQutputFile) — Bool I/O-Prozedur

Files werden als spezielle Ports behandelt. Es gibt drei Arten von Files:

o reine Lese-Files. Ihre Grofe ist durch getFileSize feststellbar, das File-
Ende ist durch isEndOfFile feststellbar.

e reine Schreib-Files

e Files, auf die man lesend und schreibend zugreifen kann.

Diese Files haben eine feststellbare Grofie und einen aktuellen Access-
Pointer, der beliebig gesetzt werden kann. Der Access-Pointer gibt an,
welches der Index das néchsten Objekts ist, das gelesen oder geschrie-
ben wird. Fiir jedes File kann der Access-Pointer Werte zwischen 0 und
getFilesize(File) annehmen.

Files sind deswegen Ports, weil sie ein blockierendes Verhalten zeigen kénnen.
AccessFiles konnen als Tripel, bestehend aus einem Input- einem Output- und
einem Steuer-Port, modelliert werden.

Interrupt — Type Typ
createInterrupt (Address) — Interrupt Prozedur

Ein Interrupt ist ein Objekt, dessen einzige Funktion darin besteht, dal man
darauf warten kann. Interrupts bringen keine Werte mit sich. Die typische Ver-
wendungsform sieht so aus:

\"UberdruckMelder = createlnterrupt(16#00fe4712)

suspend \"OffneVentil until \"Uberdruckmelder within 0,0
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Ein Suspension, die von einem Interrupt abhéngt, definiert einen Handler. Dieses
Programmfragment installiert einen ‘Einmal-Interrupt-Handler’. Ist kein solcher
Handler installiert, wird der ‘Null-Handler’ aufgerufen, der nichts tut:

proc NullHandler(I : Interrupt) =
supend NullHandler(I)
until I within 0,0

Es darf immer nur einen Prozefl geben, der auf einen Interrupt wartet. Installiert
sich ein neuer Handler, wird der alte geloscht, d.h. nie aktiviert.

Interprozef3-Kommunikation

Channel — Type Typ
ChannelOf (Type) — Type Typ
writeToChannel (Channel, Obj) — Prozedur
readFromChannel (Channel) — Obj Prozedur
isChannelReadable (Channel} — Bool Prozedur
isChannelWritable (Channel} — Bool Prozedur
? Channel — Obj Prefix-Prozedur
Obj —> Channel — Infix-Prozedur

Ein Channel ist eine Queue der Lénge 1. Jeder Prozefl kann in jeden Channel
hineinschreiben und aus jedem Channel lesen. Die Zugriffsprozeduren blockie-
ren, d.h. ein schreibender Prozef} blockiert, bis ein lesender Prozef§ auf den Chan-
nel zugreift; ein lesender Prozef blockiert, bis etwas in den Channel geschrieben
wird (Rendezvous).

Channel sind das einzige ‘echte’ IPC-Konstrukt. ALDiSP—Channel entspre-
chen dem gleichnamigen Konstrukt in QOccam[9]?2.

? und -> sind die Abkiirzungen fiir ReadFromChannel und writeToChan-
nel. Wenn eine Implementierung einen ‘echten Pfeil’ (?—) anstelle von >->?
anbieten kann, sollte sie dies tun.

Sonstiges

Error (Obj .... Obj) — bottom Prozedur

Error ist eine Prozedur, die Fehlerausgaben vornimmt. Das Ergebnis ist bottom.
Es wird nicht garantiert, dal wirklich eine Fehlermeldung erscheint — in vielen
Umgebungen wird es hierzu keine Moglichkeit geben.

Object is Constructor — Bool essentielles Pradikat

is ist kein ‘echtes’ Pradikat, sondern Teil des Mechanismus der abstrakten Da-
tentypen. Es stellt fest, ob Object vom Constructor erzeugt worden ist.

22 Allerdings ohne die elaborierten ‘Protokoll’-Strukturen: Da ALDiSP von sich aus poly-
morph ist, sind diese nicht notwendig.
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2.4 Die Arbeitsumgebung

Der einzige genormte Teil der Arbeitsumgebung, d.h. des Interpreters/Compi-
lers, ist die Beschreibung der File-System-Schnittstelle.

Man kann davon ausgehen, daf ein ALDiSP-Programm in mehrere Files
aufgeteilt ist, von denen jedes eins oder mehrere Module oder das “Haupt-
programm” enthilt. Innerhalb der Sprache Modulnamen irgendwie in Datein-
amen um) scheint mir sehr umstindlich und fehlertrichtig — was, wenn das
File-System bestimmte Zeichen nicht kennt?. ALDiSP sieht daher ein Link-File
vor, das die Namen der Module mit ithren Aufenthaltsorten assoziiert. Das For-
mat ist einfach:

LinkFile ——  LinkLine +

LinkLine —— ModuleName < Zwischenraum>
FileName < Zeilen- oder File-Ende>
| Kommentar

Kommentar —  “\” <Kommentar bis Zeilen- oder File-Ende>

Die Modul-Namen entsprechen genau den ALDiSP-Namen, nur das Haupt-
modul hat den (ansonsten nicht reservierten) Namen main, der daher nicht als
Modulname auftauchen darf. Ein Link-File unter UNIX koénnte so aussehen:

\ Demo-Linkdatei

main \usr\pdv\mfx\test\main.ald
int16é \usr\pdv\mfx\test\stdints.ald
int24 \usr\pdv\mfx\test\ints.ald
int32 \usr\pdv\mfx\test\stdints.ald
i/o \usr\pdv\mfx\test\iolib.ald

Das main-File enthélt die Netzdefinitionen und eine Reihe von Importen,
die anderen Files enthalten (ein oder mehrere) Module. Aus jedem File werden
selektiv die Moduldefinitionen gelesen, die in der Linkdater angegeben sind. Im
Kontext des o.a. Beispiels heifit dies: enthélt die Datei ...\stdints.ald ein
Modul int24, so wird dies ignoriert; es kommt nicht zum Konflikt mit dem aus
...\ints.ald gelesenen Modul.
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Die ALDiSP-Entwicklungsumgebung

3.1 Interpreter vs. Compiler

ALDISP soll zuerst in der CADiISP-Umgebung als Zwischensprache (“unterhalb”
einer interaktiven objekt-orientierten graphischen Benutzeroberflaiche, aber “iiber’
der Assemblersprache der realen Maschine) eingesetzt werden. In dieser Umge-
bung sollen primar DSP-Algorithmen fiir (mehr oder weniger) beliebige Hardware-
Konfigurationen erstellt werden, d.h. fiir

>

e Ein- oder Mehrprozessorsysteme

e Verschiedene DSP-Prozessoren

o verschiedenste Hardware-Unterstiitzungen (Timer, I/O, Speicher).
DSP-Anwendungen zeichnen sich durch folgenden Eigenschaften aus:

o Oft mufi der Code im ROM stehen (eingebettete Applikationen z.B. in der
Telekommunikation).

o Der Code muf} oft extrem klein sein.
e Der Code muf} fast immer extrem schnell sein.

Gerade der letzte Punkt ist wichtig: der Code, der vom ALDiSP-Compiler er-
zeugt wird, sollte genauso schnell sein wie von Hand programmierter Assem-
bler-Code! .

Es werden also verschiedenste Anforderungen an ALDiSP-Programme ge-
stellt — Anforderungen, die kein einzelner Compiler sinnvoll erfiillen kann. Es ist
daher notwendig (und auch ansonsten sinnvoll), mindestens zwei Ausfithrungs-
mechanismen fiir ALDiSP-Programme zur Verfiigung zu stellen: einen Interpre-
ter und (mindestens) einen Compiler.

!Eine performance degradation von bis zu 50% ist wahrscheinlich meist in Ordnung, aber
viel mehr nicht.

72
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3.2 Der Interpreter

Ein ALDiSP-Interpreter hat die Funktion, Programme sofort, semantisch kor-
rekt und mit einem maximalen Grad von interaktiver Einsichtnahme auszufiihren,
solange sie noch noch in der Entwicklung sind. Die Ausfiihrungszeit eines In-
terpreters ist dabei ziemlich irrelevant?. Ziel ist es, mit dem Interpreter ein
fehlerfreies Programm zu entwickeln, das dann von einem hochoptimierenden
Compiler iibersetzt wird.

3.2.1 Simulation von Echtzeit

DSP-Programme laufen, wenn sie einmal auf die Zielmaschine gebracht sind,
in Echtzeit, d.h. miissen harten Zeitvorgaben (timing constraints) geniigen. Der
Interpreter mufl in der Lage sein, diese Zeitvorgaben modellieren zu kénnen.
Dies kann er tun, indem sdmtliche Ein- und Ausgaben mit Zeitangaben (time
tags) versehen werden. Der Interpreter weifl zwar noch nicht, ob der Compiler
in der Lage sein wird, Code der gewiinschten Geschwindigkeit zu erzeugen, er
kann aber helfen, die Zeiteigenschaften der Programme korrekt zu formulieren,
d.h., festzustellen, ob die durch die Suspensions vorgegebenen virtuellen Zeiten
die gewiinschte Funktionalitdt erbringen.

3.2.2 Fehlermeldungen und Debugging

Die eigentlich zentrale Eigenschaft von Interpretern, die sie von (normalen oder
inkrementellen) Compilern unterscheidet, ist das Erhaltenbleiben der Quellprogramm-
Struktur bei der Programmausfithrung. Wenn ein Fehler auftaucht, kann er
in der Terminologie des Quellprogramms beschrieben werden; es mufl keine
umstindliche “Riick-Ubersetzung” aus dem Assembler (oder der virtuellen Ma-
schine) in die Quellsprache erfolgen. Insbesondere sind Debugging-Techniken wie
die Uberwachung von Variablenwerten, das Warten auf bestimmte Programm-
zustinde etc., die normalerweise schwer zu realisieren sind, in einem Interpreter
trivial. Die Fehlerbehandlungsmoglichkeiten in Smalltalk-80[17] und Scheme[5]
sind hierbei vorbildlich: Tritt ein Fehler auf, stoppt die Auswertung, die gesamte
Aufrufgeschichte des fehlgegangenen Ausdrucks ist als Datenobjekt vorhanden,
also sichtbar und modifizierbar; Korrekturen vor Ort ermdoglichen ein schnelles
Austesten.

Ein ALDiSP-Interpreter muf die Eigenschaft haben, alle Fehler (gleich wel-

2Nun ja, in der Praxis vielleicht nicht: wenn mit dem Interpreter die Verarbeitung nichttri-
vialer Datenmengen simuliert werden soll, sollte er schon eine Geschwindigkeit von, sagen wir,
1% der avisierten Endgeschwindigkeit, erreichen. Niichtelange Simulationsldufe gefallen nie-
mandem — sind aber immer noch besser als nichtelange Ubersetzungszeiten von Programmen,
die dann doch falsch sind und in einer nicht-kooperativen Umgebung abstiirzen: Debugging
am Logik-Analysator ist auch kein Vergniigen.
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cher Art) die in der Semantik eines Programms begriindet liegen®, zu finden und
korrekt und mit maximaler Ausfiihrlichkeit zu melden. Dies ist beim Compiler
ganz anders.

3.3 Der Compiler

Ein ALDiSP-Compiler wird ein langsames, grofles, tabellengetriebenes Pro-
gramm sein: er muf} sich relativ leicht an neue Prozessoren, andere Konfiguratio-
nen und verschiedene Grade der Parallelitit anpassen lassen. Zugleich muf} stets
eine (im Vergleich zu von Hand codiertem Assembler) ziemlich optimale Uber-
setzung gewéahrleistet sein; diese beiden Forderungen implizieren die Existenz
einer extensiven Optimierungsphase, womoglich auch in und nach der Code-
Erzeugung, die essentiell heuristisch—kombinatorischen Charakters sein wird.

Man mufl damit rechnen, dafl ein mittelgroes Programm einige Stunden zur
Ubersetzung bendtigen wird.

3.3.1 Statisches und Dynamisches Scheduling

Neben der Ubersetzungsarbeit am Programm mufl der Compiler eine Lauf-
zeitumgebung zur Verfligung stellen, die vor allem eine Funktion haben wird:
Interrupt-Steuerung und Scheduling der Prozesse.

Im idealen Fall einer total synchronen Anwendung kann man ohne einen
Scheduler auskommen, es gibt einen statischen Schedule, d.h. einen unveréander-
baren Fahrplan, den das Programm nie verldfit. Anstelle von Interrupts besorgen
in einem solchen Programm oft Warteschleifen die Zeitkontrolle. Wo immer dies
moglich ist, sollte der Compiler die Moglichkeit zu einem statischen Schedule
erkennen und dementsprechend Code erzeugen.

Im Normalfall jedoch ist dies nicht méglich: je nach Art der eingehenden
Daten (und dem Zeitpunkt ihrer Ankunft) wird sich das Zeitverhalten des Pro-
gramms dndern. Als Konsequenz hiervon muf es einen Scheduler geben, d.h. eine
Uberwachungsroutine, die (z.B. durch einen Zeitscheibenmechanismus) den Pro-
zessen Laufzeit zuteilt, sie schlafenlegt und wieder aufweckt. Je genereller der
Einsatzbereich eines solchen Schedulers, desto grofier der mit ihm verbundene
Overhead: daher sollte der Compiler eine Palette von Schedulern variabler Kom-
plexitét erzeugen konnen: Scheduler fiir zwei, drei, k oder beliebig viele Prozesse;
fiir einfache und komplexe Trigger-Expressions (Suspension-Erweckungs-Bedin-
gungen); fiir eine oder mehrere Interruptquellen, usw.

3Vom Interpreter kann nicht erwartet werden, dafl er Ressourcenfehler oder Zeitiiberschrei-
tungen findet kann.
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3.3.2 Fehlerverhalten

Von einem compilierten ALDiSP-Programm kann kein “korrektes” Fehlerver-
halten erwartet werden. Das Auftreten eines Fehlers? fiihrt zu “undefiniertem”
Verhalten® | insbesondere zu allen Arten von “Abstiirzen”. Dies ist v6llig in Ord-
nung, da ja alle Programme auf dem Interpreter getestet und daher korrekt sind.
Wiren da nicht Ressourcen- und Zeitfehler: Wahrend alle “semantischen” Fehler
(Typfehler, nondeterministische Ausdriicke und nichtterminierende Berechnun-
gen) im Interpreter gefunden werden kénnen, féllt dies bei “Laufzeitfehlern”
schwer.

Ressourcen- und Zeitfehler

Ein Ressourcen-Fehler tritt auf, wenn eine endliche Ressource (meist Speicher
oder File-System-Platz, aber auch Bandbreite) erschopft ist. Offensichtlich sind
diese Fehler von der realen Maschine abhingig und nicht durch Testldufe auf
einer ‘idealen’ Maschine, wie sie ein Interpreter nun einmal darstellt, im Voraus
feststellbar.

Zeit ist eine ganz speziele Ressource: man kann Zeit nicht einfach wie Spei-
cher kaufen; DSP-Prozessoren befinden sich meist schon an der Grenze des tech-
nisch Machbaren, was Geschwindigkeit angeht. Zeitfehler treten auf, wenn (in
ALDiSP- Terminologie) die realen Zeitpunkte, an denen I/0 stattfindet, mit
den virtuellen Zeitpunkten nicht gentigend iibereinstimmen — in der Praxis heift
dies, “weil das Programm zu langsam lauft” . Zeitfehler kénnen in starkem Mafle
datenabhéngig sein und sind oft komplexer als andere Ressourcenfehler.”

3.3.3 Eine pragmatische Hilfestellung

Es gibt eine ganze Reihe von Programmen, die sich als ’statisch’ im Speicherbe-
darf und im Zeitverhalten (oder in der Bandbreite oder worin auch immer) er-
weisen und so, zumindest theoretisch, zur Ubersetzungszeit als frei von Laufzeit-
Ressourcen-Fehlern bewiesen werden kénnen. Es mufl auch Aufgabe eines Com-
pilers sein, eine moglichst grofle Menge dieser Programme zu erkennen. Ein Hilf-
mittel hierfiir ist der Einsatz von Funktionalen, wie er schon in 1.2.4 beschrieben

4Mit ‘Fehlern’ sind keine numerischen Exceptions gemeint — Man kann davon ausgehen, daf$
zu Laufzeit nur mit saturierter oder wrap-around-Arithmetik gearbeitet wird, da es zusatzli-
chen Aufwand erfordern wiirde, arithmetische Fehler iiberhaupt zu erkennen. ‘Fehler’ im Sinne
dieses Abschnitts sind z.B. ein ‘illegaler Array-Index’ und ’Stack Overflow’.

5Dies geht mit der Interpretation von L als dem am schwichsten definierten Wert einher,
der durch jedes Berechnungsverhalten, auch durch das nichtterminierende, korrekt berechnet
wird.

8 Interrupt-Uberschneidungen, fehlende kritische Sektionen etc. gehéren in die Reihe der
semantischen Fehler, da sie zu undeterminiertem Verhalten fithren: es gibt fiir einen Ausdruck
mehrere Auswertungsreihenfolgen, die zu verschiedenen Ergebnissen fithren. Derartige Fehler
sollte man mit Hilfe des Interpreters finden kénnen.



KAPITEL 3. DIE ALDISP-ENTWICKLUNGSUMGEBUNG 76

wird. Ein Compiler, der Probleme hatte, allgemeine Rekursionstrukturen aufzu-
decken, kann eine feste Anzahl von Funktionalen als ‘build-in’ erkennen und iiber
sie argumentieren. Er kann iiber ihre Laufzeit- und Terminationseigenschaften
informiert sein und (da er auch die maximale Laufzeit aller Primitiven kennt)
die maximale Laufzeit ganzer Programme einschatzen. Es ist auch moglich, ein-
fache Rekursionsstrukturen durch Analyse des Programms zu gewinnen; dies ist
jedoch iiberaus aufwendig, schwer zu verallgemeinern und fehlertrachtig.
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Rationals

4.1 Zur Modellierung von Maschinenobjekten

Bei der Definition der Maschinentypen wurde versucht, ein moglichst breites
Anwendungsspektrum abzudecken. Die meisten synchronen und asynchronen
I/O-Gerite sollten sich durch einfach Ports realisieren lassen; die meisten kon-
tinuierlich arbeitenden Gerite (z.B. D/A-Wandler) sollten durch Register mo-
dellierbar sein.

Die Idee der Maschinentypen ist nicht, Objekte zu konstruieren, mit de-
nen man ‘rechnen’ kann — Maschinentypen sind keine Datentypen —, sondern
dem Implementierer die Moglichkeit zu geben, in der Hardwareumgebung vor-
gegebene Objekte standardisiert zu modellieren. Voraussetzung dazu ist, das es
eine feste Hardware-Konstellation gibt, deren Eigenschaften sich nicht zu schnell
dndert (oder nur endlich wenigen Variationen kennt: Ein Beispiel ist ein kom-
binierter 1/O-Port, der zu einem Zeitpunkt nur Input oder Ouput liefern kann
und mit einem gezielten Kontrollregister manipuliert wird.) Der Programmie-
rer wird also im Normalfall keinen Bedarf haben, Maschinenobjekte selbst zu
deklarieren; alle relevanten Objekte werden von der Umgebung vorgegeben.

Eine Erleichterung fiir den Implementierer einer spezifischen Umgebung ist
die Moglichkeit, Hardware-Bausteine durch Funktionspakete zu modellieren. Als
bekanntes Beispiel soll hier der ACIA 6850 beschrieben werden, ein beliebtes
Teil fiir die serielle I/O. Um Maschinenobjekte zu deklarieren, werden hier ein
Datentyp (Address) und einige Funktionen (declareInputPort etc.) benutzt,
die in einer Vorversion als Primitive deklariert waren, jetzt jedoch nicht mehr
fiir den ‘normalen’ Programmierer zur Verfiigung stehen.

Module Hardware
Exports ACIAG850 : (Address -> Control6850,
Status6850,
Send6850,
Receive6850),
Control6850: InputRegister(Byte),

77
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Status6850 : OutputRegister(Byte),
Send6850  : InputRegister(Byte),
Receive6850: OutputRegister(Byte)

proc ACIA6850(Base : Address) =

let
Control = declarelnputRegister(Byte,Base+4)
Transmit= declareInputRegister(Byte,Base+5)
Status = declareOutputRegister(Byte,Base+6)
Receive = declareOutputRegister(Byte,Base+7)

in

(Control,Status,Send,Receive)

endlet

\ Es k\"onnen noch viele Spezialfunktionen folgen, z.B.

proc Reset6850(C : Control6850) =
WriteToRegister(C,2#00000011)

EndModule Hardware

Ein Problem tritt auf, wenn eine Interruptquelle eingebunden werden muf.
Auf vielen Prozessoren sind alle Interrupts distinkt; fiir n Interruptquellen gibt
es dann ein n Elemente grofles Array von Sprungadressen. Wenn sich jedoch
mehrere Quellen einen Interrupt teilen, mufl Code erzeugt werden, der alle mogli-
chen Interruptquellen abfragt. Dies mufi von Hand geschehen, d.h. kann dem
ALDiSP-Compiler nicht allein iiberlassen werden (immer mit der Einschrankung
‘bei den jetzt definierten Typen’ — sicher ist es moglich, diese Abfragen explizit
in ALDiSP zu schreiben; aber dies ist wahrscheinlich nicht effizient).

Zusitzliche Maschinentypen erméglichen es, um “Compiler-Direktive” her-
umzukommen, z.B. kénnte es zur Modellierung asynchroner Interrupts, die mit
einer bekannten Haufigkeit auftreten, einen Typ AverageInterrupt (Duration)
geben.

4.2 Zur Implementierung von Suspensions

Die Suspensions stellen das am schwierigsten zu implementierende Element von
ALDiSP da. Bei ndherer Betrachtung vereinfacht sich die Implementierung je-
doch, wenn man keine zu allgemeinen Abhingigkeiten aufbaut. Es soll im Fol-
genden eine Strategie zur effizienzen Implementierung der meisten real vorkom-
menden Suspensions erldutert werden.
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Einfache Datenabhingigkeiten
Die meisten Suspensions modellieren Datenabhingigkeiten. Das Programm

proc a(X) =
suspend F(head(X)) :: a(tail(X))
until isAvailable(X)
within 0,0

proc b() =
suspend readFromPort(A) :: b()
until isReadable(4)
within 0,0

net in
a(b())

endnet
ist eine explizit notierte Variante! des Programms

func a(X) = F(head(X)) :: a(tail(X))
proc b() = readFromPort(4) :: b()

net in
a(b())

endnet

Zu jedem Zeitpunkt der Programmausfithrung wird es theoretisch zwei Suspen-
sions geben — die eine wartet auf einen Input am Port ‘A’ die andere auf ein
Element des Streams ‘X’. Fiir alle praktischen Belange handelt es sich dabei
jedoch nur um eine Suspension, da eine Datenkopplung vorliegt, die die von den
beiden Suspensions erzeugten Prozesse synchronisiert. In dem Beispiel ist dies
trivial zu sehen: man kann das Programm derart umschreiben, dafl nur mehr
eine Suspension sichtbar ist:

proc c() =
suspend F(readPort(4)) :: c()
until isReadable(4)
within 0,0

net in

c()

endnet

IMan beachte, das “a” einmal eine Prozedur, das andere Mal eine Funktion ist. Das liegt
daran, dafl im ersten Fall eine explizite Erwdhnung der Suspensions auftritt; im zweiten Fall

jedoch nicht. Das erste “a” ist somit spezialisierter als das zweite.
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Will man dieses Datenabhingigkeitsprinzip verallgemeinern und abschitzen,
wieviele Suspensions derart reduziert werden kénnen, so mufi man sich vor Au-
gen halten, dafl der fiir die Analyse relevante Teil die Bedingung der Suspension
ist. (Es soll hier von normalen, ’asynchronen’ Suspensions ohne Verzogerungs-
faktor ausgegangen werden). Diese Bedingungen konnen nur an Zustandsdnde-
rungen festgemacht werden, das heifit an I/O-Objekten und dem Zustand ande-
rer Suspensions. Typische DSP-Anwendungen sind Input-getrieben bzw. laufen
synchron, so dafl der Zeitpunkt einer ganzen Abhangigkeitskette von Prozessen
vom Zeitpunkt der Eingabe abhéngt. Implementierungstechnisch heifit dies, dafl
an jeder moglichen Eingabequelle ein Interrupt angebracht wird; die Suspensi-
ons stellen den Interrupthandler dar. Im Fall einfacher Datenabhéngigkeiten
braucht es dabei keinen weiteren Scheduler (solange sich die Interrupts nicht
tiberschneiden); etwas problematischer wird es, wenn komplexe Abhéngigkeiten
bestehen.

Komplexe Datenabhingigkeiten
Die einfachste komplexe Abhéngigkeit ist die Abhéngigkeit von zwei Zustdnden:

proc merge(X,Y)
suspend
if isAvailable(X) head(X)::merge(Y,tail(X))
| isAvailable(Y) head(Y)::merge(X,tail(Y)) endif
until
isAvailable(X) or isAvailable(Y)
within 0,0

Natiirlich kann eine solche Abhéngigkeit noch von vielen logischen Verkniipfun-
gen begleitet sein:

proc PrinterDaemon()
\ Aufwachen, wenn ein Problem auftaucht ODER
\ wenn ein Printer nichts zu tun hat und ein job anliegt
\ (Es gibt 3 Printer und 2 Job-Kan\"ale)
suspend

until
OutO0fPaper(Printeri)
or OutOfPaper(Printer2)
or OutOfPaper(Printer3)
or (( NewJobOn(Channell)
or NewJobOn(Channel2))
and
(  PrinterAvailable(Printeri)
or PrinterAvailable(Printer2)
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or PrinterAvailable(Printer3))

)

Es gibt mehrere Méglichkeiten, diese komplexe Abhéngigkeit zu implementieren.
Die einfachste ist die Umwandlung des Bedingungsausdrucks in eine Routine,
die jedesmal aufgerufen wird, wenn sich einer der Zustdnde dndert (es wird nur
endlich viele davon geben). Diese Moglichkeit steht immer offen, ist jedoch nicht
von maximaler Effektivitdt. Wenn die Bedingung wie im obigen Beispiel durch
or-Ketten zusammengehalten wird, kann es eleganter sein, aus einer Suspension
mehrere zu machen. Im o.a. Code kann man mindestens 4 Prozesse bilden: drei
fiir ‘out of Paper’, einer fiir ‘Job verteilen’.

Abstruse Bedingungen

Unter dem Begriff ‘Abstrus’ méchte ich die Bedingungen verstehen, die zu auf-
wendig sind, um in Echtzeit abgetestet werden zu konnen?. ‘Abstrus’ heifft nicht
‘sinnlos’; sondern nur ‘wahrscheinlich nicht durch einen Compiler hinreichend
effizient tibersetzbar’. Das ‘Printer’-Beispiel zeigt eine Bedingung am Rande der
Unimplementierbarkeit. Ein schoneres Exemplar st dies hier:

func FFT(X: Vector) = ....

proc HochfrequenzWarnung
suspend <Irgendetwas>
until
FFT(ListToMatrix
(256 ,readPipeFromRegister(1 sec/44100, DA_Wandler)
)
)(255)>0.5
within 0,100ms

Die Intention ist es hierbei, 256 Samples einzulesen, die FFT darauf anzuwenden

und festzustellen, ob ein bestimmtes Frequenzband (das héchste in diesem Fall)

eine Amplitude von 0.5 iiberschreitet. Tritt dies ein, wacht die Suspension auf.
Hier wurde das Suspension-Konstrukt ‘falsch’ eingesetzt, denn:

e Die Bedingung einer Suspension soll sich, zumindest theoretisch, in Null-
zeit berechnen lassen — d.h. in ‘virtueller Nullzeit’. Das Einlesen von 256
Daten erfordert jedoch die Konstruktion von 256 Suspensions — in diesem
Beispiel kann die Bedingung nur alle 1/172 Sekunden berechnet werden!
(Dies ist der einzige auch ‘formal falsche’ Aspekt des Beispiels)

e Der Rechenaufwand ist viel zu hoch — eine FFT ist eine grofiere Operation,
die leicht in die Millisekunden gehen kann!

2Grober Anhaltspunkt: Eine Bedingung sollte, bei intelligenter Implementierung, in weni-
ger als, sagen wir, 20 Instruktionen abtestbar sein.
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e Die Bedingung 148t sich nicht durch daf} Interrupthandler-Modell imple-
mentieren.

e Der Compiler wird kaum in der Lage zu sein, die 100 Millisekunden Reak-
tionszeit garantieren zu kénnen. (Auch wenn das Programm dies nachher
mit Leichtigkeit bewiltigt — es sollte doch statisch beweisbar sein!)

Eine korrektere Implementierung des Problems konnte so aussehen:

func FFT(X: Vector) = ....

proc HochfrequenzWarnung()
if
FFT(ListToMatrix (256,
readPipeFromRegister(1 sec/44100, DA_Wandler))
)(255)>0.5
then <Irgendetwas>
else HochfrequenzWarnung()

Wird diese Prozedur gestartet, so liest sie 256 Daten ein, berechnet die FFT,
und testet die Frequenz. Wie man sieht, ist eine explizit Suspension oft gar
nicht nétig! Implizit, d.h. durch das readPipe. .., wird dafiir gesorgt, daf die
Prozedur nur alle 1/172 Sekunden aufwacht (wenn alle Daten gesammelt sind)
und rechnet. Es wird kein Versprechen hinsichtlich der Ausfithrungszeit gemacht,
also hat der Compiler auch keine Probleme mit der Verifikation. (Natiirlich ist
auch nicht gesichert, daf§ iberpriift wird, ob das Programm “hinterherkommt”.)

4.3 Diverses

Integers sind Fixpunkttypen

Integers konnen als der Spezialfall von Fixpunktzahlen, der keine Nachkomma-
stellen hat, angesehen werden. Dies wird in der ALDiSP-Beschreibung nicht
betont, da

o es etliche Funktionen gibt, die nur auf Integers und Cardinals definiert
sind,

e Integers implementierungstechnisch anders behandelt werden und

o Integers und Cardinals stark nicht-numerischen Einsatz finden (z.B. in der
Array-Indizierung).

Integer ist somit neben Bool ein de facto im Sprachkern eingebundener Da-
tentyp, wahrend die Fixpunkt-Typen z.B. auf einem Floating-Point-DSP unter
Umsténden gar nicht implementiert sind.
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Zu den Regeln zur Typisierung numerischer Resultate

Diese Regeln haben reinen Vorschlagscharakter. Im Prinzip kénnen die Resul-
tate numerischer Funktionen beliebig aussehen, solange garantiert ist, dafl es
nicht zu einem Uberlauf kommen kann. Die Idee hinter den Typisierungsregeln
ist die, dafB} es fiir einen moglichst groflen Teil der numerischen Funktionsaufrufe
statisch feststellbar ist, daB es zu keinem Uberlauf kommt. Ist dies garantierbar,
folgt daraus, dafi es zu keinem Exception-Aufruf kommt, d.h. dafi Funktionen
ohne den fiir Exceptions notigen Overhead iibersetzt werden koénnen. Es ist
jedem Compiler erlaubt, beliebig detaillierte Aussagen iiber einen Resultatty-
pen zu treffen, d.h. Wertmengenabschétzungen, die weit iiber das, was in den
vorgeschlagenen Typregeln erwdhnt wird, hinausgehen. Ebenso ist es jeder Im-
plementierung erlaubt, nur einen Integer-Typen zu unterstiitzen und bei jedem
Funktionsaufruf den Exception-Overhead zu ertragen. Zum Beispiel fiir einen
Interpreter geht dies véllig in Ordnung.

Funktionen variabler Stelligkeit

In ALDiSP kann man keine Funktion variabler Stelligkeit notieren: so ist es z.B.
nicht méglich, eine allgemeine Kompositionsfunktion zu notieren. Es ist ziem-
lich klar, wie eine Erweiterung in diese Richtung aussidhe: Man 148t einfach die
Klammern bei der Applikation weg; eine Variable (bzw. eine Expression) steht
dann fiir die ganze formale (bzw. aktuelle) Parameterliste: func comp(f,g) x
= £ g x Das syntaktische Problem dabei ist die Unterscheidung zwischen dem
1-Tupel und seinem Inhalt. £ (g x) impliziert, das g genau einen Wert als Resul-
tat liefert, kann aber auch als einfache Klammerung gesehen werden! Um diesen
Problemen zu entkommen (und weil die Struktur eines Programms nicht gerade
lesbarer wird, wenn mit variabelstelligen Funktionen gearbeitet wird), ist diese
Erweiterung nicht iibernommen worden.

“Rein funktionale” I/0

Jegliche T/O wird in ALDISP als Nebeneffekt aufgefaBt. Hier soll kurz erldutert
werden, wie sich eine derartige 1/O funktional “sauber” interpretieren 14ft. Die
Idee dahinter ist, die “Umgebung” des Programms (den “Weltzustand”) und
alle Anderungen dieser Umgebung durch zustandséndernde Prozeduraufrufe zu
formalisieren. Im einfachsten Falle geschieht dies, indem jede derartige Prozedur
F mit der Funktionalitdt x — y zu einer Funktion F’ mit der Funktionalitat
r,s — y, s’ umgewandelt wird, wobei s den alten, s’ den veranderten Zustand
modelliert. Es ist moglich (recht einfach, aber sehr schreibaufwendig), jedes
ALDiSP-Programm in dieser Weise umzuwandeln (Jede Prozedur, die Neben-
effekte erzeugt, mufl in dieser Weise erweitert werden). Diese Transformation ist
nicht “fein” genug fiir viele Bedarfsfille, da sie zu “vorsichtig” ist. Ein Beispiel:

WriteToPort(x,readFromPort (y)+readFromPort(z))
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wird entweder zu

seq
tmpl,statel = readFromPort(x,state0);
tmp2,state2 = readFromPort(y,statel);
state3=WriteToPort(tmpl+tmp2,state2);
state3

endseq

oder zu

seq
tmpl,statel = readFromPort(y,state0);
tmp2,state2 = readFromPort(x,statel);
state3=WriteToPort(tmpl+tmp2,state2);
state3

endseq

gewandelt — es wird eine Sequentialisierung vorgenommen. (Nebenbei wird eine
Fehlermeldung erzeugt, weil der Ausgangs-Ausdruck nicht voll deterministisch
war.) Wenn Port y und Port x jedoch, was wahrscheinlich ist, voneinander un-
abhéngig sind, d.h. nicht zwei Namen fiir dasselbe Objekt sind oder irgendwie ei-
ne gegenseitige Beeinflussung ausiiben, und das “+” kommutativ ist, ist die Rei-
henfolge irrelevant; die Sequentialisierung (und die Fehlermeldung ) ist unnétig.
Unnotige Sequentialisierungen sind nicht nur “aus Prinzip” zu vermeiden (wie
alle anderen unnétigen Operationen), sondern, weil sie die Moglichkeiten der
Optimierungs- und Parallelisierungsphase des Compilers einschréanken.

Ein Nachteil der Zustandsparametrisierung liegt darin, dafi sie realistischer-
weise den aktuellen Zustand nur modelliert, nicht aber implementiert. Es gibt
daher Einschrankungen beim Gebrauch der Zustandswerte: man darf sie nicht
“zweimal benutzen”: in einem Programm darf es zu jedem Zeitpunkt nur einen
Zustand geben; wiirden Zusténde in irgendeiner Art gespeichert, wiirde dies die
Implementierung eines ewigen Gedéchtnisses in der Art der “Demonic Memo-
ries” [15] implizieren — eine recht aufwendige Angelegenheit.

19-Bit Integers

Die Regeln zur Festlegung der Ergebnistypen arithmetischer Funktionen werfen
die Frage nach der Implementierbarkeit ‘krummer’ Typen auf. Der Ausdruck

([3 # [Integeri16] 10 + [Cardinal8] 1) + 2

wertet sich folgendermaflen aus: Zuerst mufl der Typ von 3 bestimmt werden.
Konstanten sind vom Typ Integer. In einer typischen Implementierung kénnte
Integer die Breite 16 haben. Es ist eine erlaubte Optimierung, einen ’feineren’
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Typen zu suchen, fir 3 wire dies zum Beispiel Cardinal(2). Je nachdem er-
gibt die Multiplikation [Integer31]130 oder [Integer18]130. Nach der ersten
Addition gibe es dann [Integer32]31 oder [Integer19]31, nach der zweiten
[Integer33]33 oder [Integer20]33.

Die Implementierung von 18-, 19- und 20-Bit-Integern ist kein Problem,
da durch die Resultattypisierungsregeln garantiert wird, dafl kein Unter- oder
Uberlauf auftreten kann. Wenn es aber keine derartigen Fehler zu beachten gibt,
kann man genausogut die ganze Rechnung z.B. mit 24-Bit- oder 32-Bit-Integern
implementieren.

Genau das 1st die Motivation hinter den ‘krummen’ Resultat-Typen: jede
Maschine wird nur wenige Wortbreiten effizient verarbeiten kénnen; aber eine
n-Bit Wortbreite implementiert alle ‘<n’-Wortbreiten gleich mit. Die Typisie-
rungsregeln ermoglichen es, zur Ubersetzungszeit festzustellen, welche Berech-
nungszweige keinen Uberlauf erzeugen kénnen — implementierungstechnisch ha-
ben sie sonst keine Bedeutung, d.h. auf der realen Maschine werden sie (aufer
vielleicht in 1/O-Objekten) nicht mehr zu finden sein.

Keywords

Warum sind Keywords case-insensitive? Schliisselworter kénnen grofl
oder kleingeschrieben werden, weil viele Programmiersprachen sich nicht dahin-
gehend einigen konnen und viele Programmierer grof3- oder kleingeschriebene
Keywords erwarten. Ich selbst tendiere zur Kleinschreibung, aber bei Schliissel-
worten ist die Notwendigkeit der herausragenden Syntax gegeben, die als Motiv
hinter der GroBischreibung steht. Also wird beides zugelassen. Zugleich aber sol-
len bei ‘normalen’ Namen Grof- und Kleinschreibung verschieden sein, damit
gilt, dafl keine zwei unterschiedlich geschriebenen Namen dasselbe Ding bezeich-
nen — gleiches Objekt, gleiche Schreibung.

Warum heifit “=<” nicht “<=” ? “=>” und “<=" sind als Namen fiir Ver-
gleichsoperationen nicht benutzt worden, um diese Zeichenkombinationen fiir
“Pfeil”-Operationen freizuhalten. Wo immer dies mé&glich ist, sollten die Sym-
bole “<” und “>” benutzt werden, so dafl die ungewohnliche Erscheinung von
“=<” nicht weiter stort.

Urspriinglich... sollten let und endlet sowie seq und endseq einfache ge-
schweifte Klammern sein; aber dies sah dem Betreuer zu sehr nach ’C’ und zu
wenig nach Blockstruktur aus. Die Syntax wird aber nicht uneindeutiger, wenn
diese Anderung riickgéingig gemacht wird; daher empfehle ich, die geschweiften
Klammern als Alternativkonstrukt beizubehalten.

Uneindeutigkeiten in der Grammatik FEs gibt mindestens eine bekannte
Stelle in der Grammatik von ALDiSP, die uneindeutig ist. Dies ist die Verwen-
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dung des Gleichheitszeichens sowohl in 1et und den sequentiellen Definitionen
als auch als Vergleichsoperator. Ein Ausdruck der Form

a = b(c) = d(e)(f)=e
hat folgende Interpretationsmoglichkeiten:

=b; (c) =d(e) ; (£) = e
b(c) = d(e) ; (f)=e

b; (c) = (d(e)(f) =e)
(blc) = (d(e)(£f) = e ))

O o o
non

Um dies zu verbieten, wurde die Klammerung von Namen (auch Namenstupeln)
auf der linken Seite von Definitionen verboten. Eine einfachere Losung wére es,
ein anderes als das Gleichheitszeichen fiir Definitionen zu wé&hlen; aber + ist
im ASCII-Zeichensatz nicht vorhanden und :=, <= und <- sehen zu sehr wie
von-Neumann-Assignments aus und sind zudem zu lang.

Pipes vs. Streams

Manchmal scheint es so, als wiren Pipes und Streams eigentlich dasselbe und
die Unterscheidung rein semantisch, wihrend die Syntax fiir beide die gleiche
sein konnte, so dafl es nur ein Konstrukt gébe. Dies ist falsch. Das Problem
taucht auf, weil man meist ‘synchrone’ Anwendungen von Pipes untersucht, bei
denen dies in der Tat der Fall ist, die ‘asynchronen’ Fille jedoch auflier Acht
1aBt. ( Ein Ausdruck der Form foo (piper, pipes) soll synchron genannt werden,
3 aus pipe; und pipe; benétigt.
Asynchron soll der Ausdruck heiflen, wenn ein Datum in einer der beiden Pipes

wenn er, um ausgewertet zu werden, je ein Datum

ausreicht, d.h. ein (zeitlich deterministischer) Non-Determinismus vorliegt (man
kanns auch als Orakel sehen). Alle einfachen Funktionen des allgemeinen Typs
(pipe —-> pipe) sind zwangsliufig synchron.)

Warum gibt es soviele Integer-Typen und sowenig Reals?

Grundidee ist: es sollte eine breite Palette von Integers geben, da

e Arithmetik mit ungewohnten Integer-Breiten recht einfach zu implemen-
tieren ist

e Ungewohnte Breiten im I/O-Bereich hiufig auftauchen: sowohl in Hard-
ware-Ports als auch in Dateiformaten sind z.B. 7— oder 14-Bit-Daten
nichts Ungewohnliches.

3Eigentlich: je n Daten, aber im Rahmen dieser Diskussion ist der Spezialfall mit n=1

0O.B.d.A. ausreichend.
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Im Gegensatz hierzu ist das Rechnen mit Floating-Point eine aufwendig Sache,
die von fixen Libraries oder mit spezieller Hardware ausgefiihrt wird. In beiden
Féllen sind feste Datenformate (vor allem die IEEE-754 Formate[18]) zu erwar-
ten. Es wire ziemlich aufwendig, allgemeine Floating-Point-Routinen mit n Bits
Mantisse und m Bits Exponenten zu implementieren, und niemand wiirde sie
bendtigen. Also gibt es drei vorgegebene Real-Typen, fiir die sich 32, 64 und
80 Bit geradezu anbieten, aber nicht festgeschrieben sind — wer weif}; vielleicht
bringt Motorola iibermorgen einen 96-Bit DSP-Chip heraus, mit 48-Bit ‘Shorts’
und 144-Bit ‘Longs’.

Fehler und bottom

bottom hat zwei Semantiken: im Rahmen einer typischen Interpreterausfithrung
wird erwartet, dafl alle Fehlersituationen, auch nur dynamisch auffindbare, zu
einer Fehlermeldung und bottom als Resultat fithren. Tritt zur Laufzeit eines
compilierten Programmes eine Fehlersituation auf, bedeutet bottom ein “un-
definiertes Verhalten” | d.h. einen mé&glichen Absturz, fehlerhafte Resultate, auf
jeden Fall aber keine Garantie einer Fehlermeldung gleich welcher Art. Diese
zweite Interpretation von bottom ist rein effizienzbedingt.

And und Or

sind in ALDiSP, im Gegensatz zu Scheme oder Modula-2, echte Funktionen. Die
‘von-links-nach-rechts’-Auswertung wurde fallengelassen, weil sie

e Fehleranfallig ist — sie wird zu leicht iibersehen.

o nicht funktional ist — es gibt keinen logischen Grund, and und or getrennt
zu behandeln.

e nicht so leicht parallelisierbar ist — man weifl nicht, ob es auf die Sequenz
ankommt oder nicht.

e nicht notwendig ist — wenn es darauf ankommt, kann man die Sequentia-
litat auch explizit (durch Ifs) notieren.

4.4 Features, die ausgelassen wurden

Im folgenden werden einige “Auslassungen”, also Konstrukte und Typen, die
man vielleicht in ALDiSP erwarten wiirde, erldutert.

4.4.1 Assignment

Eigentlich sollte es zum Assignment ein eigenes Kapitel geben — so problematisch
ist alles, was damit zu tun hat.
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Dinge, die ohne Assignment nicht moglich sind

Das wichtigste Konstrukt, das es ohne Assignment nicht gibt, ist die Prozedur
mit Zustand, die einen mutablen Datentypen implementiert. (Gibt es von vorn-
herein mutable Datentypen, so kann man das Assignment damit implementie-
ren.) Ohne mutable Datentypen sind diverse Algorithmen und Datenstrukturen
schwer formulierbar. So ist ALDiSP z.B. kaum in der Lage, das objekt-orientierte
Paradigma zu unterstiitzen.

4.4.2 Continuations
Von der Einbeziehung von Continuations wurde abgesehen, da

o durch expliziten Continuation-Passing-Style so ziemlich alles gemacht wer-
den kann, was durch vorgegebene Continuations machbar ist,

e Continuations schwer effizient compilierbar sind und

o mit Continuations Obfuszierungen méglich sind, die nicht einmal mit dem
GOTO machbar sind. (Immerhin war die Continuation urspriinglich als
funktionale Verallgemeinerung des GOTO, d.h. als allgemeinste mégliche
Kontrollstruktur iberhaupt, entwickelt worden.)

Ich bin der Meinung, dafl es kaum gute Griinde fiir den Benutzer einer
Programmiersprache gibt, neue Kontrollstrukturen von solcher Méchtigkeit ein-
zufithren, daf} sie nicht mit dem Mittel der allgemeinen Funktionsabstraktion
beschreibbar sind. Continuations werden gerne benutzt, um Dinge wie Corou-
tinen und Streams zu beschreiben - Konzepte, die eine Sprache selbst vorgeben
sollte.*

4.5 Ungewohnte Sprachkonzepte

Im folgenden werden einige nicht-standard Elemente von ALDiSP erldutert.

4.5.1 Makros

Das (eingeschriankte) Makro-Feature wurde eingefiihrt, um Spezial-Syntax zu
sparen. In ALDiSP werden Makros als Funktionen aufgefafit, deren Aufruf call-
by-name statt call-by-value erfolgt und die keine Rekursion erlauben.

Die Makros bringen also keinen syntaktische Aufwand mit sich, da die Funk-
tionssyntax unverdndert {ibernommen wird. Der Aufwand im Compiler ist mi-
nimal (ungefihrliche textuelle Substitution, voll zur Ubersetzungszeit méglich).
Der pragmatische Vorteil eines solches Konstrukts wiegt dagegen schwer: Von

4Zum Thema ‘Kontrollstrukturen’ empfehle ich dem geneigten Leser: “A linguistic contri-
bution to GOTO-less programmin” by R. Lawrence Clark, CACM 27,4, April 1984
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haufigen Spezialfillen, die nicht-Funktionen enthalten (z.B. delay- und guard-
Ausdriicke), kann beliebig abstrahiert werden.?

4.5.2 Das allgemeine Typkonzept

Die Abkehr vom tradierten termbasierten Typkonzept (Aufbau von Termen
durch Konstruktoren, Zerlegung durch Pattern Matching), das in den meisten
funktionalen Sprachen (exemplarisch in ML) Anwendung findet, hat mehrere

Grinde:

o Pridikattypen sind allgemeiner als Termtypen (allgemeiner: Partition Ty-
pes — Typen, die die Menge der Objekte in disjunkte Teilmengen aufteilen)
und damit “theoretisch erstrebenswerter”.

e Préadikattypen lassen es zu, exaktere Aussagen iiber Funktionsparameter
und Expressions zu machen, als dies bisher méglich ist. Ein Pradikattypi-
sierung kann als Assertion bei der Verifikation eingesetzt werden. Beispiel:
Statt

func £(A: Array(m,n) i: Nat, j: Nat) =
\ Pre: 0<=i< m, 0<=j< m, 0<=i< n, 0<=j< n
Ali,j1+Al],4]

kann man direkt
type CardRange(n)(x) =

if isCardinal x then x<n
else false

endif
func £(A: Array(m,n), i: CardRange (m)
and CardRange(n),
j: CardRange (m)

and CardRange(n))
Ali,jl1+Alj,14]

schreiben. Eine derartige Typisierung hat mindestens 2 Funktionen:

— Sie wird wihrend der Entwicklungsphase als Laufzeittest durchgefiihrt
und kann somit zum Test und zur Verifikation eingesetzt werden.

— Der Compiler kann sie als Optimierungshilfe einsetzen.

5Man kann die Argumentation fiihren, da Makros eine Konsequenz der Orthogonalitit
sind, da es ohne sie nicht méglich ist, von beliebigen Ausdriicken zu abstrahieren.
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o Priadikattypen lassen sich einfach auf dynamisch getypte Sprachen (wie
Scheme und APL) aufsetzen. Typ-Deklarationen haben eine ausfiihrbare
Semantik (Test auf Wertebereiche von Parametern.)

e Wie das abstype—Konstrukt zeigt, bereitet es keine Probleme, ‘echte’
termbasierte Typen im Kontext einem pradikatbasierten Typsystems zu
definieren.

Eine ausfiihrliche Auslassung zu diesem Thema findet sich in [16].

4.5.3 Parser-Deklarationen

Urspriinglich sollten ALDiSP—-Ausdriicke ungefihr die Form von M-FEzpressions
annehmen®, also in ziemlich reiner Préfix-Form notiert werden... als einige Bei-
spielprogramme damit geschrieben wurden, war klar, das diese Form zwar véllig
ausreicht, aber uniibersichtlich ist. Es mufiten also Infix-Operatoren her. Norma-
lerweise sind alle Infix-Operatoren links-assoziativ. cons aber ist rechts-assoziativ
—und es gehort sich einfach nicht, eine funktionale Sprache zu schreiben, in der

a.b.c.() — (((a.b).c))

ist. Also gibt es beide Assoziativitdten. Dann kamen die Zeitangaben: man soll in
der Lage sein, “3 ms” schreiben zu kénnen (statt ms(3) oder ms 3). Also gibt
es Postfix (auBlerdem macht es Spaf, das immerwéhrende Beispiel mal anders
zu notieren:

func n! =
if n>0 then 1
else n*(n-1)!
endif

8Das LISP 1.5 Programmer’s Manual [19] kennt sie noch, die “LISP Meta-language”. Dort
notiert man

ged[x;y]=[x>y—rgedly;x];
rem[y;x]=0—rx;
T—ged[rem[y;x];x]

statt (in Scheme—Notation)

(define (ged x y)
(cond ((> x y) (gcd y x))
((= (rem y x) 0) x)
: (else (ged (rem y x) x))
)

Das Beispiel ist [19], Seite 7, entnommen.
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Und wenn man schon In- und Postfix hat, ist es sinnlos, am Préfix zu sparen,
also kann man sin 42 statt sin(42) schreiben. (Natiirlich ist letzteres aufgrund
der allgemeinen Klammer-Regel weiterhin erlaubt.)

4.5.4 Suspension

Das Suspension-Konstrukt ist das neuartigste Element in ALDiSP. Es stellt eine
Fortentwicklung von in diversen LISP-Dialekten eingefiihrten Konstrukten dar,
namentlich dem delay, das aus Scheme bekannt ist und direkt iibernommen
wurde, und dem dem future—Konstrukt, das z.B. in Multilisp[10] und Mul-
T[12] benutzt wird, um Prozesse zu erzeugen:

“The expression future X), where X is an arbitrary expression,
creates a task to evaluate X and also creates an object known as a
future to eventually hold the value of X. When created, the future
is in an unresolved, or undetermined, state. When the value of X be-
comes known, the future resolves to that value, effectively mutating
into the value of X and losing its identity as a future. Concurrency
arises because the expression future X) can proceed concurrently
with the evaluation of X. [....] Strict operations such as addition or
comparison, if applied to an unresolved future, are suspended until
the future resolves and the proceed, using the value to which the
future resolved as though that had been the original operand.”[12]

Die Idee hinter der Suspension ist es nun einfach, fiir die Berechnung der Future
einen Zeitrahmen anzugeben.

4.6 Vergleich mit anderen Sprachen

4.6.1 Scheme

ALDISP war zunéchst als Scheme[2]-Erweiterung mit verstandlicherer Syntax
geplant. Einige Elemente, z.B. das delay—Konstrukt, sind auch geblieben. Nach
langer Diskussion wurde das imperative set! entfernt. Der Typisierungsansatz
entspricht, wenn man Typisisierungen in operationalen Code umwandelt, ziem-
lich dem von Scheme, der Einsatz von bottom jedoch nicht. Scheme bietet keine
Méglichkeiten, ein automatischem Mapping fiir nicht-primitive Funktionen ein-
zubauen.

4.6.2 ML, Hope, Miranda etc.

ML, Hope und Miranda stehen hier exemplarisch fiir den ‘Mainstream’ moder-
ner funktionaler Sprachen.” Das System der abstrakten Datentypen und der

7Wer kennt die Namen? Man kénnte auch FX-87, FX-89, Haskell, Russell, Poly, Scratchpad
II, verschiedenste Lisp-Dialekte, funktional-relationale Sprachen wie POP-11 und Sprachen
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Exceptions ist ML[3] entlehnt, aber einfacher, da ALDiSP keine Riicksicht auf
eine statische Typdisziplin nehmen mufl und alles erlauben kann, was irgendwie
Sinn macht. Immerhin ist die Syntax der von ML doch nicht un&hnlich.

Anders als z.B. Miranda[4] wird ALDiSP nicht lazy, sondern eager ausgewer-
tet, was vor allem aus Effizienzgriinden und wegen der Nebeneffekte geschieht,
bei denen die Reihenfolge der Auswertung ja relevant ist, also nicht dem Inter-
preter iiberlassen werden darf.

4.6.3 APL

APL hat vor allem die Idee michtiger Array-Typen und des automatischen
Mappings geliefert. ALDiSP kennt keine hochdimensionalen Arrays (APL sieht
mindestens 64 Dimensionen vor!).

4.6.4 Modula-2

Modula-2 findet hier nur des Modul-Konzepts wegen Erwéhnung. ALDiSP kennt
keine ‘definition modules’, was auch nicht nétig ist, da jene in Modula-2 vor
allem fiir Speicherplatzberechnungen bei der separaten Compilierung und fiir
Typchecks notwendig sind — beides ist so in ALDiSP nicht implementierbar
bzw. notwendig.

4.6.5 SILAGE

SILAGE[21] ist eine Spezialsprache zur Spezifikation von DSP-Algorithmen. SI-
LAGE hat die Form einer Sammlung von single-assignment-Funktionen, die von
einer mawn-Funktion aufgerufen werden. Der elementare Datentyp in SILAGE
ist das Signal. Ein Signal entspricht einem List (Number) (eigentlich: einer Pi-
pe). Signale werden implizit synchron eingelesen (mit einer nicht spezifizerten
Abtastrate) und ausgegeben. Man kann mit Signalen verschiedener Abstastraten
arbeiten.

Jede SILAGE-Funktion verkniipft die aktuellen Samples der Eingabe-Sig-
nale der Funktion zu den aktuellen Samples der Ausgangssignale. Praktisch
liegt ein implizites Mapping vor, bei dem man auch auf zeitlich zuriickliegende
Samples zugreifen kann (der ‘@’-Operator. Das folgende Beispiel zeigt, wie ein
SILAGE-Programm in eine ALDiSP-Funktion umgewandelt werden kann:

#define word fix<8>
#define coefType int<8>

my_coefs = coefType({5,7,8,9,12,16,27,81,-81,
-27,-16,-12,-9,-8,-7,-5})

mit funktionalen Anteilen oder abstrakten Datentypen wie CLU oder Mesa nennen.
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func h_transform(in:word; coefs: coefTypel]):word =
begin

return innerprod(coefs,{i:16::in0@(31-2%i)});
end;

func main(in:word) :word =

begin
return=h_transform(in,my_coefs);

end;

Das Beispiel entstammt [21], p.1-21, und beschreibt einen FIR-Filter. Die Funk-
tion h_transform multipliziert die letzten 16 an ‘ungeraden’ Indizies stehen-
den Abstastwerte mit den Koeffizienten und addiert die Ergebnisse. In ALDiSP
konnte man dies, etwas eleganter, so programmieren:

myCoefs = [5,7,8,9,12,16,27,81,-81,-27,-16,-12,-9,-8,-7,-5]

func hTransform(in: 1istOf (Number), coef:VectorOf (Number)) =
reduce(’+"’,o0dds(s)*vectorToList(coef))
: hTransform(tail(list),coef)

net

in = readStdInPipe()

out= hTransform(in,myCoefs)
in

writeStdOutPipe(out)
endnet

Die StdIn-Pipe kommt ins Spiel, weil ALDiSP das Abtasten selbst vornimmt.®
ALDISP kennt keine derartigen Standard-I/O-Kanile.

Man beachte, dafl hTransform keine explizite Referenz auf die Lénge des
Filters und die Typen der Streams und der Koeffizienten macht, also ‘modularer’
als h_transform formulierbt ist.

Im direkten Vergleich zeigt sich, daBB ALDiSP vielseitiger und méchtiger als
SILAGE ist (so konzeptualisiert SILAGE weder 1/0 noch Zeit und kann keine
‘asynchronen’ Probleme bewaltigen), wihrend SILAGE auf dem Gebiet, fiir
das es entworfen ist, oft kiirzere (wenn auch nicht unbedingt verstindlichere)
Programme erméglicht.

4.6.6 Occam

ALDISP hat den Interprozeflkommunikationsmechanismus “Channel” aus der
Sprache Occam [occam?2] {ibernommen. Occam verfiigt iiber eine Reihe inter-
resanter Konzepte und Strukturen, die alle in ALDiSP simulierbar sind. Das

8Dije read- und write-Funktionen sind keine Primitiven, sondern miissen selbst definiert
werden.
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grundlegende Konzept von Occam ist, das alles ein Prozef} ist. Die Termination
von Prozessen ist sehr wichtig. Durch die SEQ- und PAR-Konstrukte sind Prozes-
se sequentiell und parallel ausfithrbar, wobei eine automatische Synchronisation
stattfindet, d.h. erst wenn alle Prozesse eines parallelen Konstrukts terminiert
sind, terminiert das parallele Konstrukt.

Die Channel sind das zentrale Modularisierungsmittel von Occam. Sie ent-
sprechen in der Nutzung den Streams und Pipes von ALDiSP.

Das ALT-Konstrukt von Occam ermdglicht in eingeschriankter Weise das
asynchrone Warten auf eine von mehreren Eingabesituationen. In ALDiSP wird
dies durch explizite Suspensions, die von komplexen Bedingungen abhéngen,
modelliert.

Occam verfiigt tiber call-by-name (optional call-by-value) Prozeduren und
Funktionen, die etwas ungewohnt ist. Auch in Occam gilt die Trennung zwischen
nebeneffektfreien Funktionen und nebeneffektbehafteten Prozeduren.

4.7 Implementierungs-Restriktionen

Einige Bereiche von ALDiSP sind allgemeiner definiert, als nach heutigem Stand
der Technik effizient implementierbar ist. Da ALDiSP-Programme nicht nur
korrekt, sondern auch schnell laufen sollen, steht es jedem ALDiSP-Compiler
frei, Restriktionen in den nachfolgenden Gebieten aufzustellen:

e Nicht alle (nicht einmal alle essentiellen) numerischen Typen miissen im-
plementiert sein. Insbesondere darf eine Implementierung ohne Reals aus-
kommen. Reals sind nur deswegen als ‘essentiell’ markiert, weil Suspensi-
ons (genauer gesagt, Zeit-Ausdriicke) mit reellen Zahlen rechnen.

o Es darf starke Restriktionen bei der Bildung von Typtermen geben. Ins-
besondere konnen Pradikattypen verboten sein!

e Abstrakte Datentypen kénnen verboten sein.

e Der ‘Bedingungs™-Teil von Suspensions kann eingeschrankt werden. Ins-
besondere konnen die einzigen erlaubten Abhingigkeiten die booleschen
Konstanten, die Abhéngigkeit von anderen Suspensions und die Abhén-
gigkeit von asynchroner 1/0O sein.

Ein zweites Problem sind Speicherplatzbeschrankungen. Es ist prinzipiell unméglich,
vorausszusagen, wieviel (Stack-) Platz eine rekursive Funktion benétigen wird.

Es ist daher eine zumutbare Einschrankung, wenn eine Implementierung keine
Rekursion erlaubt! Als Ausgleich miissen allerdings hinreichend méchtige Funk-
tionale zur Verfiigung gestellt werden.



Anhang A

Einfache Syntax von ALDiSP

Diese Syntax ist vereinfacht und beschreibt ein Superset der eigentlichen Gram-
matik. Es fehlen die Beschreibungen der Vorrangregeln und der Assoziativitat.
Weiterhin fehlen die Parser-Anweisungen. Die Grammatik ist in einer Art EBNF
beschrieben, die [9] entnommen ist. {1, # } bedeutet “das ein- oder mehrmalige
Auftreten von z, bei mehrmaligem Auftreten durch “,” getrennt.”

program +—>
net-description —

declaration ——

declaration-qualifier
simple-declaration +——
multiple-declaration —

abstraction-declaration ——

module ——

{0 declaration } net-description
NET {; declaration } [ IN tupel ] [ ENDNET ]

[ declaration-qualifier | simple-declaration

| multiple-declaration

| declaration-qualifier abstraction-declaration
| MACRO abstraction-declaration

| module

| imports

| abstype

| parser-declaration

[ OVERLOADED ] HEAD

ID “=" expr
(((77 {27 ID } (()77 ((:77 tupel

ID {1, “(" {o, ID [ typing ] } )" } [ typing ]
“=" tupel

| ID BINOP ID [ typing | “=" tupel
| PREOP ID [ typing | “=" tupel
| ID POSTOP [ typing ] “=" tupel

MODULE ID
{1 exports }
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exports

typing
rename

imports

expr

detexpr

suspension

tupel

conditional

delay
seq
stmt
typdecl

typcast

IR A

l

l

l

l

R A

{1 declaration }
ENDMODULE ID

EXPORTS {; ID [ rename ] [ typing ] }

1R

7 type
AS ID

96

[ OVERLOADED ] IMPORT {; [ OVERLOADED]ID

[ rename | [ typing ] }
FROM ID

detexpr
| suspend

| (((77 expr (()77

CONST

| ID

| conditional
| application
| typdecl

| typcast

| delay

| seq

| local

| guard

SUSPEND tupel
UNTIL detexpr
WITHIN detexpr «,” detexpr

expr

| (((77 {27 expr } (()77

IF expr THEN tupel
{0 BAR expr THEN tupel }
[ ELSE tupel | ENDIF

DELAY expr

SEQ {o stmt “” } tupel ENDSEQ

expr
(([77 type ((]77

(([77 ((!77 type ((]77
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type ——  detexpr
| (((77 {07 type } TO {07 type } (()77

application ——  expr BINOP expr
| PREOP expr
| expr POSTOP
| expr (((77 {07 expr } (()77

| (([77 {17 expr } ((]77

local —  LET {; decl } IN tupel ENDLET
| LET tupel WHERE {; decl } ENDLET

abstype ——  ABSYTPE {igar constructor }
— ID
| ID “(" {1, ID [ typing ] } ©)”

parser-declaration —  PARSERFIX " ID " [ “” CONST]

constructor

guard —>  GUARD expr {; ON declaration } ENDGUARD

Die Terminale entsprechen den String-Mengen

IF = “if” (case insensitive)

THEN = “then” (case insensitive)
BAR = "

TO = >

ELSE = “else” (case insensitive)

ENDIF = “endif” (case insensitive)

GUARD = “guard” (case insensitive)

ENDGUARD = “endguard” (case insensitive)

ABSTYPE = “abstype” (case insensitive)

EXCEPTION = “exception” (case insensitive)

SUSPEND = “suspend” (case insensitive)

UNTIL = “until” (case insensitive)

WITHIN = “within” (case insensitive)

MODULE = “module” (case insensitive)

IMPORT = “import” (case insensitive)

EXPORT = “export” (case insensitive)

DELAY = “delay” (case insensitive)

WHERE = “where” (case insensitive)

IN = “in” (case insensitive)

AS = “as” (case insensitive)

HEAD = {“func”, “proc”, “type”, “exception”} (case insensitive)
PARSERFIX = {“postfix”, “prefix”, “infix” } (case insensitive)
CONST ist die Menge aller Konstanten, d.h. aller Zahlen- und Stringliterale:

const — number
| string
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number — int
| real
real —  decimal-card “.” decimal-card[ “e”decimal-int ]
int — [ %7 ]card
decimal-int — [ “-” ]decimal-card
card —  decimal-card
| based-card
decimal-card —  {0123456789}%
based-card ——  decimal-card “#” (0123456789aAbBcCADeELF)"
string — " aChar* "
aChar ——  ein sichtbares Zeichen oder ein Leerzeichen

ID ist die Menge aller Identifier:
ID —  standard-ID

| special-ID
standard-ID ——  alpha alphanum*
special-ID —  special-char®
alphanum ——  alpha
| numeral
alpha —  {a-zA-Z_} und lokale Umlaute
numeral —  {0123456789}
special-char —  {!\$%&/=7""#-.,:;"}

und verfligbare mathematische Sonderzeichen

BINOP ist die Menge aller Infix-Operatoren. Diese Operatoren sind entweder links-
oder rechtsassoziativ und mit einer Bindungsstérke zwischen 1 und 5 versehen (hdher
bindet schwicher).

PREOP ist die Menge aller Prafix-Operatoren.

POSTOP ist die Menge aller Postfix-Operatoren.



Anhang B

yacc—Syntax von ALDiSP

%token IF THEN ELSE ENDIF

%token ID CONST

%token DELAY SUSPEND UNTIL WITHIN

%token MODULE ENDMODULE

%token BINOPL1 BINOPL2 BINOPL3 BINOPL4 BINOPLS
%token BINOPR1 BINOPR2 BINOPR3 BINOPR4 BINOPRS
%token PREOP POSTOP

%token IMPORT FROM

%token EXPORTS AS

%token ARROW

%token LET IN WHERE ENDLET

%token SEQ ENDSEQ

%token NET ENDNET

%token GUARD ON ENDGUARD

%token FUNC PROC TYPE EXCEPTION ABSTYPE OVERLOADED

hh

pgm : decls NET decls IN expr optendnet
optendnet: /* emtpy */

| ENDNET
expr : detexpr

| suspend

detexpr : expril
| exprir

| expr2

exprll : expr2 BINOPL1 expril
| expr2 BINOPL1 expr2
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exprir

expr2

expr2l

expr2r

expr3

expr3l

expr3r

expr4

expr4l

exprir

exprb

expr51

exprbr

expré

exprlr BINOPR1 expr2
expr2 BINOPR1 expr2

expr2l
expr2r
expr3

expr3 BINOPL2 expr2l
expr3 BINOPL2 expr3

expr2r BINOPR2 expr3
expr3 BINOPR2 expr3

expr3l
expr3r
expr4

expr4 BINOPL3 expr3l
expr4 BINOPL3 expr4

expr3r BINOPR3 expr4
expr4 BINOPR3 expr4

expr4l
exprir
exprb

expr5 BINOPL4 expr4l
expr5 BINOPL4 exprb

expr4r BINOPR4 exprb
expr5 BINOPR4 exprb

expr51
exprbr
expré

expr6 BINOPL5 expr5l
expr6 BINOPL5 expr6
expr6 ARROW expro6

exprb5r BINOPRS expro6
expr6 BINOPR5 expro6

expr6 POSTOP
expr?

/* Spezialfall ohne Klammern */
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expr?

exprs

expr9

decls

exprs

if

elsifs

else

: PREOP expr7

DELAY expr7

[ typ ’17 expr?

,[) [ typ ,]) expr7
exprs

expr8 ’(’ exprs ’)’
expr9

ID

CONST

,() expr ,))

>(? exprs ARROW exprs ’)’
local

seq

if

guardedexpr

: decl

suspend :

local

seq

stmts

stmt

tupel

decl decls

expr
expr ’,’ exprs

IF expr THEN tupel elsifs else ENDIF

/* empty */
|’ expr THEN tupel elsifs

/* empty */
ELSE tupel

SUSPEND expr UNTIL expr WITHIN detexpr ’,’ detexpr

LET decls IN tupel ENDLET
LET tupel WHERE decls ENDLET

SEQ stmts ENDSEQ

stmt ’;’ stmts
tupel

decl
expr

expr
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| >’ expr ’,’ exprs ’)’
typ : detexpr

decl : paramdecl

| importdecl

| moduledecl

| simpledecl

| multidecl
paramdecl : optoverload DECLOP declhead ’=’ expr
importdecl: optoverload IMPORT optIDs FROM ID
moduledecl: MODULE ID exportlists decls ENDMODULE ID
simpledecl: optoverload optdeclop ID ’=’ expr

H

multidecl : ID ’,’ IDs ’=’ tupel

declhead : ID paramlists opttyp
| ID BINOP ID opttyp
| ID POSTOP opttyp
| PREOP ID opttyp

IDs : ID

| ID ’,’ IDs
optIDs : optID

| optID ’,’ optIDs
optID : ID optrename opttyp

optoverload: /* empty */
| OVERLOADED

optdeclop : /* empty */
| DECLOP

optrename : /* empty */
| AS ID

opttyp : /* empty */
I 7:7 typ
exportlists: /* empty */
| exportlist exportlists
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5
exportlist:

H

paramlists:

I
5
paramlist :

params

param

EXPORTS optIDs

paramlist
paramlist paramlists

’(’ ’)’

> (? params )’

param
param ’,’ params

ID opttyp

guardedexpr: GUARD expr ON guards ENDGUARD

guards : /* empty */

H

ON declhead ’=’ expr
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Primitive & Typen

Die Typen und Primitiven sind in Form von Modul-Headern zusammengefaflt.

Module Standard

Exports
bottom : Bottom,
0bj : Type,
Type : Type,
-> : (Type,Type -> Type) \ spezial-syntax
Function : Type,
Bool : Type,
Predicate : Type,
Macro : Type,
Module : Type,
Exception : Type,
eq : (0bj,0bj -> Bool)
identity : 0bj -> 0bj
“or'" : (Bool, Bool -> Bool)
"and" : (Bool, Bool -> 0bj)
"not" : Bool -> Bool

EndModule Standard

Module Numbers
Exports
Number : Type,
Integers,
FixInts,
Reals,
ComplexNumbers,

nan : (Humber, Number -> Bool),

neyn : (Humber, Number -> Bool),
o : (Humber, Number -> Bool),
ny=n : (Humber, Number -> Bool),
ngn : (Humber, Number -> Bool),
n=gn : (Humber, Number -> Bool),
REa : (Number, Number -> Number),
et : (Number, Number -> Number),
k! : (Number, Number -> Number),
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/e : (Number, Number -> Number),
BE el : (Number, Number -> Number),
R el : (Number, Number -> Number),
"'sqrt" : Number -> HNumber,
"sin" : Number -> Number,
‘'cos" : Number -> Number,
“tan" : Number -> Number,
"asin" : Number -> Number,
“‘acos" : Number -> Number,

overloaded atan : Number -> Number
overloaded atan : (Number,Number -> Humber),

log : (Hlumber ,lumber -> Humber),

“1n" : Number -> Number,

14" : Number -> Number,

"exp" : Number -> HNumber,

k! : (Number, Number -> Number),

max : (llumber, Humber -> Number),

min : (Hlumber, Humber -> Number)

"abs" : Humber -> HNumber

"signum" : Humber -> HNumber

DivisionByZero : Exception,
DivisionOverflow : Exception,
MultiplicationOverflow : Exception,
ExponentiationOverflow : Exception,
ExponentiationIsComplex : Exception,
AdditionOverflow : Exception,
SubtractionOverflow : Exception,

NegativeRoot : Exception,
UndefinedTangens : Exception,
TangensOverflow : Exception,

LogIsComplex : Exception,
TruncateOverflow : Exception,

RoundError : Exception,
SignalingDivision : (Number ,Humber -> Number),
RealDivision : (Number ,Number -> Humber),
SaturatedDivision : (Number ,Number -> Humber),
WrappingDivision : (Number ,Number -> HNumber),
IgnoringDivision : (Number ,Humber -> Number),

SignalingMultiplication :(Number,Number -> Humber),
RealMultiplication : (Number ,Number -> Humber),
SaturatedMultiplication :(HNumber,Number -> Number),
WrappingMultiplication :(Number,Humber -> Number),
IgnoringMultiplication :(Number,Number -> Number),

SignalingExponentiation :(Number,Number -> Humber),
RealExponentiation : (Number ,Number -> Humber),
ComplexExponentiation : (Number ,Number -> HNumber),
SaturatedExponentiation :(HNumber,Number -> Number),
WrappingExponentiation :(Number,Humber -> Number),



ANHANG C. PRIMITIVE & TYPEN 106

IgnoringExponentiation :(HNumber,Number -> Number),

SignalingAddition : (Number ,Humber -> Number),
RealAddition : (Number ,Number -> Humber),
SaturatedAddition : (Number ,Number -> Humber),
WrappingAddition : (Number ,Number -> HNumber),
IgnoringAddition : (Number ,Humber -> Number),

: (Humber ,Number -> Number),
: (Humber ,Number -> Number),
: (Humber ,Number -> Number),
: (Humber ,Number -> Number),
: (Humber ,Number -> Number),

SignalingSubtraction
RealSubtraction
SaturatedSubtraction
WrappingSubtraction
IgnoringSubtraction

SignalingRoot : (Number -> Number),
ComplexRoot : (Number -> Number),
IgnoringRoot : (Number -> Number),
SignalingTangens : (Number -> Number),
RealTangens : (Number -> Number),
SaturatedTangens : (Number -> Number),
IgnoringTangens : (Number -> Number),
SignalingLog : (Number ,Humber -> Number),
ComplexLog : (Number ,Number -> Humber),
IgnoringLog : (Number ,Humber -> Number),
SignalingTruncate : (Number -> Number),
SaturatedTruncate : (Number -> Humber),
IgnoringTruncate : (Number -> Number),
Signaling : Macro,

Realizing : Macro,

Complexing : Macro,

Saturated : Macro,

Wrapping : Macro,

Ignoring : Macro,

RoundToZero : (Number ,Bit -> Number),
RoundToPlus : (Number ,Bit -> Number),
RoundToMinus : (Number ,Bit -> Number),
RoundToEven : (Number ,Bit -> Number),
RoundTo0dd : (Humber ,Bit -> Number)

Module Integers
Exports

Integer : Type,

MinInt : Integer,

MaxInt : Integer,
nBitInteger : Cardinal -> Type,
"round" : Humber -> Integer,
"truncate" : Humber -> Integer,
"isEven" Integer -> Bool,
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"is0dd" : Integer -> Bool
"mod"! : (Integer, Integer -> Integer)
"rem' : (Integer, Integer -> Integer)

BiasedCardinal : (Type, Cardinal -> Type)

Cardinal : Type,

MaxCard : Cardinal,

nBitCardinal : Cardinal -> Type,

"bitAnd" : (Cardinal,Cardinal -> Cardinal),
"bit0r" : (Cardinal,Cardinal -> Cardinal),
"bitXor" : (Cardinal,Cardinal -> Cardinal),
"bitInverse" : Cardinal -> Cardinal,
"bitReverse" : Cardinal -> Cardinal,
"bitLshift" : (Cardinal,Cardinal -> Cardinal),
"bitRshift" : (Cardinal,Cardinal -> Cardinal),
"bitLrotate" : (Cardinal,Cardinal -> Cardinal),
"bitRrotate" : (Cardinal,Cardinal -> Cardinal),
"bitCut" : (Cardinal,Cardinal -> Cardinal),

EndModule Integers

Module FixInts
ScaledFixpoint : (Type,Cardinal -> Type),
FixInt : (Cardinal,Cardinal -> Type),
FixCard : (Cardinal,Cardinal -> Type),
EndModule FixInts

Module Reals

Exports
Real : Type,
SmallestReal : Real,
LargestReal : Real,
ShortReal : Type,

SmallestShortReal: ShortReal,
LargestShortReal : ShortReal,

LongReal : Type,
SmallestLongReal: LongReal,
LargestLongReal : LongReal,

plusInfinity : Real,

minusInfinity : Real,

plusInfiniteSmall : Real,

minusInfiniteSmall: Real
EndModule Reals

Module ComplexNumbers

Exports
Complex : Type -> Type,
aComplex : Type,
makeComplex : (Humber, Number -> aComplex),

"realPart" : Complex -> Number,
"imagPart" : Complex -> Number,
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“phase"
pointInfinity

: Complex -> Number,
: Complex,

EndModule ComplexHumbers

Module Time
Exports

Duration
Time

sec

ms
MinDuration

Time
SystemClock
"Year"
"Month"
“Day"
"Hour"
"Minute"
"'Second"
makeTime

EndModule Time
EndModule Numbers

Module Strings

Exports

String
AsciiToString
g

"length"

ldrop

rdrop
NumberToString

EndModule Strings

Module Arrays

Exports

Array
"sizeOf"
map
dMap

Module Vectors
Exports

Vector
VectorOf
createVector
changeVector
dChangeVector

: Type,

: Type,

: Number -> Duration,
: Number -> Duration,
: Number,

: Type,

( => Time),

: Time -> Cardinal,
: Time -> Cardinal,
: Time -> Cardinal,
: Time -> Cardinal,
: Time -> Cardinal,
: Time -> Cardinal,

(Cardinal,Cardinal ,Cardinal,
Cardinal ,Cardinal ,Cardinal -> Time),
(Time, Time -> Duration)

: Type,
: Cardinal -> String,

(String, String -> String),
String -> Cardinal,
(Cardinal, String -> String),
(Cardinal, String -> String),

: Number -> String

: Type,
: Array -> Cardinal,

((0bj -> 0bj), Array -> Array),
((0bj -> 0bj), Array -> Array)

: Type,
: Type -> Type,

(Cardinal, (Cardinal -> 0bj) -> Vector),

(0bj, ... ,0bj -> Vector), \ Spezial-Syntax
(Vector, Cardinal, O0bj -> Vector),

(Vector, Cardinal, O0bj -> Vector),
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reduce

rReduce

rev
"evens"
"odds"
merge
subVector
compose

EndModule Vectors

Module Matrices
Exports
Matrix
Matrix0f
createlatrix
MatrixLiteral
changelMatrix
dChangelatrix
"hSize"
"vSize"
UnitMatrix
"hRev"
"vRev"
"dRev"
""oRev"
"rot"
"rot2"
"rot3"
"hEvens"
"h0dds"
"'vEvens"
"v0dds"
hMerge
vilerge
hSubMatrix
vSubMatrix
hCompose
vCompose
Row
Col
diag
ndiag
"det"
hReduce
vReduce
EndModule Matrices
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((0bj, O0bj -> Obj), Vector -> Vector),
((0bj, O0bj -> Obj), Vector -> Vector),

: Vector -> Vector,
: Vector -> Vector,
: Vector -> Vector,

(Vector, Vector -> Vector),
(Vector, Cardinal, Cardinal -> Vector),
(Vector, Vector -> Vector),

: Type,
: Type -> Type,

(Cardinal, Cardinal, (Cardinal -> 0bj) -> Matrix),
(Vector, ,Vector -> Matrix),

(Matrix, Cardinal, Cardinal, 0bj -> Matrix),
(Matrix, Cardinal, Cardinal, 0bj -> Matrix),

: Matrix -> Cardinal,
: Matrix -> Cardinal,
: Cardinal -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,
: Matrix -> Matrix,

(Matrix, Matrix -> Matrix),
(Matrix, Matrix -> Matrix),
(Matrix, Cardinal, Cardinal -> Matrix),
(Matrix, Cardinal, Cardinal -> Matrix),
(Matrix, Matrix -> Matrix),
(Matrix, Matrix -> Matrix),
(Cardinal, Matrix -> Vector),
(Cardinal, Matrix -> Vector),
(Matrix, Cardinal -> Vector),
(Matrix, Cardinal -> Vector),

: Matrix -> Number,

(Function, Matrix -> Vector),
(Function, Matrix -> Vector),

EndModule Arrays

Module Lists

Exports
List0f
List
null

cons
we.n

: Type -> Type,
: Type,
: List,

(0bj, List -> List)
(0bj, List -> List)

’

’
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head

tail

isEmpty

isSingleton

select

reduce

ListToVector

VectorToList

listifyVectors

vectorizelList
EndModule Lists

Module MachineTypes
Exports
Interrupts,
Registers,
Ports

Module Registers
Exports
Register
InputRegister
OutputRegister

anInputRegister
anOutputRegister:

writeToRegister

readFromRegister
waen

nen

PipeFromRegister:

PipeToRegister

StreamToRegister:

EndModule Registers

Module Ports

Exports
Port
InputPort
OutputPort
isPortReadable

isPortWriteable

writeToPort
readFromPort

i
won
PipeFromPort
PipeToPort

EndModule Ports

Module Files
Exports
File
InputFile
OutputFile
AccessFile

: List -> 0bj,

: List -> List,
: List -> Bool,
: List -> Bool,

(Cardinal, List -> Object),
(Function, List -> Object),

: List -> Vector,
: Vector -> List

(List0f(Vector) -> List)
(Cardinal, List -> List0f(Vector))

: Type,
: Type -> Type,
: Type -> Type,
Type,
Type,

(anOutputRegister, 0bj -> ),

: anInputRegister -> 0bj

(anOutputRegister, 0bj -> ),

: anInputRegister -> 0bj
(Duration, anInputRegister -> List),
(List -> anInputRegister),
(Duration, List -> anInputRegister)

: Type,
: Type,
: Type,

InputPort -> Bool,
OutputPort -> Bool,
(OutputPort, O0bj ->),
InputPort -> 0bj
(OutputPort, O0bj ->),
InputPort -> 0bj
(anInputRegister -> List),
(List -> anInputRegister)

: Type,
: Type -> Type,
: Type -> Type,

: Type -> Type,
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anInputFile
anOutputFile
anAccessFile
openInputFile
openOutputFile
openfccessFile
writeToFile

readFromFile
win

nan
setAccessPointer:
closeFile

EndModule Files

Module Interrupts
Exports

Interrupt

EndModule Interrupts

EndModule MachineTypes

Module IPC

Exports

Channel
ChannelOf
writeToChannel
readFromChannel
isChannelReadable:

isChannelWritable:
won

EndModule IPC

Module Stuff

Exports

Error
isAvailable
isSuspended
after

when

all

is"

EndModule Stuff

: Type,
: Type,
: Type,

(String, Type) -> anlnputFile,
(String, Type) -> anOutputFile,
(String, Type) -> anAccessFile,
(File, Obj ->),

: File -> 0bj,

: (File, 0bj -> ),

: File -> 0bj,
(File, Cardinal -> ),
(File -> )

: Type,

: Type,

: Type -> Type,

(Channel, Object -> ),
Channel -> Object,
Channel -> Bool,
Channel -> Bool,

: Channel -> Object,

(Channel, Object -> ),

(Object, ,0bject -> ),
Object -> Bool,
Object -> Bool,

: Macro,
: Macro,
: Macro,

(Object, Constructor -> Bool)
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Anhang D

Minimale Primitive & Typen

Hier wird das Subset der in jeder ALDiSP-Implementierung erforderten Primi-
tiven und Typen vorgestellt.

Module Standard

Exports
bottom : Bottom,
0bj : Type,
Type : Type,
-> : (Type,Type -> Type) \ spezial-syntax
Function : Type,
Bool : Type,
Predicate : Type,
Macro : Type,
Module : Type,
Exception : Type,
eq : (0bj,0bj -> Bool)
identity : 0bj -> 0bj
“or'" : (Bool, Bool -> Bool)
"and" : (Bool, Bool -> 0bj)
"not" : Bool -> Bool

EndModule Standard

Module Numbers

Exports
Number : Type,
Integers,
Reals,

nan : (Humber, Number -> Bool),

neyn : (Humber, Number -> Bool),
o : (Humber, Number -> Bool),
ny=n : (Humber, Number -> Bool),
ngn : (Humber, Number -> Bool),
n=gn : (Humber, Number -> Bool),
REa : (Number, Number -> Number),
et : (Number, Number -> Number),
k! : (Number, Number -> Number),
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ll/ll

max
min

abs
"signum"

Module Integers
Exports
Integer
MinInt
MaxInt

"round"
"truncate"
"isEven"
"is0dd"

Cardinal
MaxCard

EndModule Integers

Module Reals
Exports
Real
SmallestReal
LargestReal

plusInfinity

minusInfinity

(Number, Number -> Number),

(Number, Number -> Number),
(Wumber, Number -> Number)

: Number -> Number
: Number -> Number

: Type,

Integer,
Integer,

: Humber -> Integer,
: Humber -> Integer,

Integer -> Bool,
Integer -> Bool

: Type,
: Cardinal,

: Type,
: Real,
: Real,

Real,
Real,

minusInfiniteSmall: Real

EndModule Reals

Module Time

Exports
Duration
Time

sec
MinDuration

EndModule Time
EndModule Numbers

Module Arrays
Exports
Array
"sizeOf"
map

: Type,

: Type,

: Number -> Duration,
: Number,

: Type,
: Array -> Cardinal,
((0bj -> 0bj), Array -> Array),
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Module Vectors

Exports
Vector : Type,
createVector : (Cardinal, (Cardinal -> 0bj) -> Vector),
v, Lo, s (Obj, ... ,0bj -> Vector), \ Spezial-Syntax
changeVector : (Vector, Cardinal, 0bj -> Vector),
reduce : ((0bj, 0bj -> 0bj), Vector -> Vector),
rReduce : ((0bj, 0bj -> 0bj), Vector -> Vector),

EndModule Vectors

Module Matrices

Exports
Matrix : Type,
createlMatrix : (Cardinal, Cardinal, (Cardinal -> 0bj) -> Matrix),
MatrixLiteral : (Vector, ... ,Vector -> Matrix),
changelMatrix : (Matrix, Cardinal, Cardinal, 0bj -> Matrix),
"hSize" : Matrix -> Cardinal,
"vSize" : Matrix -> Cardinal,

EndModule Matrices
EndModule Arrays

Module Stuff

Exports
isAvailable : Object -> Bool,
isSuspended : Object -> Bool,
"is" : (Object, Constructor -> Bool)

EndModule Stuff



Anhang E

Vordefinierten Operatoren

Es folgt eine Auflistung aller vordefinierten Infix-Operatoren, geordnet nach
ihren Bindungsstarken (1-5). Operatoren der Starke ‘1’ binden schwicher als
Operatoren der Stirke ‘2’, etc. Alle Operatoren bis auf das Infix-Cons (: :) sind
links-assoziativ.

Bindungsstirke 1

and or

Bindungsstirke 2

=< >>= =< <> 7!

Bindungsstirke 3

+ -

bitAnd bitOr bitXor

bitLshift bitRshift bitLrotate bitRrotate
bitCut

->

Bindungsstiarke 4

* / mod

Bindungsstirke 5

**
Diese Bindungsstirken erlauben die korrekte Parsierung des Ausdrucks

y=42 or x=atb*c**d
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Es gibt einige vordefinierte Operatoren, die aus dem Konzept fallen, da sie
als nicht sinnvoll verallgemeinerbar anzusehen sind. Hierzu gehoren:

e Das ‘Vektor-Literal’ [expry,..., expr,]

o Der Typkonstruktor (types,..., type, —>typem,..., typemyr ), der auch oh-
ne Klammern auftreten kann, wenn es nur je einen Argument- und Resul-
tattypen gibt.

e Der Tupel-Konstruktor (expry,..., expr,) —auch wenn Tupel keine echten
Datentypen sind, werden sie doch intuitiv als solche aufgefafit.

Prafix-Operatoren

not sqrt sin cos tan

asin acos 1n 14 exp
signum bitNot bitReverse round truncate
isEven 1is0dd realPart imagPart phase
length sizeOf rev evens odds
hSize vSize hRev vRev dRev
oRev rot rot2 rot3 hEvens
hOdds vEvens v0dds det head
tail isEmpty

Postfix-Operatoren

sec ms



Anhang F

Fallbeispiele

F.1 16-Kanal Mixer

Beschreibung

Ein Mixer vermischt mehrere Signale, indem er sie zusammenaddiert. Die ein-
zelnen Signalquellen konnen dabei den verschiedensten Modifikationen ausge-
setzt sein. Im folgenden Beispiel gehe ich davon aus, dafl es 16 analoge Inputs,
einen A/D-Wandler (16 Bit) und einen analogen Output (der direkt a einem
16-Bit D/A-Wandler sitzt) gibt. Zudem gibt es 16 Misch-Regler, einen pro Ka-
nal. Die Regler werden iiber einen billigen 8-Bit A/D-Wandler abgetastet. Es
gibt zwei Mutiplex-Steuerregister, die bestimmen, welche Inputs an den beiden
A/D-Wandlern anliegen. Die Abtastfrequenz ist theoretisch beliebig, praktisch
wird ein Wert von 44KHz vorgegeben.

\ Beispielprogramm:
\ 16-Kanal-Mixer

SamplingRate = (1/44000) sec

\ Die Adressen der Hardware-Komponenten seien wie folgt gegeben:
input16bit= [!InputRegister(Word)] ['address] #x0ef000
output16Bit=['!0utputRegister (Word)] [!address] #x0ef004

input8bit = [!InputRegister(Byte)] ['address] #x0ef008

selectori6bit=[!0utputRegister(Nibble)] [!adress]#x0ef010
selector8bit =[!0utputRegister(Nibble)][!adress]#x0ef014

proc readAndMixInput(n:Nibble) =
{

writeRegister(selector16bit,n);
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writeRegister(selector8bit,n)

Sample = readRegister(selector16bit);
Aussteuerung = readRegister(selector8bit));

\

\ der Aussteuerungswert wird als Faktor zwischen O und 1
\ interpretiert.

\ die Berechnung muss in der richtigen Reihenfolge

\ ausgef\"uhrt werden, damit keine Bits verlorengehen.

tmp=([!nBit(24)]Sample)*Aussteuerung;
['Word] (tmp/256)
}

\ wenn es beim Addieren der Samples zu einem Overflow kommt,
\ sollte das Ergebnis der maximale Sample sein.
\ (per Default w\"are es Wrap-Around.)

proc AccumulatelInput(n,akku) =
{
if n<0 then akku
else AccumulatelInput(n-1,
Wrapping(akku+readAndMixInput(n))

)

endif

}

proc DoMixing() =
writeRegister(output16Bit,AccumulateInput(15,0))

proc RunMixer() =
suspend
{
RunMixer();
DoMixing()
b
until true
within SamplingRate,SamplingRate

net
\ keine Netzbeschreibung
in
RunMixer() \ dies ist der Programmstart
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endnet

F.2 Definition einiger primitiver Funktionen und
Prozeduren

Im Folgenden sollen fiir einige vorgegebene Funktionen beispielhafte ALDiSP—
Implementierungen gegeben werden.

proc PipeFromRegister(F : Duration; R: InputRegister) =
readFromRegister(R) ::
suspend SampleRegister(F, R)
until true
within F,F

proc StreamToRegister(FrameDuration : Duration;
R : Outputregister;
D : List) =
seq
writeToRegister(R,head(L));
suspend PipeToRegister(FrameDuration, R, tail(L))
until true
within FrameDuration,FrameDuration
endseq

proc PipeToRegister(R : Outputregister;
D : List) =
seq
writeToRegister(R,head(L));
PipeToRegister(R,tail(L));
endseq
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